Disclaimer; No Warranty

THIS INFORMATION AND ALL OTHER DOCUMENTATION (IN PRINTED OR ELECTRONIC FORM) ARE PROVIDED FOR REFERENCE PURPOSES ONLY. WHILE EFFORTS WERE MADE TO VERIFY THE COMPLETENESS AND ACCURACY OF THIS INFORMATION, THIS INFORMATION AND ALL OTHER DOCUMENTATION ARE PROVIDED "AS IS" WITHOUT ANY WARRANTY WHATSOEVER AND TO THE MAXIMUM EXTENT PERMITTED, LOTUS AND IBM DISCLAIM ALL WARRANTIES, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SAME. LOTUS AND IBM SHALL NOT BE RESPONSIBLE FOR ANY DAMAGES, INCLUDING WITHOUT LIMITATION, DIRECT, INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES, ARISING OUT OF THE USE OF, OR OTHERWISE RELATED TO, THIS INFORMATION OR ANY OTHER DOCUMENTATION. NOTWITHSTANDING ANYTHING TO THE CONTRARY, NOTHING CONTAINED IN THIS INFORMATION OR ANY OTHER DOCUMENTATION IS INTENDED TO, NOR SHALL HAVE THE EFFECT OF, CREATING ANY WARRANTIES OR REPRESENTATIONS FROM LOTUS AND IBM (OR THEIR SUPPLIERS OR LICENSORS), OR ALTERING THE TERMS AND CONDITIONS OF THE APPLICABLE LICENSE AGREEMENT GOVERNING THE USE OF THIS SOFTWARE.

Under the copyright laws, neither this documentation nor the software may be copied, photocopied, reproduced, translated, or reduced to any electronic medium or machine-readable form, in whole or in part, without the prior written consent of IBM Corporation, except in the manner described in the documentation or the applicable licensing agreement governing the use of the software.

© Copyright IBM Corporation 1998, 2005

All rights reserved. Printed in the United States.

US Government Users Restricted Rights - Use, duplication or disclosure restricted by GS ADP Schedule Contract with IBM Corp.

Lotus Software, IBM Software Group
One Rogers Street
Cambridge, MA 02142

Trademarks

iSeries, iSeries Client Access Express, eServer, and i5/OS are trademarks and IBM, Operating System/400, and PowerPC are registered trademarks of International Business Machines Corporation. Domino, Sametime Connect, and QuickPlace are trademarks and Lotus, Lotus Notes, and Sametime are registered trademarks of Lotus Development Corporation and/or IBM Corporation in the United States, other countries, or both. Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both. MeetingPlace is a trademark of Latitude Communications, Inc. Microsoft, NetMeeting, Outlook, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both. Pentium is a registered trademark of Intel Corporation in the United States, other countries, or both. Other product and company names mentioned herein may be the trademarks or registered trademarks of their respective owners.
Contents

1 Getting Started With Domino for i5/OS .......................... 1
   What is Lotus Domino for i5/OS? .......................... 1
   What's new in Domino 7 for i5/OS? ......................... 1
   How do I administer Domino on i5/OS? ..................... 3
   Domino for i5/OS server requirements .................... 4
   Where do I find more information? ......................... 6
   How do I get fixes? .................................... 7

2 Upgrading the Domino Software ............................. 9
   Considerations for upgrading from previous versions of Domino .......................... 9
   Considerations for upgrading to future releases .............................................. 12
   What happens when the Domino software is upgraded? .......................... 12
   Ending Directory Synchronization tasks .......................... 13
   Ending the MSF and SMTP services .......................... 13
   Moving from Mail Server Framework to Native Notes .......................... 14
   Verifying that all mail is delivered .......................... 16
   Performing the Domino upgrade .......................... 16
   How do I upgrade the Domino for iSeries Navigator plug-in? .......................... 17

3 Installing Domino on your system .......................... 19
   i5/OS authorities required to install and configure Domino .......................... 19
   Verifying the installed software .......................... 21
   What should I know before I install Domino? .......................... 21
   Is my server properly sized? .......................... 23

   Installing the Domino software .......................... 24
   What software should I install? .......................... 24
   How do I install the Domino software? .......................... 25
   What happens when the Domino software is installed? .......................... 28
   Verifying that the Domino software is installed .......................... 29

4 Planning the Domino for i5/OS Environment ..................... 31
   How should I set up TCP/IP for Domino for i5/OS? .......................... 31
   Verifying TCP/IP setup and status .......................... 31
   Determining if TCP/IP is set up .......................... 32
   Determining the Internet address and host name to use for Domino .......................... 32
   Starting TCP/IP .......................... 33
   Verifying TCP/IP interface status .......................... 33
   How does Domino 7 interact with other programs on my server? .......................... 34

5 Preparing the administrator's workstation .......................... 35
   Installing iSeries Navigator .......................... 36
   Verifying that NetServer is running .......................... 36
   Verifying access to the NetServer file share .......................... 37
   Installing the Domino plug-in .......................... 38

6 Setting Up a First Domino Server .......................... 39
   Deciding what to specify for server characteristics .......................... 40
   What happens during first server setup? .......................... 45
7 Setting up multiple Domino servers on the same system ........................................ 47
What is Domino partitioning? .................................................................................. 47
8 Setting Up an Additional Domino Server .............................................................. 51
Registering the additional server ............................................................................ 52
Verifying TCP/IP connections to the system ......................................................... 53
Copying the ID files for the additional server to the system ............................... 54
Setting up an additional server using iSeries Navigator ....................................... 56
What happens during additional server configuration? ......................................... 58
9 Managing the Domino Server Overview ............................................................... 59
Ways of managing a Domino server ....................................................................... 59
Authority requirements for Domino administrators ....................................... 60
Overview of using iSeries Navigator to manage a Domino server .................... 61
Overview of using the Java Server Console to manage a Domino server ........... 62
Overview of using the Domino Administrator client to manage a Domino server 62
Using the Verity KeyView filter .............................................................................. 63
Fault recovery operation ........................................................................................ 63
10 Managing a Domino Server Using iSeries Navigator ......................................... 65
Starting a Domino server ...................................................................................... 66
Stopping a Domino server .................................................................................... 66
Stopping a Domino server immediately .............................................................. 67
Stopping a Domino subsystem .............................................................................. 67
Starting the Java Server Controller ...................................................................... 68
Starting a Domino server and the Java Server Controller .................................. 68
Stopping a Domino server and the Java Server Controller ................................ 69
Stopping a Domino server and Java Server Controller immediately ................ 69
Starting the Domino Server Setup Wizard to configure a new server ............... 70
Adding a Domino application .............................................................................. 70
Determining the server status ............................................................................. 71
Viewing active jobs related to Domino servers ................................................... 71
Changing a Domino server's properties .............................................................. 72
Editing the NOTES.INI file .................................................................................. 72
Why are partial server properties displayed? ....................................................... 73
Installing the Domino Administrator client ....................................................... 73
Launching the Domino Administrator client ...................................................... 73
Launching the Domino console .......................................................................... 74
Deleting a Domino server .................................................................................... 74
11 Registering and managing users ........................................................................ 77
Setting up Domino for i5/OS users ...................................................................... 77
About Domino for i5/OS Single Logon ................................................................ 78
12 Using Domino for i5/OS multi-version capabilities .......................................... 79
Overview of multi-version terms and concepts ................................................... 79
Preparing for multi-version capable releases ....................................................... 81
Installing multi-version capable releases ............................................................ 82
Installing multiple releases of Domino ............................................................... 84
Removing multi-version capable releases ........................................................... 85
Managing multi-version capable releases ......................................................... 86
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>19 Integrating iSeries Collection Services with Domino</td>
<td>167</td>
</tr>
<tr>
<td>20 Using National Language Versions of Domino</td>
<td>173</td>
</tr>
<tr>
<td>Using other languages on English versions of Domino</td>
<td>173</td>
</tr>
<tr>
<td>Language dictionary files</td>
<td>175</td>
</tr>
<tr>
<td>Changing the date and time formats and separators</td>
<td>178</td>
</tr>
<tr>
<td>Installing the translated Domino plug-in for iSeries Navigator</td>
<td>179</td>
</tr>
<tr>
<td>About running Domino using a secondary language</td>
<td>181</td>
</tr>
<tr>
<td>Appendix A Domino for i5/OS Diagrams</td>
<td>183</td>
</tr>
<tr>
<td>Domino installation options</td>
<td>183</td>
</tr>
<tr>
<td>Domino configuration options</td>
<td>184</td>
</tr>
<tr>
<td>Appendix B Setting Up Remote LAN Services</td>
<td>185</td>
</tr>
<tr>
<td>Server requirements for remote LAN service</td>
<td>185</td>
</tr>
<tr>
<td>Creating a PPP profile for remote LAN service</td>
<td>186</td>
</tr>
<tr>
<td>Adding the Connection document for remote LAN service</td>
<td>187</td>
</tr>
<tr>
<td>Adding a Server document for remote LAN service</td>
<td>189</td>
</tr>
<tr>
<td>Remote LAN service errors</td>
<td>189</td>
</tr>
<tr>
<td>Appendix C Using i5/OS Commands With Domino for i5/OS</td>
<td>191</td>
</tr>
<tr>
<td>Typical administrative tasks and their equivalent Domino commands</td>
<td>198</td>
</tr>
<tr>
<td>Index</td>
<td>205</td>
</tr>
</tbody>
</table>
Welcome to IBM® Lotus® Domino™ 7 for i5/OSTM! This document will help you set up a Domino environment for your organization, so you can take advantage of its advanced Web serving technology, messaging, groupware, and application development capabilities.

What is Lotus Domino for i5/OS?

Lotus Domino is a middleware solution that provides an infrastructure to enhance communications and knowledge sharing throughout your organization. Lotus Domino and i5/OS are an ideal combination for deploying such an infrastructure. Together, they provide a reliable, scalable, integrated solution providing high availability so your users can access their applications when they need them.

What's new in Domino 7 for i5/OS?

This section describes aspects that are new specifically for Lotus Domino 7 for i5/OS. For more information on new features not specific to the i5/OS platform, see the Release Notes for Domino/Notes 7 (readme.nsf), available on the product CD-ROM or at Lotus developerWorks at the following Web address:

http://www.ibm.com/developerworks/lotus/

- Domino 7 for i5/OS uses the licensed program ID 5733LD7 for the installed product identifier. The IBM Passport Advantage product ID (PID) is 5724E62, which is used for ordering and licensing features. Lotus Domino 7 for i5/OS is only available through the Passport Advantage ordering process. For more information on Passport Advantage, see the following Web site:

http://www.lotus.com/passport
Use the Display Software Resources (DSPSFWRSC) command to determine which Domino software is installed on your server. For example, with all options of Domino 7.0 installed, the DSPSFWRSC command displays the following output:

```
5733LD7  *BASE    5050    Lotus Domino 7 (5724E62)
5733LD7  *BASE    2924    Lotus Domino 7 (5724E62)
5733LD7   1        5050    Lotus Domino 7: C API
5733LD7   10       5050    Lotus Domino 7: Release 7.0.0
5733LD7   10       2924    Lotus Domino 7: Release 7.0.0
```

- Domino 7 for i5/OS is only supported on IBM i5/OS V5R3 or later. Domino 7 cannot be installed and is not supported on OS/400 V5R2.
- Physical media for Lotus Domino 7 for i5/OS consists of multiple CDs. If you use physical media, you will need to switch CDs during the installation process. For more information, see Chapter 3 "Installing Domino on your system."
- While the name of the operating system has changed from "OS/400" to "i5/OS," there are still portions of the product that may show or return the values "OS/400" or "OS400." For example, the output from the Domino "show server" command will contain the string "i5/OS" and the output of the SHOW STAT command will contain the following:

  *
Server.Version.OS = OS400 V5R3M0*

  In general, interfaces that can potentially return values to customer applications are unchanged and may still return the value "OS/400" or "OS400," while other uses or references to the product name are changed to use "i5/OS."
- Support for Cluster Enabled Domino has been removed.
- Domino 7 for i5/OS continues to provide multi-version capability and can be installed on the same i5/OS partition as other multi-version capable releases of Domino - 6.0.3 and 6.5.0 and later. For more information, see Chapter 12 "Using Domino for iSeries Multi-version Capabilities ."
- Support for xSP hosting has been removed. If the CFGDOMSVR or CHGDOMSVR commands specify XSP(*YES), the setting is ignored.
- The Lotus Branded DataDirect Connect for ODBC wire protocol drivers are now installed by the Domino installation program to the directory /QIBM/ProdData/Lotus/DOMINOXXX/EITODBC/, where XXX corresponds to the release of Domino (for example, DOMINO700 for Domino 7.0). The user is no longer required to download and install the drivers.

2 Installing and Managing Domino 7 for i5/OS
How do I administer Domino on i5/OS?

Domino 7 includes many improvements to help you administer your Domino server. You can use either the Domino Administrator client or the Web Administrator client.

**Domino Administrator client**
The Domino Administrator client can be installed on a remote workstation, allowing the administrator access to functions through a Notes interface. The Domino Administrator client allows an administrator to change server settings, set user settings, set policies, register users, and control client upgrades.

**Web Administrator client**
The Web Administrator client can be accessed from any workstation through a Web browser. The administrator is authenticated by the user ID and password used to log onto the server. The interface changes depending on the roles assigned to the user ID. Using the Web Administrator client, administrators can perform most of the same tasks as the Domino Administrator client, such as repairing Access Control Lists, registering users, and changing server properties.

**iSeries Navigator**
iSeries Navigator is part of the IBM iSeries Access family of products, and runs on a workstation that is communicating with your iSeries server through TCP/IP. It allows you to perform administrative functions for both Domino and i5/OS using one graphical user interface.

**i5/OS commands**
i5/OS commands allow you to initiate system functions using a terminal directly connected with your server, or a workstation communicating with your server using a session such as a 5250 emulator window.

For more information on administering Domino on i5/OS, including client setup, starting, using, and troubleshooting, see the Lotus Domino Administrator 7 Help online or the Domino Administrator Help database (HELP7_ADMIN.NSF).
Domino for i5/OS server requirements

Domino for i5/OS requires the following hardware and software.

**Hardware**

One of the following hardware models:

- IBM iSeries model 8xx server
  
  *Recommended:* Model 810, 825, 800-2464 and above
  
  *Not recommended:* Model 800-2463

- IBM eServer i5 model 520 or higher
  
  *Recommended:* Model 520-0901 and above
  
  *Not recommended:* Model 520-0900

Memory and disk requirements:

- Minimum 288 MB memory, 512 MB recommended
- Minimum 1.6 GB free disk space, 2 GB recommended

*Note* Use these values as general guidelines for minimum memory and disk space. The requirements for your environment may be different. For more information about sizing an iSeries server for Domino, use the IBM Workload Estimator for iSeries. The Estimator is available at the following Web site:

http://www.ibm.com/eserver/iseries/support/estimator

**i5/OS software**

- IBM i/OS™ V5R3 or later with the latest PTFs applied.
  
  For more information on the latest PTFs, refer to the following Web sites:
  
  http://www.ibm.com/eserver/iseries/domino/support
  
  
  http://www-912.ibm.com/s_dir/sline003.nsf/sline003home

- OS/400 - Host Servers, 5722SS1 option 12
- TCP/IP Connectivity Utilities, 5722TC1
- IBM Developer Kit for Java™, 5722JV1 plus the 1.4 JDK option for 5722JV1 (option 6)
- OS/400 - QShell Interpreter, 5722SS1 option 30
Domino software
Lotus Domino 7 for i5/OS (5733LD7)

There are three options that can be installed.

- 5733LD7 *BASE - This is the base option of Domino 7; this option is required.
- 5733LD7 option 1 - This contains the C API related files; installation of the C API is optional. If you want to run any application that uses the C API interfaces, you must install this software.
  
  **Note**  The C API option is not multi-version capable. Only one instance of this option can be installed on an i5/OS partition at a time. For more information, see "Installing multiple releases of Domino" in Chapter 12.
- 5733LD7 option 10 - This option contains the Domino 7 server code; installation of this option is required.

After installing all three options of Domino 7.0 for i5/OS, the DSPSFWRSC command will display the following output:

```
5733LD7  *BASE    5050    Lotus Domino 7 (5724E62)
5733LD7  *BASE    2924    Lotus Domino 7 (5724E62)
5733LD7    1        5050    Lotus Domino 7: C API
5733LD7   10       5050    Lotus Domino 7: Release 7.0.0
5733LD7   10       2924    Lotus Domino 7: Release 7.0.0
```

The Resource ID "5733LD7" is the i5/OS installed licensed program (LICPGM) value and the text "(5724E62)" that follows the Description is the IBM Lotus Passport Advantage product ID. While both values may be used to refer to the Lotus Domino 7 product, the 5733LD7 LICPGM value is specific to i5/OS.

For more information on installing the Domino software, see Chapter 3 "Installing Domino on your system."

Optional software
As your environment grows more complex, you may want to add software that is not necessarily required in order to run Domino for i5/OS. You have many options for complementing the Domino software to create a productive environment.

If you will be doing any application development with Domino 7, you may want to install the following software:

- OS/400 - System Openness Includes, 5722SS1 option 13
- ILE C Compiler, 5722WDS option 51
If you plan to manage your Domino environment using iSeries Navigator, the graphical user interface for managing an eServer i5 server, you must install the following additional software:

- IBM iSeries Access Base, 5722XW1 (V5R3)
- IBM iSeries Access for Windows, 5722XE1 (V5R3)

If you plan to use the Java server controller you must also install the following additional software:

- Crypto Access Provider 128-bit, 5722AC3 (V5R3)

**Recommended V5R3 individual PTFs**

The following V5R3 individual PTFs are recommended:

- 5722SS1 S116689 - OSP-INCORROUT C RUNTIME SETLOCALE CHANGE
  
  In certain situations, calls to the setlocale() routine will return an empty string rather than the correct locale string. The locale will have been set correctly by setlocale(), but the string result will be empty rather than having the correct value.

- 5722999 MF34557 - LIC-COMM JSSE does not detect when 5722AC3 is installed
  
  This PTF addresses Java controller/console connect errors that may occur if the controller is the only SSL application and no other SSL servers/applications have been previously started.

For more information on i5/OS fixes for Domino, see the Lotus Domino for i5/OS Support page on the Web at:


---

**Where do I find more information?**

Before installing and configuring Lotus Domino for i5/OS, be sure to review the Readme file located on the product CD-ROM or at Lotus developerWorks at the following Web address:


In addition, review the Domino for i5/OS Web site that includes the most up-to-date information on sizing recommendations and installation tips. The Web site is located at the following address:


---

6 Installing and Managing Domino 7 for i5/OS
You may also find the following resources helpful:

- The Lotus Domino home page:
  http://www.ibm.com/lotus/domino
- Lotus support for Domino and Notes:
  http://www.ibm.com/software/lotus/support
- The latest Domino and Domino for i5/OS documentation:
  http://www.ibm.com/lotus/ldd/doc
- Lotus products for i5/OS:
- IBM Redbooks including Domino and i5/OS information:
  http://www.ibm.com/redbooks
- The IBM eServer iSeries Information Center CD-ROM, which is provided with your system, has details about installing, setting up, and using TCP/IP. It also provides an overview of using IBM iSeries Access and iSeries Navigator. The latest version of the Information Center is located at the following Web address:
  http://www.ibm.com/eserver/iseries/infocenter

---

**How do I get fixes?**

IBM provides fixes to the Domino product in the form of Maintenance Releases and Fix Packs. Maintenance Releases typically follow a four month development cycle and are available for download from the Internet. Fix Packs are released as necessary and are also available for download from the Internet.

For the latest information on Maintenance Releases and Fix Packs, see the following Web site:

http://www.ibm.com/eserver/iseries/domino/support

Lotus Domino for i5/OS also requires cumulative Program Temporary Fix (PTF) packages and individual PTFs for IBM i5/OS. Other PTF packages, also known as group PTFs, are available to support specific types of Domino for i5/OS operations. Each cumulative PTF package or individual PTF includes installation instructions. For the latest information on PTFs required for i5/OS, see the following Web site:


From the **Software** menu, select **Licensed Program Products: V5R3** and click **Go**.

On the V5R3 page, click **Lotus Domino**.
If you already have Domino servers set up on your server, you can upgrade those servers to a later release of Domino by installing the new Domino for i5/OS software. The Domino server upgrade process may occur during installation or as post-installation step, depending on the release of Domino server being installed.

You do not need to go through the server setup procedure again when you upgrade to a new Domino release. However, you may want to change the server configuration to take advantage of new features provided by the new Domino release.

Whether you are upgrading from a version prior to Domino 7, or are upgrading to a new Maintenance Release, there are special considerations to keep in mind, as highlighted in the following two sections.

For more details, see "Installing the Domino software" in Chapter 3 and "Changing a Domino server's properties using iSeries Navigator" in Chapter 10.

**Considerations for upgrading from previous versions of Domino**

You should carefully consider what features you want to use with Domino 7 before upgrading, as this may have an impact on how you complete the upgrade. The following is a list of things to consider before starting the upgrade process.

- There are a number of Domino upgrade considerations documented by Lotus that are not specific to the i5/OS platform. It is strongly recommended that you read the information on upgrading in the following documents:
  - Domino administration documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF).
  - Release Notes for Domino/Notes 7 (README.NSF).
Domino 7 for i5/OS is structured in the same way as the Domino 6.0.3/6.5.0 and later releases. The product options available in Domino 7 are:

<table>
<thead>
<tr>
<th>Previous release feature</th>
<th>Domino 7 solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Logon (in option 1)</td>
<td>Available as download</td>
</tr>
<tr>
<td>Directory Synchronization (in option 1)</td>
<td>Not supported on Domino 6 or Domino 7</td>
</tr>
<tr>
<td>C++ API and toolkit (option 4)</td>
<td>Available as download</td>
</tr>
<tr>
<td>Operations Navigator plug-in (in option 1)</td>
<td>Included in each release's own *BASE product option</td>
</tr>
<tr>
<td>Advanced services (option 7)</td>
<td>Included in each release's own *BASE product option and controlled by the license agreement</td>
</tr>
<tr>
<td>C API (option 3)</td>
<td>Option 1</td>
</tr>
</tbody>
</table>

**Note** All of the downloadable features mentioned in the table can be found at Lotus developerWorks at the following Web address:

http://www.ibm.com/lotus/ldd

- The directory synchronization feature is not available in Domino 7 for i5/OS. If you are upgrading from Domino 5 and currently use directory synchronization, you must stop all tasks associated with it before attempting an upgrade. For more information, see "Ending Directory Synchronization tasks" later in this chapter.

- Support for the OS/400 Mail Server Framework (MSF)/AnyMail integration is not available in Domino 7. If you are upgrading from Domino 5 and currently use OS/400 MSF/AnyMail integration with OS/400 SMTP support and Domino in your environment, prior to upgrading to Domino 7, you must reconfigure your Domino servers to not use MSF.

  Additionally, as Domino for i5/OS no longer supports integration with OfficeVision/400 using the OS/400 MSF, it is no longer possible to route mail between the Domino server and an i5/OS mail application using MSF. It is still possible to route mail between the Domino server and a different i5/OS mail application, but the mail is now routed between the i5/OS SMTP server and the Domino SMTP server. To activate this change, you must reconfigure the Domino server and the i5/OS mail application to use separate TCP/IP addresses.

  For more information, see "Moving from Mail Server Framework to Native Notes" later in this chapter.

- Before upgrading your servers from Domino 5, you must verify that all mail has been delivered. For more information, see "Verifying that all mail is delivered" later in this chapter.

- You can no longer run under the original OS/400 HTTP server. If you are upgrading from Domino 5 and are using the original OS/400 HTTP server, you can either set up your Domino server to use the Domino HTTP server, or the IBM HTTP Server (powered by Apache). For more information, see Chapter 16 "Chapter 16 Using Domino as a Web server."

10 Installing and Managing Domino 7 for i5/OS
• Before upgrading your servers, make sure you properly back up all server data. For more information on backing up your server data, see Chapter 18 "Managing Backup and Recovery."

• After installing the software, compact the Domino Directory file (names.nsf). When compacting the file for the first time, you must run the compact operation while the Domino server is down. Compacting the database will convert it to the new format, which offers performance and functional enhancements. After the initial compaction, you can compact the Domino Directory file while the server is active.

To compact the Domino Directory file, type the following command at any i5/OS command line, and press Enter:

```rundomcmd server('servername') cmd('call pgm(qnotes/compact) parm(names.nsf)')```

where `servername` is the name of your Domino server instance.

• Make sure you also upgrade the Domino Directory template to the new version. You will be prompted in the server console to upgrade the template when you start each Domino server.

• Beginning with releases 6.0.3 and 6.5.0, the Domino plug-in for iSeries Navigator was changed from C++ based to Java based. If you use iSeries Navigator, you must uninstall the Domino plug-in from any release prior to 6.0.3 and 6.5.0, and install the version of the Domino plug-in supplied with Domino 6.0.3 or 6.5.0, or you will not be able to work with your upgraded Domino servers.

• If the server you are upgrading uses DECS, after upgrading, you must manually replace the design on the DECS administrator prior to running activities. For more information, see the DECS Installation and User Guide (decsdoc7.nsf).

• Fully translated versions of Domino are no longer available for any platforms in Domino 7. You must now first install the English version and then install language support from a separate Language Pack CD. If you are currently running a non-English version of Domino and continue to need that language in Domino 7, you should not upgrade until you have the necessary Domino 7 Language Pack CD.
Considerations for upgrading to future releases

In the future you may want to upgrade your Domino 7 servers to the latest Maintenance Release of the software. IBM Lotus typically releases a new Maintenance Release every four months. The following are items to consider when you upgrade to future releases:

- Before attempting to upgrade, stop all Domino servers for the release you are upgrading. For more information on stopping Domino servers and subsystems, see Chapter 10 "Managing a Domino Server Using iSeries Navigator."
- Verify that no users are attempting to run any Domino commands or tasks.
- Properly back up all server data for each Domino server.

For more information on obtaining Maintenance Releases from IBM, see the following Web site:

http://www.ibm.com/servers/eserver/iseries/domino/support/

What happens when the Domino software is upgraded?

When you upgrade to Domino 7 for i5/OS, the following occur:

- The code copies files into the system first. When installing the *BASE option, some objects are placed into the QNOTES library and the directory /QIBM/Userdata/Lotus/Notes. When installing a release's option, the objects are placed into the release-specific library and directory. For example, when installing the 7.0.0 release option, option 10, the objects are placed into the QDOMINO700 library and the /QIBM/ProdData/Lotus/DOMINO700 directory.

  **Note** If you are installing multiple releases on the same partition, a /QIBM/ProdData/Lotus/Notes symbolic link is created to point to the directory of the primary release. For more information on installing multiple releases on the same partition, see Chapter 12 "Using Domino for i5/OS Multi-version Capabilities."

- If the release being updated was not multi-version capable, the new Domino 7 software goes through and updates every existing Domino server on your server, then proceeds to copy files into each server's data directories.

- If it seems like the upgrade process has stalled, you may need to go into the Domino console to answer a prompt on whether to upgrade the Domino Directory to the new design, as it will wait until this is done. You can access the Domino console through the i5/OS command WRKDOMSVR.
During the software upgrade, Domino 7 will detect whether or not your Domino servers use the Domino Mail Transfer Agent (MTA) or MSF. If the upgrade program detects an R5.0x OS/400 SMTP with MSF server is configured, it will halt the installation. When the installation is halted, the user is notified and must change or remove the R5.0x OS/400 SMTP with MSF server. For more information on making these changes, see the section "Moving from Mail Server Framework to Native Notes" later in this chapter.

---

**Ending Directory Synchronization tasks**

If you are not using Directory Synchronization (Domino 5 only) with Domino, skip this section.

End all Directory Synchronization tasks by following these steps:

1. Using a Notes client, open the Directory Synchronization configuration database.
   - Choose **File -> Database -> Open**.
   - In the server field, enter the name of the Domino server.
   - Select the Directory Sync Configuration (NNDIRSYNC.NSF).
   - Click **Open**.

2. Click **Configurations**.

3. Select the configuration document for the configuration that you want to end and click **Edit Configuration**.

4. Change the status of the configuration to **Disabled** or **Suspended**.

5. Click **Save and Close**.

**Note** Directory Synchronization may take several minutes to end.

---

**Ending the MSF and SMTP services**

If you are not using MSF/AnyMail with Domino, skip this section.

To end the Mail Server Framework, type the following command at any i5/OS command line and press Enter:

```
ENDMSF
```

By default, the MSF jobs will end after all MSF messages are processed or within 30 seconds.
To end the SMTP server, type the following command at any i5/OS command line and press Enter:

```
ENDTCPSVR *SMTP
```

---

**Moving from Mail Server Framework to Native Notes**

If your current Domino server uses the Mail Server Framework (MSF) with i5/OS SMTP support, you must change the server to use Domino SMTP before upgrading to Domino 7 for i5/OS if your Domino server is currently at R5.0x, and it must be removed if your Domino server is at R4.6x.

If you attempt to upgrade without changing your R5.0x OS/400 SMTP and MSF supported server, the upgrade process will stop immediately and issue the following escape message:

```
CPF9897 *R5.0X *MSF SMTP CONFIGURED SERVERS HAVE BEEN DETECTED ON THIS SYSTEM. CONSULT THE DOMINO 6 FOR ISERIES INSTALLATION GUIDE FOR DETAILED INFORMATION AND INSTRUCTIONS FOR UPGRADING YOUR R5.0X *MSF SMTP MAIL SERVERS.
```

You must either remove this server or change it to use Domino SMTP before proceeding with the upgrade.

To change your server to use Domino SMTP using iSeries Navigator, make sure your Domino server is stopped and follow these steps:

1. Open the system where you will upgrade to Domino 7.
2. Click **Network**.
3. Click **Servers**.
4. Click **Domino**.
5. Right-click the Domino server you need to change, and select **Properties**.
6. On the Mail tab, select the check box that indicates **Simple Message Transfer Protocol (SMTP)** and click **OK**.

![Image of Mail tab with SMTP checked and OK button highlighted]

7. Restart your Domino server to make the changes take effect.

**Tip** You can also use the CHGDOMSVR SMTP(*DOMINO) command to change your Domino server to use Domino SMTP. For more information on the CHGDOMSVR command, see Appendix C "Using i5/OS Commands With Domino for i5/OS."
Verifying that all mail is delivered

Prior to upgrading from Domino 5, you should verify that all Domino 5 mail has been delivered. If you find that mail still exists in the integrated file system directories, then you must find another way to deliver the mail. To verify that all mail has been delivered using iSeries Navigator, follow these steps:

1. Open the inbound and outbound mail directories in the i5/OS integrated file system.
   - Open the system where you are upgrading Domino.
   - Click File Systems.
   - Click Integrated File System.
   - Click Root.
   - Open the /QIBM/userdata/lotus/smtpmta/inbound directory
   
   **Note** To verify that there are no outbound messages, open the /QIBM/userdata/lotus/smtpmta/outbound directory.

2. Verify that no messages are in the directory.

3. If you see files located in either directory, then you must deliver the messages using an alternate method.

Performing the Domino upgrade

Once you have satisfied all upgrade requirements, you are ready to upgrade your Domino servers.

There are several ways you can upgrade your Domino servers. Each way provides a slightly different experience. This section will only document the upgrade steps using iSeries Navigator. For a general idea of the other upgrade path options, see Chapter 3 "Installing Domino On Your System."

To upgrade to Domino 7 using iSeries Navigator, follow these steps:

1. Open the system where you will upgrade your Domino servers.
2. Click Network.
3. Right-click **Servers** and select **Install and Configure Domino**.

Follow the directions on each panel of the wizard. For help with a particular setting, click **Help**.

**Tip** You can also use the LODRUN command or run the setup.exe program from the root directory of the product CD-ROM. For more details, see Chapter 3 "Installing Domino on your system."

---

**How do I upgrade the Domino for iSeries Navigator plug-in?**

If you previously installed the Lotus Domino plug-in for iSeries Navigator (part of IBM iSeries Access), upgrade the plug-in components on the client workstation. Whenever you install a new release of Domino (including Maintenance Releases), you should always upgrade the Domino plug-in component on the client workstation or you may not be able to use some new Domino plug-in administration features when working with the new Domino server release. Newer Domino plug-in versions are backward compatible with prior versions of Domino.
To upgrade the Domino for iSeries Navigator plug-in, follow these steps:

1. Connect the client to the system where you installed the Domino software.
2. From the client, set up this system as your Administration system.
   - If you are using iSeries Access for Windows, choose:
     
     **Start - IBM iSeries Access - iSeries Access Properties**
     
     Click the Administration System tab and change the Administration system to the system with the old Domino software. Then click **Apply**.
   - If you are using iSeries Access for Web, choose:
     
     **Start - IBM iSeries Access - iSeries Access Properties**
     
     Click the Administration System tab and set the Source Directory to the share that you used to access the iSeries when you added the Domino plug-in; for example, `\mysystem\QIBM`. Then click **Apply**.
     
     If the share does not exist, you must recreate it. For an example, see steps 1 through 5 in the procedure for adding the Domino plug-in on a workstation using iSeries Access.
     
     For details on adding the Domino plug-in and creating a share on a workstation that is using iSeries Access, see Chapter 5 "Preparing the Administrator's Workstation."

3. Start the Check Version program. This program may start automatically, depending on the settings on the Service tab of the iSeries Access Properties (see the previous step).
   
   To force the Check Version program to run, choose:
   
   **Start - IBM iSeries Access - Service - Check Service Pack Level**

4. When the Check Version program runs, read the messages carefully. Depending on the level of iSeries Access on the client and level on the current managing server, you could receive warnings.
   - You can ignore warnings that the iSeries Access level on your managing server is at an earlier level than your client.
   - Follow the instructions about updates for iSeries Navigator plug-ins. Check Version will copy the plug-in files to your client workstation.

5. Once the updated plug-in is on your client, the plug-in must be applied for each system in your iSeries Navigator tree. To apply the plug-in, open each system in iSeries Navigator. iSeries Navigator detects the change and "scans" the system to automatically apply the change.
Chapter 3
Installing Domino on your system

This chapter will help you install the Domino server software. It also describes the special authorities needed by your user profile, and the necessary steps to verify the installation.

i5/OS authorities required to install and configure Domino

The i5/OS operating system has extensive security restrictions to prevent unauthorized access to system functions and data. The administrator who installs and configures Domino must sign on to the system with a user profile that has the required authorities.

To install the Domino software, your user profile must have the following special authorities:
- All object access (*ALLOBJ)
- Security administration (*SECADM)

To configure a Domino server, your user profile must have the following special authorities:
- All object access (*ALLOBJ)
- System configuration (*IOSYSCFG)
- Job control (*JOBCTL)
- Security administration (*SECADM)

Checking your user profile using iSeries Navigator

The system security officer has the required authorities to install and configure Domino. If you are not the security officer, check to see if your user profile has the required authorities by following these steps:

Open the system where you will install Domino.

- Click Users and Groups.
- Click All Users.
- Right-click user-id
  where user-id is the name of your user profile.
• Click Properties.
• Click Capabilities.

The authorities granted to your user profile are displayed on the Privileges tab.

If your user profile does not have the required authorities, ask the security officer to either install and configure Domino or add the required authorities to your user profile.

Checking your user profile using commands

The system security officer has the required authorities to install and configure Domino. If you are not the security officer, use the Display User Profile (DSPUSRPRF) command to determine if your user profile has the required authorities. To check your user profile, follow these steps:

1. On any i5/OS command line, enter the following command:
   
   DSPUSRPRF USER-ID
   
   where USER-ID is the name of your user profile.

2. Press the PAGE DOWN key and look for the special authority field to display the special authorities for the user profile.

If your user profile does not have the required authorities, ask the security officer to either do the installation and configuration or to add the required authorities to your user profile.
Verifying the installed software

You can determine what software is installed on your system by using iSeries Navigator or by entering i5/OS commands.

Checking for installed software using iSeries Navigator
To verify your software using iSeries Navigator, follow these steps:

Verify the release of the installed software.
- Open the system where you will install Domino.
- Click Configuration and Service.
- Click Software.
- Click Installed Products.

On the right, you will see a list of the products installed on your system.

To find the release of Domino you are running, look for 5769LNT (Domino 5), 5733LD6 (Domino 6), 5733L65 (Domino 6.5), or 5733LD7 (Domino 7) in the Product column. Look under the Release column to see which release(s) of Domino you are running.

Checking for installed software using commands
To determine what software is currently installed on your system, type the following command and press Enter:

DSPSFWRSC

The Resource ID column shows the program number, such as 5769LNT, 5733LD6, 5733L65, or 5733LD7 for Domino. Press F11 to see the version and release of the software.

What should I know before I install Domino?

This section highlights some of the decisions administrators should make before they install Domino on their system.

Before you install and set up your first Domino server, you must plan server and organizational naming and security. In addition, you must understand your existing network configuration and how Domino will fit into the network. If you are new to the Domino family of products, review the Lotus Domino Administration documentation for more information on planning issues. This documentation is available from Lotus developerWorks at the following Web address:

http://www.ibm.com/lotus/ldd/doc
Note You can also access this information after installation from the following location on your server:

/QIBM/ProdData/LOTUS/DOMINOxxx/DATA/HELP/help7_admin.nsf

where DOMINOxxx is the directory corresponding to the release of Domino (for example, DOMINO700 for Domino 7.0).

Domino servers and subsystems must be stopped while installing software
If you already have Domino servers configured on the system, make sure you stop these servers and all Domino subsystems before installing the Domino 7 for i5/OS software.

Note If all configured servers are multi-version capable servers, you can install the Domino software while they are still running.

For more information on stopping Domino servers and subsystems, see Chapter 10 "Managing a Domino Server Using iSeries Navigator."

Server data directory should not be in QIBM directory
When setting up a Domino server, do not specify the Domino product directory (/QIBM/ProdData/...) or the Domino user directory (/QIBM/UserData/...) for the location of the server data directory. Putting the server data directory within the product directory could cause problems when operating the server, especially if you run more than one Domino server on your system.

A commonly used location for the server data directory is:

/lotus/domino/data

If you have more than one Domino server on your system, you could specify a location such as:

/lotus/domino/servername/data

where servername is the name you specify for each server.

Note In Domino 6 and later versions, use of the Domino product directory (/QIBM/ProdData/...), the Domino user directory (/QIBM/UserData/...) or the root directory in the Data Directory parameter (DTADIR) on the Configure Domino Server (CFGDOMSVR) command is checked. If found, a failure of the command with message LNT0102 (Path specified not valid) will occur. This will also cause the GUI server setup wizard to fail if the Domino product directory (/QIBM/ProdData/...), the Domino user directory (/QIBM/UserData/...) or the root directory is specified. The setup wizard also invokes the CFGDOMSVR command.
**Network communications error**
If network communications are not set up correctly, you will receive the following error message during installation using InstallShield or server setup using the setup wizard:

![Server setup alert](image)

Make sure you satisfy all the requirements in this message before attempting the installation again. For more information, see Chapter 4 "Planning the Domino for i5/OS Environment."

**QNOTES user profile requirements**
In order to function correctly, Domino 7 for i5/OS requires *RWX (read, write, and execute) access to the root integrated file system directory. For example, when creating new Domino servers, a new directory needs to be created off of the root directory for the associated new Domino data directory. By default, i5/OS sets the public access to the root integrated file system directory to *RWX. However, for security reasons, some administrators may decide to restrict public access. For example, public access may be set to *X (execute). In this case, the QNOTES user profile should be given *RWX access to the root integrated file system directory.

---

**Is my server properly sized?**
Properly sizing your system is crucial to the success of your Domino environment. IBM provides an online tool, the IBM Workload Estimator, to help you assess your environment and provide sizing recommendations. This tool is located at the following Web address:

http://www.ibm.com/eserver/iseries/support/estimator

---

Chapter 3: Installing Domino on your system  23
Installing the Domino software

Before installing the Domino software, verify the following:

• You have a user profile with the required authorities to install and configure Domino. For more information about required authorities, see "i5/OS authorities required to install and configure Domino" earlier in this chapter.

• You have installed the required hardware and software. For more information, see "Domino for i5/OS server requirements" in Chapter 1.

• Your operating system is IBM i5/OS V5R3 or later. If your operating system is not at the V5R3 level, you must upgrade it before installing Domino 7.

  If you are upgrading from Domino 5 to Domino 7, you must upgrade from the latest version of Domino 5 (5.0.13). Note that Domino 5 cannot be installed and is not supported on i5/OS V5R3, but you can upgrade from OS/400 V5R2 with Domino 5 installed to i5/OS V5R3 for the purpose of upgrading Domino 5 to Domino 7.

• Any previous beta or pre-release versions of Domino 7 have been removed using DTLICPGM.

• TCP/IP is set up and active on your system. For more information about setting up TCP/IP, see the IBM eServer iSeries Information Center at the following Web address:
  http://www.ibm.com/eserver/iseries/infocenter

What software should I install?

When you install the Domino server software, you can also install i5/OS integration software and application development software. Decide which of the following product options you want to install.

**Note** You can install the application development software later if you are not sure you need it.

**Lotus Domino 7** (*BASE option) defines the product options that can be installed for a specific product ID. This option must be installed before any product option can be installed.

**Product Option** contains the programs, data, and template files needed to run a specific release of Domino. You must select this option to install and run a Domino server. This option includes all Domino help databases. For example, 5733LD7 option 10 is the product option for 7.0.0.
**C API (option 1)** contains the header files and modules for creating Notes C applications that can run on a Domino server on i5/OS.

**Note** The C API option is not multi-version capable. Only one instance of this option can be installed on a partition at a time. For more information, see "Installing multiple releases of Domino" in Chapter 12.

To determine if a more recent version of the C API is available, check the Domino Developer Tools section of the following Web site:


**Language support**

With Domino 7 for i5/OS, you can run more than one language on a server or can have Domino servers running with different languages using the Domino Language Pack and multi-lingual database support. If you plan to run more than one language on a Domino server, you must install the language pack in addition to the Domino software. During the Domino installation process, you have the opportunity to specify whether or not you will be using multiple languages. If so, the language pack installation process will automatically be launched. For more information on using multiple languages, see Chapter 20 "Using National Language Versions of Domino."

**How do I install the Domino software?**

There are several ways you can begin the installation of the Domino software. Each way provides a slightly different experience, but all accomplish the same tasks. You can install the Domino software using any of the following methods:

- **Launch the Domino Server Installation and Setup Wizard through iSeries Navigator.** This method uses the InstallShield graphical interface and allows the product CD-ROM to be in either your workstation or the optical drive of the server.
- **Launch the Domino Server Installation and Setup Wizard through EZ Setup.** This method uses the InstallShield interface and allows the product CD-ROM to be in either your workstation or the optical drive of the server.
- **Use the InstallShield interface directly by running the setup.exe file from the product CD-ROM.** This method allows the product CD-ROM to be in either your workstation or the optical drive of the server.
- **Use the LODRUN command through the i5/OS command line interface.** This method requires the product CD-ROM to be in the optical drive of the server. 
- **Use the RSTLICPGM command through the i5/OS command line interface.** This method requires the product to be in the save file form. This is typically used for installing images from the Web.
Using iSeries Navigator to launch the Domino Server Installation Wizard
To install and configure a Domino server using iSeries Navigator, follow these steps:

1. Open iSeries Navigator.
2. Open the system where you will install and configure a Domino server.
3. Click Network.
4. Right-click Servers and select Install and Configure Domino.

Follow the directions on each panel of the wizard. You will be prompted to insert CD-ROM 2 during the installation. For help with a particular setting, click Help.

Once you complete the installation, you are given the option to launch the Domino Server Setup Wizard.

Using EZ Setup to launch the Domino Server Installation Wizard
The EZ Setup CD-ROM was shipped with your system. You can use EZ Setup to configure basic system values, security settings, and aspects of your network environment. During the EZ Setup process, you can indicate that Domino will be used on your system. Indicating this will launch the Domino Server Installation Wizard automatically.
Once you complete the installation, you are given the option to launch the Domino Server Setup Wizard.

**Using InstallShield from the product CD-ROM**
You can launch the InstallShield wizard by running the setup.exe file from the Domino product CD-ROM using a workstation with Windows installed. The setup.exe file is in the root directory of CD-ROM 1. For example, the file will be found at the following location:

\[d:\\]setup.exe

where \(d\) is the letter assigned to your CD-ROM drive. You will be prompted to insert CD-ROM 2 during the installation.

Once you complete the installation, you are given the option to launch the Domino Server Setup Wizard.

**Using the LODRUN command through the i5/OS command interface**
To install the Domino software using the LODRUN command, follow these steps:

1. Insert CD-ROM 1 of the Domino for i5/OS CD-ROM set into the system's optical drive.
2. On any i5/OS command line, type the following command and press Enter:
   
   \[LODRUN DEV(*OPT) DIR('/OS400')\]

3. Select each product option that you want to install by typing a 1 beside the product option. Selecting the option that defines the release you want to install will automatically install the *BASE option if it is not already installed. Select Option 1 if you want to take advantage of the C API functions.
4. Press Enter to install the product options that you selected.
6. Press Enter to continue the installation.

**Using the RSTLICPGM command through the i5/OS command interface**
The Restore Licensed Program command can be used to install the Domino software if you downloaded it as a Web electronic image, for example. To use the RSTLICPGM command, follow these steps:

1. On any i5/OS command line, type the following command and press Enter:
   
   \[RSTLICPGM\]
2. On the Restore Licensed Program display, enter the following values into the fields provided:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Specify the installed Domino licensed program number.</td>
<td>5733LD7 for Domino 7 for i5/OS</td>
</tr>
<tr>
<td>Device</td>
<td>Specify the device used for restoring the software.</td>
<td>*SAVF</td>
</tr>
<tr>
<td>Optional part to be restored</td>
<td>Specify the option you want to restore.</td>
<td>*BASE, 1, release option</td>
</tr>
</tbody>
</table>

Note  The RSTLICPGM command must be issued once for each option you install.

For the remaining fields, you can accept the default values provided, or enter the values appropriate for your specific environment.

Note  If the primary language of your system is not English 2924, you should change the LNG value from the default (*PRIMARY) to 2924, or you will get an error stating that the LNG objects for the product were not found on the save file.

3. Press Enter to run the restore command.

What happens when the Domino software is installed?

- Licensed program objects, such as programs (*PGM) and service programs (*SRVPGM), are placed in the release-specific library, such as QDOMINO700.
- Miscellaneous objects, such as the following, are placed in the QUSRNOTES library:
  - All the Domino subsystem descriptions
  - All the data queues and job queues for the servers
  - The status of the servers
- Basic Domino files, such as .nsf and .ntf types, and files that contain symbolic links to the programs, service programs, and other objects in the release-specific library are created in the release-specific directory in the i5/OS integrated file system, such as /QIBM/ProdData/Lotus/DOMINO700. These symbolic links provide access to the objects in the release-specific library from the integrated file system.

The integrated file system provides a directory structure similar to the Domino installation on a Windows or UNIX operating system.
• The /QIBM/USERDATA/LOTUS/NOTES directory is created in the integrated file system. Users who create programs to be accessed by Domino must add symbolic links to their programs in this directory.

• The QNOTES user profile is created for use by Domino and Notes application programs that run on the server. This user profile is intended for use of system functions by Domino and for integration with the underlying i5/OS security mechanisms. Therefore, it does not have a password. Individual users cannot use the QNOTES user profile to sign on to the system. The QNOTES user profile should not be deleted.

Verifying that the Domino software is installed

To verify that the Domino software is installed using iSeries Navigator, follow these steps:

1. Open the system where you installed the Domino software.
2. Click Configuration and Service.
3. Click Software.
4. Click Installed Products.
   In the right-hand pane, you will see a list of products installed on the system. In the Product column, look for 5733LD7. There should be at least one item with this product code for each option that is installed.

   To see the version that is installed on the system, look under the Release column. For example, release 7.0.0 is displayed as V7R0M0.

To verify that the Domino software is installed using i5/OS commands, follow these steps:

5. Enter the following i5/OS command to display a list of installed software: DSPSFWRSC

6. Look for items that have a Resource ID of 5733LD7. There should be at least one item with this Resource ID for each product option that is installed.

   To see the Domino 7 for i5/OS version that is installed on your system, press the F11 key. The Release column indicates the version. For example, release 7.0.0 is displayed as V7R0M0.
Domino 7 for i5/OS uses the TCP/IP protocol for the Notes client and server connections. As you set up your TCP/IP and Domino environment, keep the following items in mind:

- You can configure your Domino server to start automatically after TCP/IP is started on your system. The default for this setting is No, but you can change this during server setup.
- Since i5/OS V5R3 and Domino both provide some of the same Internet protocols, it is possible for port conflicts to occur if the Domino server or system are not configured correctly. Services such as SMTP, POP3, HTTP, and LDAP need to be configured so that they do not conflict. For more information on configuring services to avoid port conflicts, see Chapter 15 "Using Domino as a Mail Server," Chapter 16 "Using Domino as a Web Server" and Chapter 17 "About Directory Services and Domino."

How should I set up TCP/IP for Domino for i5/OS?

This section provides a simple list of steps that must be performed in order to set up TCP/IP for Domino on your system. For more information on setting up a TCP/IP environment, see the documentation for TCP/IP in the IBM eServer iSeries Information Center at the following Web address:

http://www.ibm.com/eserver/iseries/infocenter

To set up TCP/IP for Domino on your system, follow these procedures:

1. Create a line description for your TCP/IP interface.
2. Add a TCP/IP interface.
3. Start the TCP/IP support on your system, then start the new TCP/IP interface.
4. Verify that the TCP/IP connection is active.

Verifying TCP/IP setup and status

The Domino server on i5/OS communicates with Notes workstations and other external resources such as the Internet through TCP/IP. For the Domino server to work properly, TCP/IP must be set up and active on your system.
TCP/IP configuration greatly impacts server performance. For more information on tuning your network for optimal performance, see the book *TCP/IP Configuration and Reference* (SC40-5420-04). You can access this book online through the IBM eServer iSeries Information Center at the following Web address:

http://www.ibm.com/eserver/iseries/infocenter

### Determining if TCP/IP is set up
TCP/IP may already be set up on your system. To verify that it is set up as needed for the Domino server, follow these steps using iSeries Navigator:

1. Open the system where you installed Domino.
2. Click **Network**.
3. Click **TCP/IP Configuration**.
4. Click **Interfaces**.
5. On the right-hand pane, you will see a list of TCP/IP interfaces configured on the system. Look for an Internet address that does not have a line description of **Loopback**.
   - If you do not see an Internet address other than the address associated with **Loopback**, you must set up TCP/IP. For more information, see the IBM eServer iSeries Information Center at the following Web address:
     http://www.ibm.com/eserver/iseries/infocenter
   - If you see an Internet address other than the address associated with **Loopback**, TCP/IP is already configured. Continue to the following procedure.

**Tip** You can also use the CFGTCP command to determine if TCP/IP is set up. From the Configure TCP/IP display, select option 1 (Work with TCP/IP interfaces).

### Determining the Internet address and host name to use for Domino
1. Record an Internet address from the previous procedure that is not associated with **Loopback**.
   - **Tip** If there is more than one Internet address, choose one of the addresses to use for your Domino server. It is recommended that you use a unique Internet address for each Domino server.
2. Find the host name that is associated with the Internet address:
   - If you are using a Domain Name Service (DNS), look in the DNS server for the host name that is associated with the Internet address.
   - If you are using host tables for your TCP/IP network, use the TCP/IP host table entries on your system to find the host name that is associated with the Internet address. To view the host table entries using iSeries Navigator, right-click **TCP/IP Configuration** and select **Properties**. On the TCP/IP Configuration properties display, select the **Host Table** tab.
3. Record the TCP/IP host name you will use for the Domino server.

By using an existing host name and Internet address for the Domino server, you can take advantage of the existing TCP/IP configuration and avoid additional configuration.

**Tip** You can also use the CFGTCP command to determine the Internet address and host name to use for Domino. From the Configure TCP/IP display, select option 10 (Work with TCP/IP Host Table Entries).

### Starting TCP/IP

Once TCP/IP is set up for your system, make sure TCP/IP is started. To start TCP/IP using iSeries Navigator, follow these steps:

1. Open the system where you installed Domino.
2. Click **Network**.
3. Right-click **TCP/IP Configuration** and select **Start**.
4. Periodically press F5 to refresh your screen and wait for the TCP/IP status to be **Started**.

**Tip** You can also use the CFGTCP command to start TCP/IP. From the Configure TCP/IP display, select option 1, then type a 9 next to the TCP/IP address you want to start, and press Enter.

**Note** If TCP/IP is already started, the system responds with a message that indicates TCP/IP is currently active.

### Verifying TCP/IP interface status

To verify the status of any TCP/IP interface on your system using iSeries Navigator, follow these steps:

1. Open the system where you installed Domino.
2. Click **Network**.
3. Click **TCP/IP Configuration**.
4. Click **Interfaces**.

In the right-hand pane, you will see a list of all the TCP/IP interfaces configured on the system. Look under the **Status** column to determine the status of the TCP/IP interface.

**Tip** You can also use the CFGTCP command to determine the status of your TCP/IP interface. From the Configure TCP/IP display, select option 1, then type a 5 next to the TCP/IP interface.
How does Domino 7 interact with other programs on my server?

Since Domino easily integrates with many other software programs, it is very common to have an environment with many applications working together for complete enterprise solutions. If you currently have an environment with multiple applications integrated with Domino (such as IBM Lotus Sametime® or IBM Lotus QuickPlace™) you should check the documentation for those products for their compatibility with Domino 7.
Chapter 5
Preparing the administrator's workstation

To manage your Domino server on i5/OS, you must set up an administrator's workstation to communicate with your system through TCP/IP. Once you have a workstation communicating with your system, you can choose any of the following methods for managing your Domino environment:

**iSeries Navigator**
Using iSeries Navigator to administer your Domino environment provides a unique advantage when running Domino on the i5/OS platform. This tool allows you to perform administrative functions for both Domino and i5/OS using one interface, integrating many functions for a seamless administration experience.

**Domino Administrator client**
The Domino Administrator client is a separate installable tool, allowing you to perform administration functions through a Notes interface. Using the Domino Administrator client, you have access to all administration functions for Domino, but it provides no ability to manage your i5/OS environment.

**Caution** You must use the Domino Administrator 7 client to manage Domino 7 servers. Do not attempt to use a Domino 6 Administrator client.

**Domino Web Administrator**
The Web Administrator provides a way to manage your Domino environment through a Web browser. You can administer your Domino servers from any workstation, without having to install specific software. To access the Web Administrator from any workstation, open a browser and enter the following Web address:

http://servername/webadmin.nsf

where *servername* is the name of your Domino server.

When prompted, type the Administrator's ID and password and click **OK**.
Installing iSeries Navigator

The preferred way to manage your Domino environment is through iSeries Navigator. iSeries Navigator is part of the IBM iSeries Access family of products, and runs on a workstation that is communicating with your system through TCP/IP.

To use iSeries Navigator, you must install iSeries Access on a workstation that is running a Microsoft Windows operating system. All of the software needed for running iSeries Access is included in the i5/OS software that is pre-loaded on your system.

For detailed information on installing iSeries Access and iSeries Navigator on your workstation, see the IBM eServer iSeries Information Center at the following Web address:

http://www.ibm.com/eserver/iseries/infocenter

Verifying that NetServer is running

NetServer allows you to access i5/OS directories from your workstation. To verify that the NetServer is running, follow these steps:

1. Open iSeries Navigator.
2. Open the system where you installed the Domino software.
3. Click Network.
4. Click Servers.
5. Click TCP/IP.
   On the right, you will see a list of servers that should include NetServer.
   If the NetServer status is Started, then proceed to "Verifying access to the NetServer file share."
   If the NetServer status is not Started, right-click iSeries NetServer and select Start.
   Tip You can also use the STRTCPSVR *NETSVR command to start NetServer.
   If you do not see NetServer on the list, see the Client Access Express for Windows - Setup documentation (SC41-5507) for information on configuring NetServer.
7. Record the name of the NetServer, as you will need this information in the next section.
Verifying access to the NetServer file share

To verify access to the NetServer file share, follow these steps:

1. In iSeries Navigator, open the system where you installed the Domino software.
2. Click File Systems.
3. Click Integrated File System.
4. Click Root.
   A NetServer file share already exists for QIBM if you see a hand holding the QIBM folder.
   If a share does not exist, right-click the QIBM folder and select Sharing -> New Share. When the NetServer File Share dialog box appears, click OK.
5. On your Windows workstation, click the Start button and select Search -> For Files or Folders.
6. On the Search Results dialog box, click the Tools pull-down menu and select Map Network Drive.
7. Select the drive letter that you want to use for the NetServer file share.
8. In the Folder field, type the following and press Enter:
   \servername\QIBM
   where servername is the name of the NetServer.
You will see a message indicating that your workstation is communicating with the file share.

Caution  You should not map the Domino server data directory on the system as a network drive from a Notes client workstation. When the Notes client accesses the data directory of the Domino server through a mapped network drive, the NOTES.INI file of the server may be overwritten with the path of the client data directory. In addition, corruption of the NOTES.INI is possible if a user on the client double-clicks a Domino database that resides on the mapped network drive.
One possible consequence of this corruption is that the next time the server is stopped and restarted, the server ends with an error of 'X'00000108' in the QNNINSTS job log. The client can write over the NOTES.INI of the server even if the server is not running.

If your workstation is unable to connect to your NetServer file share, see the Client Access Express for Windows - Setup documentation (SC41-5507) for information on configuring NetServer.
Installing the Domino plug-in

The Domino plug-in for iSeries Navigator must be installed if you want to manage your Domino environment using iSeries Navigator. Installing the plug-in adds folders and objects to the hierarchy tree, choices to menus, and additional property pages to the property sheet for a folder or object in iSeries Navigator.

Once you have installed iSeries Navigator on your workstation, and the Domino software is installed on your server, you can install the Domino plug-in on your workstation by following these steps:

1. Open iSeries Navigator.
2. Click the File pull-down menu and select Install Options -> Install Plug-ins.
3. On the Install Plug-ins display, choose the server where you installed the Domino software and click OK.
4. Follow the prompts in the iSeries Access selective setup wizard to install the Domino plug-in.

Tip Every time you install a new release of Domino onto your server, you should update the Domino plug-in to the new version shipped with the new release of Domino.
Chapter 6
Setting Up a First Domino Server

If you are setting up a Domino domain in your organization for the first time, or are creating a new domain, follow the instructions in this chapter to set up a first Domino server. If you are adding a new server to an existing Domino domain, see Chapter 8 "Setting Up an Additional Domino Server."

You can choose to set up your first Domino server using iSeries Navigator, EZ Setup, or i5/OS commands. You can also start the Domino Server Setup Wizard by opening executable files directly from the product CD-ROM.

Using iSeries Navigator
To set up the first Domino server on your system using iSeries Navigator, follow these steps:

1. Open iSeries Navigator.
2. Open the system where you installed the Domino software.
3. Click **Network**.
4. Click **Servers**.
5. Right-click **Domino** and select *New -> New Domino Server*.

The Java-based Setup Wizard will be launched. Complete the fields in the wizard using the information in the next section "Deciding what to specify for server characteristics."

**Tip** You can also use the CFGDOMSVR command to set up a Domino server on your system. For more information on the CFGDOMSVR command, see Appendix C "Using i5/OS Commands With Domino for i5/OS."

Using the Domino Server Setup Wizard
You can launch the Domino Server Setup Wizard directly from the product CD by running the domwzd.exe file. This file is located in the root directory of the CD and can be run from the workstation. For example, the file can be found at the following location:

d:\domwzd.exe

where d is the letter assigned to your CD-ROM drive.
**Tip** You can now use a record/playback feature for using a server setup profile and performing silent setups of Domino servers. For example, to record a setup script, open a DOS prompt on your workstation and enter the following command:

```
    domwzd.exe  -record  -os400
```

To play back the setup script, enter the following command:

```
    domwzd.exe  -playback  -os400
```

For more information on using a server setup profile, see the Lotus Domino Administrator 7 Help online or the Domino Administrator Help database (HELP7_ADMIN.NSF).

---

**Deciding what to specify for server characteristics**

When you set up the first Domino server, you must provide information that defines the key characteristics of the server. These characteristics include the name of the server, the location of the server's data directory, the name of your organization, and details about the person who is the server administrator. Before starting the setup, decide what to use for those key characteristics. Here are some recommendations. For more information, see the Domino administration documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF).

**Server name**

To avoid additional TCP/IP configuration, use the TCP/IP host name of your system as the server name.

Each Domino server has a unique name that is maintained in its own ID file. Domino creates the server ID automatically during the server setup processing.

For more information about setting up TCP/IP, see the previous discussion of "Verifying TCP/IP setup and status" in Chapter 4.

**Option**

This field allows you to select whether this is the first Domino server, an additional Domino server, or if you are removing a Domino server.

For your first Domino server, specify *FIRST in this field.

**Data directory**

The data directory contains files used by the Domino server and users of the server. On a PC-based platform, the data directory typically has the directory path:

```
    x:\notes\data
```

where x is the drive letter.
On i5/OS, the files are stored in the integrated file system, which supports a directory structure similar to that of Linux or UNIX. To make the path easy to remember, specify a similar directory path on the system. For example:

```
/domino/servername/data
```

where `servername` is the name of your Domino server.

**Note** Be sure to use a forward slash (/) to specify a path in the i5/OS integrated file system.

Each server must have its own data directory. Therefore, if you set up more than one Domino server (partitioned servers), be sure to specify the unique server name in the directory path for the second and subsequent servers.

**Note** If you use an existing directory as the data directory, make sure that you set up the necessary authorities to the directory. The QNOTES user profile must have *RWX data authority as well as *OBJEXIST and *OBJMGT object authority to the directory. The owner of the data directory and subdirectories must have *OBJEXIST and *OBJMGT authority to the directory.

**Organization (This option only available for first server setup)**

Typically, the organization name is the name of your company or a major division within your company.

Each organization has a Certifier ID that is stored in a file named CERT.ID. During the server setup processing, Domino creates the organization Certifier ID automatically using the organization name you specify and an optional country code. When you register new users or servers, Domino uses the Certifier ID to certify each user or server. You also use the organization Certifier ID when you create organizational unit certifiers for a hierarchical name scheme.

**Administrator (This option only available for first server setup)**

The administrator can perform operations on the Domino server, such as starting and stopping the server. Although you only need to provide a last name, use a first name and, if needed, a middle name to make sure the administrator's name is unique. Make sure you keep a record of the name and password that you specify for the administrator. Also provide an Internet password if you plan to manage the server from a Web browser.

Domino creates a user ID for the administrator during the setup processing.

**Time zone**

The Time zone field determines the time stamp that the server uses for documents and databases.

**Daylight savings time**

Use this option to select whether or not your server should adjust for Daylight savings time.
Get Domino Directory from (This option only available for additional server setup)
Select which server will be used for replicating the Domino Directory to this server.

Domino Directory type (This option only available for additional server setup)
Select the type of Domino Directory you are using.

Additional server ID (This option only available for additional server setup)
Specify the name and password for the additional Domino server ID.

Web browsers
Use this option to set up the HTTP Web server feature, the Internet Inter-ORB Protocol (IIOP) feature, or both. Both features enable Web browsers to access the Domino server. The HTTP server feature only supports transmission of text. The IIOP feature enables Web browsers and servers to exchange complex objects, including both Notes objects and Object Request Broker (ORB) objects.

Internet mail packages
Use this option to set up one or more mail protocols, such as IMAP, POP3, and SMTP. Select SMTP if you plan to use Domino mail or want to exchange mail with mail systems that are based on i5/OS, such as OfficeVision/400™.

Directory services
Use this option to set up Lightweight Directory Access Protocol (LDAP) support on the server.

Connection services
Specify whether or not to include the Domino Enterprise Connection Services (DECS) in the server configuration.

Advanced Services
If you selected the Domino Enterprise Server type of installation, use this option to include one or more Advanced Services features, such as billing and clustering.

Default ACL settings
Specify what access control list configuration will be applied to all databases and templates on this server.

Text description
If you want, enter a text description of this Domino server.

SMTP services
In Domino 7, this option is obsolete and will only allow the *DOMINO value. Any other value entered in this field will be ignored.

News readers
In Domino 7, this option is obsolete and will only allow the *NONE value. Any other value entered in this field will be ignored.

Replace configuration
This option allows you to choose whether or not the Domino server configuration files in the specified data directory will be overwritten by the new files for this server.
**Domain name**
Specify the domain name for the Domino server.

**Network name**
Specify the Notes named network to which this Domino server belongs.

**Country or region code**
Specify a two-character country or region code to be added to the certifier ID for this Domino server.

**Organizational unit (This option only available for first server setup)**
Use this field if you want to specify an organizational unit and ID for the server. You can choose an existing ID file, or have a new one created for you. This file is saved in the data directory specified earlier.

**Certifier ID (This option only available for first server setup)**
Specify the certifier ID file to be used. You can choose an existing file, or have a new one created for you. This file is saved in the data directory specified earlier and automatically certifies the first server's ID and the administrator's user ID.

**Administrator ID (This option only available for first server setup)**
Specify the user ID for the Domino Administrator.

**Server ID (This option only available for first server setup)**
Specify the server ID to be used for this server. You can choose an existing file, or have a new one created for you. This file is saved in the data directory specified earlier.

**Start server**
Use this option to have the system start the server automatically when the setup is completed.

**Note** If using the CFGDOMSVR command, you also have the option of starting the Java Server Controller (*JSC) or both the server and its JSC (*ALL) when the setup is completed.

**Start when TCP/IP started**
Specify whether or not this server should be started automatically when TCP/IP is started on the system.

**Note** If using the STRTCP, STRTCPSVR SERVER(*AUTOSTART), or STRTCPSVR SERVER(*DOMINO) commands, you also have the option of starting the Java Server Controller (*JSC) or both the server and its JSC (*ALL) when the setup is completed.

**Log replication events**
Specify whether or not you want the replication events logged in the LOG.NSF file for this Domino server.

**Log client session events**
Specify whether or not you want the client session events logged in the LOG.NSF file for this Domino server.
TCP/IP port options
Use this TCP/IP port option to specify an Internet (IP) address for the server's port. For example, if you are setting up the server as a partitioned server, you can use this option to specify a separate IP address for the server.

For more information, see Chapter 7 "Setting up multiple Domino servers on the same system."

Server host name
Specify the host name used by this Domino server.

Subsystem and object names
Use this option if you want to use a specific name for the i5/OS subsystem and associated objects that are used by the server. Each Domino server runs in a separate i5/OS subsystem. Unless you specify a different name, the system generates a name of "DOMINO" followed by a two-character sequence number, such as DOMINO01.

Collation
Use this option to specify a collation code that defines how characters are sorted. Different national languages may sort characters differently.

Copy administrator's ID file
Use this option to specify where the setup program should put the ID file for the server administrator. Unless you specify differently, the setup program attaches the ID file to the Person document for the administrator in the server's Domino Directory and also copies the ID file to the server's data directory.

Additional services
Use this option to set up additional services for the server beyond the default services. Services selected will appear in the NOTES.INI file on the "ServerTasks=" line. If you accept the default value, which is no additional services (*NONE), the ServerTasks line will include the following:

COLSRV400, Update, Replica, RnRMgr, Router, Stats, AMgr, AdminP, Sched, CalConn

You can also remove the default services by removing values from the list in the wizard or by specifying the value *MINIMUM using i5/OS commands. In this case, the ServerTasks line will only include the minimum necessary services for Domino. These services are COLSRV400 and Update.
If you select any specific services, this overrides the default, and these services will appear in the ServerTasks line with COLSRV400 and Update. For example, if you specifically select Agent Manager (*AMGR) and Router (*ROUTER), the ServerTasks line will only include the following:

**COLSRV400, Update, AMgr, Router**

**Note** When adding services using the CFGDOMSVR or CHGDOMSVR command interface, there are some considerations to follow. When specifying *NONE, *MINIMUM or *ALL, no other values can be specified. In addition, you can not enter the same value more than once, such as *ADMINP *ADMINP.

**Allow Domino Off-Line Services**
Specify whether or not you want to allow this server to support DOLS.

---

**What happens during first server setup?**

The first server setup does the following:

- Creates a new domain for the Domino servers.
- Creates the certification log file, names it CERTLOG.NSF, and saves it in the Domino data directory.
- Enables the appropriate network and serial ports.
- Creates the Domino Directory for the domain. The setup program creates the Domino Directory in the data directory that you specify for the Domino server and gives it the default name NAMES.NSF.
  
  **Note** The Domino Directory is also known as the Public Address Book and the Name and Address Book (NAB).

- Creates a Certifier ID for your organization. The setup program saves the Certifier ID in the same directory you chose for Domino data files and gives it the default name CERT.ID.

- Creates a Certifier document in the Domino Directory. This document describes the Certifier ID.

- Creates a server ID for the new server. The setup program saves the server ID in the same directory you choose for Domino data files and gives it the default name SERVER.ID. The setup program creates the server ID with no password. If needed later, you can require a password for the server ID.

- Certifies the server ID with the organization Certifier ID.

- Creates a Server document in the Domino Directory. This document describes the first server based on information that you specify during setup.

- Creates a user ID and a password for the Domino administrator and does one or both of the following, depending on what you specified:
  - Attaches the user ID as a file named USER.ID to the administrator's Person document in the Domino Directory.
  - Copies the user ID file to the data directory.
- Certifies the administrator's user ID with the organization Certifier ID.
- Adds the administrator's name and the server's name as managers in the access control list of the Domino Directory.
- Adds the server name to the LocalDomainServers group in the Domino Directory.
- Creates the log file for the server in the same directory you specify for Domino data files and gives it the default name LOG.NSF.
- Creates a mail directory in the Domino data directory and a mail file in that directory for the Domino administrator.
- Sets up the additional options that you specified.
- Creates the Reports file, names it REPORTS.NSF, and saves it in the Domino data directory.
- Configures SMTP during the setup program.
- If "DOLS Domino Off-Line Services" was selected during the setup program, creates the Offline Services file, names it DOLADMIN.NSF, and saves it in the Domino data directory.
- Updates the Access Control List in all databases and templates in the Domino data directory tree to remove Anonymous access and/or add LocalDomainAdmin access, depending on the selections made during the setup program.
Chapter 7
Setting up multiple Domino servers on the same system

This chapter discusses setting up multiple Domino servers on the same system.

What is Domino partitioning?

Domino server partitioning lets you run multiple Domino servers on a single system. Using partitioned servers reduces hardware expenses and minimizes the number of systems you have to administer. Each partitioned server has its own Domino data directory and NOTES.INI file, but all partitioned servers share the same Domino program files. Partitioned servers can help you make more efficient use of your system.

For example, instead of purchasing multiple small systems to run Domino servers that might not take advantage of the resources available to them, you can purchase a single, more powerful system and run multiple Domino servers on that system, allowing you to easily allocate resources among the Domino servers running on that system.

Setting up partitioned servers is particularly effective when the servers are in different domains. For example, on one system you can dedicate multiple domains to multiple customers or set up multiple Web sites.

In an enterprise network, partitioned servers can provide the scalability you need while also providing security. As your system grows, you can migrate users from individual servers to partitioned servers. A partitioned server can also be a member of a cluster if you require high availability of databases. Security for a partitioned server is the same as for a server on its own system.

If one partitioned server shuts down, the others continue to run. Therefore, the applications you run on the other partitioned servers are more reliable. If a partitioned server encounters a fatal error, you can restart that partitioned server without restarting your system or other Domino servers.

In order to set up multiple Domino servers on the same system, you must:

- Prepare the TCP/IP network for partitioned Domino servers
- Configure the Domino server in one of two ways:
  - As a first Domino server
  - As an additional server in an existing Domino domain
Preparing the TCP/IP network for partitioned Domino servers

Before you configure a partitioned server, you must complete the following steps:

1. Obtain a unique TCP/IP address and host name for the server to use.
2. Update either the Domain Name Service (DNS) or the host table of each server and client with the TCP/IP address and host name of the server.

To set up TCP/IP addresses and host names using iSeries Navigator, follow these steps:

- Open the system where you will configure the partitioned Domino server.
- Click Network.
- Click TCP/IP Configuration.
- Click IPV4.

Note IPv6 is not currently supported with Domino for i5/OS.

- Right-click Interfaces, select New Interface, and select a type of interface. A TCP/IP interface wizard takes you through the steps needed to set up a TCP/IP interface for the system.

3. When you set up the partitioned server, specify the unique TCP/IP address in the Internet address field of the TCP/IP port options.

If the server is already set up, reconfigure the server using iSeries Navigator or the CHGDOMSVR command and add the TCP/IP address in the Internet address field of the TCP/IP port options.

Tip You can also use the CFGTCP command to add a new TCP/IP interface. From the Configure TCP/IP display, select option 1 and enter a 1 next to the blank Internet address field.

For more information about setting up partitioned servers, see the Domino 7 administration documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF). Return to this documentation when you are ready to configure the partitioned Domino server.

Configuring a partitioned Domino server

You may configure a partitioned server as either a first Domino server or as an additional Domino server. However, when you configure each Domino server, make sure you do the following:

- Specify a unique TCP/IP address for each Domino server running on the same system
- Enable the Partitioning option on each Domino server running on the same system
- Configure each Domino server to use one TCP/IP address by enabling the Bind to Host name option, if you plan on running multiple HTTP servers the same system

48 Installing and Managing Domino 7 for i5/OS
For more information on configuring your partitioned server as a first Domino server, see Chapter 6 "Setting Up a First Domino Server."

For more information on configuring your partitioned server as an additional Domino server, see Chapter 8 "Setting Up an Additional Domino Server."
Chapter 8
Setting Up an Additional Domino Server

Use this procedure if you want to add another Domino server to an existing Domino domain. When you add a Domino server to a Domino domain, the additional server uses the same Domino Directory as other servers in the Domain. For example, set up the Domino server as an additional server if:

• You already have a Domino server on another system and you want the new Domino server on the system to use the same Domino Directory.
• You already have a Domino server on an Integrated xSeries Server for iSeries and you want the new Domino server to use the same Domino Directory.
• You already have a Domino server set up on the system and you want to add a second server that uses the same Domino Directory.

Setting up an additional Domino server involves these tasks:

1. Prepare the i5/OS environment for the Domino server. If you previously set up your first Domino server on the same system, you already set up the i5/OS environment.
   For more information, see Chapter 4 "Planning the Domino for i5/OS Environment."
2. Use an existing server in the Domino domain to register the additional server.
   For more information on registering a server, see the next section, "Registering the additional server."
3. Verify the TCP/IP connection from the registration server and its administrator workstation to the system.
4. Copy the server ID file for the additional server to the system, if you saved the server ID in a file when you registered the server.
5. Set up the additional server on the system.
Registering the additional server

Before adding a Domino server to an existing Domino domain, you must register the additional server in the domain. When you register the server, specify the server’s TCP/IP host name as the server name, unless you already have a Domino server that uses the same TCP/IP host name.

For instructions on determining the TCP/IP host name, see "Verifying TCP/IP setup and status" in Chapter 4.

1. Select an existing server in the Domino domain and use that server (the registration server) to register the additional server. For information about registering the additional server, see the Domino administration documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF).

The server registration process creates a server document in the Domino Directory of the registration server and creates a server ID. Unless you specify differently, the server ID is encrypted and attached to the server document in the Domino Directory. You have the option of storing the server ID in a file.

• If you store the server ID in the Domino Directory, you must provide a password. Keep a record of the password in a secure place. When you set up the additional server, you must provide the password. Domino copies the Domino Directory, including the server ID, to the new server during the setup processing.

You must also specify the password every time you start the additional server. Therefore, after you issue the start request, you must start the Domino server console (using the WRKDOMCSL command) and enter the password.

• If you store the server ID in a file, you do not need to provide a password. However, you must manually copy the file to the system where you plan to set up the additional server. You must copy the server ID file before you set up the server.

Tip If you plan to manage the new server remotely, do not specify a password and specify 0 as the minimum password length for the server. Otherwise, you must open the Domino server console for the server and enter the password each time you start the server.

2. Record the names that identify the registration server and the additional server that you registered. For both the registration server and the additional server, record the full hierarchical name; for example, Server1/Chicago/Acme.

3. Record the TCP/IP host name of the registration server. This host name is usually the same as the server name.

4. Record the location of the server ID file, if you chose to store the server ID in a file.
Verifying TCP/IP connections to the system

When you set up the additional Domino server on the system, Domino copies the Domino Directory from the registration server to the new server. Therefore, the system must have an active TCP/IP connection to the registration server. Similarly, the administrator workstation for the domain must be able to communicate with the system.

Verifying the TCP/IP connection between the registration server and the system
1. Make sure the registration server is started.
2. From an i5/OS command line, enter this command:

   PING REGISTRATION-SERVER-HOST-NAME

   where REGISTRATION-SERVER-HOST-NAME is the TCP/IP host name of the registration server. You recorded the host name when you registered the additional server. The host name of the registration server may be different from the TCP/IP host name of the system on which the registration server is running.
   • If the registration server responds to the PING, the TCP/IP connection between the registration server and your iSeries server is operational.
   • If the PING is not successful, verify the TCP/IP configuration on the system containing the new server and the system containing the registration server. Also verify that both systems are properly connected to the network and that the network is operational.

   Note If you are using a firewall, the PING technique does not work. However, you may still be able to complete the server setup.

Caution If the registration server for the domain is running on an Integrated xSeries Server for iSeries on the same system as the additional server, you may need to do additional configuration.

Verifying the TCP/IP connection between the workstation and the system
To manage the additional server from your current administrator workstation, you must be able to communicate with the system through TCP/IP. If you are using a network protocol other than TCP/IP to administer your current servers, you must set up TCP/IP on the workstation.

1. Install and set up TCP/IP on the workstation. For instructions, see the documentation for the TCP/IP product.

   Tip If you are using Microsoft Windows 95, Windows 98, or Windows NT, you may want to refer to the iSeries book Client Access for Windows 95/NT - Setup (SC41-3512). This book contains a helpful chapter on configuring Microsoft TCP/IP for Windows. You can access this book from the iSeries Online Library at the following Web site:

   http://www.ibm.com/eserver/iseries/library
2. Verify the TCP/IP connection to the system.
   - From a command prompt on the administrator's workstation, type the following command:
     
     ```
     ping hostname
     ```
     
     where `hostname` is the TCP/IP host name of the system containing the additional server.
   - If the PING is successful, the workstation is communicating with the system. If the PING is not successful, review the steps you followed to set up TCP/IP on the workstation and the system.

### Copying the ID files for the additional server to the system

If you stored the server ID in a file, you must copy the file to the system where you plan to set up the additional server.

**Note** Skip this procedure if you stored the server ID in the Domino Directory.

1. Make sure you are working from the system (server or workstation) that contains the server ID file.
2. Change to the directory that contains the server ID file. You recorded the directory path as part of the procedure to register the additional server.
3. Copy the server ID file to the system where you plan to set up the additional server. Use any method that you typically use to copy files between systems. For example, you can use:
   - The TCP/IP File Transfer Protocol (FTP).
   - The Windows Network Neighborhood in combination with either iSeries Access or iSeries NetServer support to map a network drive between systems. Then you can copy the file by using any method that copies files from one directory to another on the same system.
   - iSeries Navigator. Click **File Systems -> Integrated File System -> Root** and select the server's data directory, such as `/domino/servername/data`. Then copy the ID files to a local directory on the workstation.

To use any of these methods, you must have TCP/IP communications set up and active between the workstation and the system.
4. Change the i5/OS authorities to secure the server ID file but still allow the Domino server to access the file. To change the i5/OS authorities using iSeries Navigator, follow these steps:

- Click File Systems.
- Click Integrated File System.
- Click Root.
- Right-click the server ID file and select Permissions.
- Click the Owner button, select Qnotes from the list in the "Select new owner" field, and click OK.

**Note** Qnotes is found under the "All Users" group.

- Make sure the Exclude check box is selected for (Public).
- Make sure every check box except Exclude is selected for Qnotes.

**Tip** You can also use the CHGOWN command to change the owner of the Server ID file. For example, type the following on an i5/OS command line and press Enter:

```
CHGOWN OBJ('/domino/servername/data/server.id')
NEWOWN(QNOTES)
```

where *servername* is the name of your Domino server.
Setting up an additional server using iSeries Navigator

You can use the Java-based Setup Wizard to configure an additional Domino server. To start the setup process, follow these steps:

1. Open iSeries Navigator.
2. Open the system where you will add the additional Domino server.
3. Click Network.
4. Click Servers.
5. Right-click Domino and select New -> New Domino Server.
   The Java-based Setup Wizard will be launched. Complete the fields in the wizard using the information in the section "Deciding what to specify for server characteristics" in Chapter 6.
   Tip You can also use the CFGDOMSVR command to set up a Domino server on the system. For more information on the CFGDOMSVR command, see Appendix C "Using i5/OS Commands With Domino for i5/OS."
6. When prompted, enter a valid user ID and password on the system.
   Tip The setup wizard will enter predefined defaults that typical servers use. You can change advanced server settings to customize the server to fit your specific environment.
7. Follow the setup panels, selecting the options or providing the information that matches your desired server characteristics.
   You must provide the following information:
   Choose Additional Server when asked for the type of Domino server to be configured.
   **Server ID:** Choose whether the server ID is in a file on the system or in the Domino Directory.
   If you specified a password when you registered the additional server, provide the password.
   **Server name:** Specify the full hierarchical name of the Domino server. For example:
   Server2/Chicago/Acme
   **Data directory:** Specify the directory path for the server's data directory in the integrated file system. For example, specify:
   /domino/Server2/data
   **Internet services:** Specify any desired Internet services that this Domino server will provide.
**Advanced settings:** Specify any advanced server settings you want to apply to this server.

**Network settings:** Specify any network settings for this Domino server. For example, click the Customize button and specify a fully qualified Internet host name for this Domino server.

**Local time zone:** Select the time zone to be used for the server's time stamp.

**Get Domino databases:** You can choose to provide system databases from another Domino server, or from another local media source. Either option requires that you enter a server name in the "Other Domino server name" field.

Another new feature is the ability to connect to the other Domino server through a proxy connection. To do this, specify a proxy server address, port, and type.

**Note** If a proxy server address is specified, you must select a port and type.

**Domino Directory:** Specify the type of Domino Directory this server will use.

8. When the setup is complete, use iSeries Navigator to determine the status of the server by following these steps:
   - Click **Network**.
   - Click **Servers**.
   - Click **Domino**.

   On the right, you will see a list of Domino servers on the system. Look under the **Status** column to see the status of the Domino server you just configured.

9. If the server is stopped, start it by right-clicking and selecting **Start -> Server**.

**Note** The server document may have been created with the default host name of the system and needs to be changed after you start the Domino server. You may have problems accessing your Domino server via IIOP if you do not update this value. To do this, open the server document using the Domino Administrator client and change the IP address and fully qualified host name to match your newly configured Domino server, then stop and restart your server to make the changes take effect.

For details on using iSeries Navigator to perform operations on a Domino server, see Chapter 10 "Managing a Domino Server Using iSeries Navigator."
What happens during additional server configuration?

Configuring an additional server does the following:

- Copies the Domino Directory, if a file location was specified during the setup program, names it NAMES.NSF, and saves it in the Domino data directory.
- Copies the server's ID from the location specified during the setup program, either from a file, a copy of the directory, or the existing Domino server's directory, names it SERVER.ID, and saves it in the Domino data directory.
- Retrieves the Domain name and Administrator name from the Server document in the Domino Directory.
- Creates the log file, names it LOG.NSF, and saves it in the Domino data directory.
- Copies or replicates the Administration Requests file, names it ADMIN4.NSF, and saves it in the Domino data directory.
- Copies or replicates the Monitoring Configuration file, names it EVENTS4.NSF, and saves it in the Domino data directory.
- Replicates the Domino Directory, if it doesn't already exist, names it NAMES.NSF, and saves it in the Domino data directory.
- Creates a Connection document to the existing Domino server in the Domino Directory.
- Creates the Reports file, names it REPORTS.NSF, and saves it in the Domino data directory.
- Configures SMTP during the setup program.
- If "DOLS Domino Off-Line Services" was selected during the setup program, creates the Offline Services file, names it DOLADMIN.NSF, and saves it in the Domino data directory.
- Updates the Access Control List in all databases and templates in the Domino data directory tree to remove Anonymous access and/or add LocalDomainAdmin access, depending on the selections made during the setup program.
- Replicates changes made to the Server document with the existing server, if any.
- Removes the SERVER.ID attachment from the Domino Directory, if applicable.
Chapter 9
Managing the Domino Server Overview

Domino for i5/OS provides administrative functions for managing a Domino server. When performing most administrative functions, you have a choice between the following interfaces:

- **iSeries Navigator**
  You may prefer to use iSeries Navigator if you are more comfortable with a graphical user interface such as Windows.
  For more information, see Chapter 10, "Managing the Domino Server Using iSeries Navigator."

- **Individual commands that you enter using the i5/OS command interface**
  You may prefer to use commands if you are familiar with the i5/OS command interface. i5/OS commands also provide some capabilities that are not currently available in iSeries Navigator.
  For more information, see Appendix C, "Using i5/OS Commands With Domino for i5/OS."

Ways of managing a Domino server

Typically, you manage a Domino server from a Notes client. The Notes client interface provides the full set of Domino administration functions. The Notes client is used on a remote workstation since a Domino server on i5/OS does not have a local Notes client. Domino for i5/OS also supports the Domino Web Administration tool. This tool allows you to perform a subset of the Domino administration tasks from a Web browser. For more information, see the Domino administration documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF).

To help you manage a Domino server, Domino for i5/OS allows you to use the following alternative methods to perform common administration tasks:

- **iSeries Navigator**: This graphical interface is part of the workstation support provided by IBM iSeries Access.
- **i5/OS commands**: These commands allow you to interact directly with the i5/OS operating system through its native command interface.
Java Server Console: This Java-based application allows you to manage your Domino servers from a workstation, even when your Domino servers are not currently running.

You must use iSeries Navigator, i5/OS commands, or the Java Server Console to do a few Domino server tasks, such as starting or stopping the server.

If you are familiar with a graphical user interface, such as Windows, you may prefer to use iSeries Navigator. For some tasks, using iSeries Navigator is easier than using commands or the Notes administrator functions.

If you are familiar with i5/OS, the commands provide a direct and convenient way of managing both i5/OS and a Domino server running on i5/OS. You can run the commands from any display or workstation that is communicating with the i5/OS operating system. No additional setup is required.

**Note** The primary i5/OS command used to manage a Domino server is WRKDOMSVR. For more information on the WRKDOMSVR command, see Appendix C "Using i5/OS Commands With Domino for i5/OS."

Whether you use iSeries Navigator, i5/OS commands, or the Java Server Console to manage a Domino server, you must have an i5/OS user profile that has the necessary authority to perform each administrative operation.

### Authority requirements for Domino administrators

The person who manages Domino servers must sign on to the system using a user profile with the i5/OS authorities required to perform each administrative task. To give a user special authorities, change the special authority field in the user's profile. The i5/OS security officer can use either iSeries Navigator or the Change User Profile (CHGUSRPRF) command to change a user's profile.

- **Starting and stopping (ending) a Domino server.**
  The administrator can start and end a server by using either iSeries Navigator or i5/OS commands (STRDOMSVR, ENDDOMSVR, or WRKDOMSVR). Both interfaces require *JOBCTL special authority to start or end a server.

- **Working with the Domino console.**
  The administrator can access the Domino console through an i5/OS command (WRKDOMCSL). The administrator can issue server commands from this console. To work with the Domino console, the administrator needs either *ALLOBJ special authority or the following specific authorities:
    - *USE authority to the QNNINCSS program in the QNOTES library
    - *USE authority to the WRKDOMCSL command in the QSYS library
• *X data authority to the Domino server's data directory (and its parent directories if the directory is not directly under the root directory)

The i5/OS security officer can grant these specific authorities by typing the following i5/OS commands:

```
GRTOBJAUT OBJ(QNOTES/QNNINCSS) OBJTYPE(*PGM)
USER(ADMIN-PROFILE-NAME) AUT(*USE) REPLACE(*YES)

GRTOBJAUT OBJ(QSYS/WRKDOMCSL) OBJTYPE(*CMD)
USER(ADMIN-PROFILE-NAME) AUT(*USE) REPLACE(*YES)

CHGAUT OBJ('SERVER_DATA_DIRECTORY')
USER(ADMIN-PROFILE-NAME) DTAAUT(*X)
```

where `SERVER_DATA_DIRECTORY` is the Domino server's data directory.

**Note**  The CHGAUT command must be used on each parent directory above the Domino server's data directory.

To display the Domino console, the administrator needs either *ALLOBJ special authority or *X data authority to the Domino server's data directory (and its parent directories if the directory is not directly under the root directory).

• Changing a Domino server.

After a Domino server is set up, the administrator can use the i5/OS command CHGDOMSVR to change the configuration of the server. Changing the server requires *ALLOBJ, *IOSYSCFG, *JOBCTL, and *SECADM special authorities.

• Removing a Domino server.

Removing a Domino server removes the data directory used by the server. The data directory may also contain user data. The administrator can use the i5/OS command CFGDOMSVR to remove a Domino server. The administrator must have *ALLOBJ, *IOSYSCFG, *JOBCTL, and *SECADM special authorities.

---

**Overview of using iSeries Navigator to manage a Domino server**

iSeries Navigator enables you to use your Notes administrator workstation to manage both your system and the Domino servers on the system. Through the Domino for i5/OS support in iSeries Navigator, you can:

• Determine the status of all Domino servers on a system

• Perform administrative tasks on the servers, such as starting, stopping, and deleting servers

• View and change server properties, including the NOTES.INI files

---

Chapter 9: Managing the Domino Server Overview  61
iSeries Navigator works through the iSeries Access support. Therefore, you must install iSeries Access on the system and the administrator workstation. You must also install the Domino plug-in for iSeries Navigator on the administrator workstation. For more information, see Chapter 5 "Preparing the Administrator's Workstation."

Overview of using the Java Server Console to manage a Domino server

The Java Server Console allows you to manage your Domino servers through any workstation that supports Java applications. To use the Java Server Console, you must first start the Java Server Controller (JSC) on the system. You can start the JSC when starting a Domino server from iSeries Navigator or the STRDOMSVR command.

Note  The JSC can also be started when running the STRTCP, STRTCPSVR SERVER(*AUTOSTART), or STRTCPSVR SERVER(*DOMINO) commands if *JSC or *ALL was selected in the AUTOSTART parameter during server configuration.

The Java Server Controller is a stand-alone Java program that listens for requests from the remote Java Server Console. It also listens for "heart beat" information from the Domino server.

Note  When starting a Domino server and the Java Server Controller, you will now see a QJVAEXEC job instead of a SERVER job in the i5/OS job log.

Overview of using the Domino Administrator client to manage a Domino server

The Domino Administrator is the administration client for Notes and Domino. You can use the Domino Administrator to perform a variety of administration tasks.

For example, you can:

- Start and stop server tasks
- View, search, and analyze the server's log file
- Monitor server status and availability
- Access real-time performance charts
- Manage detailed server settings
Using the Verity KeyView filter

Domino for i5/OS uses the Verity KeyView filter for retrieving text from binary attachments. Supported formats include Adobe Acrobat PDF, Microsoft Word, Corel® WordPerfect®, Lotus 1-2-3®, Microsoft Excel, Lotus Freelance Graphics®, Microsoft PowerPoint®, HTML, and many others.

**Note**  Lotus Word Pro® attachments cannot be indexed.

To enable this feature, a database must be full-text indexed with the option to index binary attachments. Indexing attachments as raw text will continue to operate as before, and does not use the KeyView filter. The KeyView filter can be enabled or disabled for the entire server by specifying one of the following settings in the NOTES.INI file:

- FT_BINARY_FILTER_OFF=1 indicates the KeyView filter will not be used.
- FT_BINARY_FILTER_OFF=0, or no setting at all, indicates the KeyView filter will be used. This is the default setting.

This NOTES.INI setting allows administrators to shut off the filter without having to change the indexing options on all databases that have the binary attachment option turned on.

**Note**  Domino for i5/OS does not support full text indexing of EBCDIC file systems.

Fault recovery operation

The fault recovery system in Domino 7 is configured the same as on UNIX platforms, with the exception that the fault recovery system is enabled by default on i5/OS. The fault recovery settings are controlled from the server's configuration document, accessible via the Configuration tab from the Domino Administrator. Also note that the AS400_DOMSVR_RESTART environment variable is no longer supported and has been replaced by the "Maximum Fault Limits" settings in the server's configuration document.

See the "Fault Recovery" section in the Lotus Domino Administrator 7 Help database for more information.

When upgrading from Domino 5 or Domino 6 to Domino 7, the current server settings for fault recovery are retained and the server's configuration document is updated accordingly.
Specifying a diagnostic program for fault recovery
There is no longer a "Cleanup Script Name" field in the server configuration document in which you must place "CALL QNOTES/NSD". This has been replaced by the "Run This Script After Server Fault/Crash" field in which you may configure a call to your own recovery diagnostic program, such as "CALL MYLIB/MYDIAG". If you do not have one, this field should be blank. Any user diagnostic will be run before the Domino NSD program.

The Domino NSD program can be turned on and off by the "Run NSD To Collect Diagnostic Information" field. This should normally be enabled so that critical diagnostic information will be generated. This information is useful to the Lotus and IBM support team for solving server problems.
Chapter 10
Managing a Domino Server Using iSeries Navigator

To enable iSeries Navigator for Domino, you must add the Domino plug-in for iSeries Navigator. For more details see "Installing the Domino plug-in" in Chapter 5.

This chapter provides you with the steps to complete the following tasks using iSeries Navigator:

- Starting a Domino server
- Stopping a Domino server
- Stopping a Domino server immediately
- Stopping a Domino subsystem
- Starting the Java Server Controller
- Starting a Domino server and the Java Server Controller
- Stopping a Domino server and the Java Server Controller
- Stopping a Domino server and the Java Server Controller immediately
- Starting the Domino Server Setup Wizard to configure a new server
- Adding a Domino application
- Determining server status
- Viewing active jobs related to Domino servers
- Changing a Domino server's properties
- Editing the NOTES.INI file
- Launching the Domino Administrator client
- Launching the Domino console
- Deleting a Domino server

**Tip** You can also perform most of these functions using the WRKDOMSVR command.
Starting a Domino server

To start a Domino server using iSeries Navigator, follow these steps:

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click Network.
4. Click Servers.
5. Click Domino.
6. Right-click the Domino server and select Start, then Server.

*Note* Starting the Domino server may take a few minutes.

*Tip* You can also use the following i5/OS command to start a Domino server:

```
STRDOMSVR SERVER(SERVERNAME)
```

where *SERVERNAME* is the name of your Domino server.

*Note* To start all Domino servers on a system, right-click Domino and select Start -> All Servers.

Stopping a Domino server

To stop a Domino server using iSeries Navigator, follow these steps:

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click Network.
4. Click Servers.
5. Click Domino.
6. Right-click the Domino server and select Stop -> Server.

*Note* Stopping the Domino server may take a few minutes.

*Tip* You can also use the following OS/400 command to stop a Domino server:

```
ENDDOMSVR SERVER(SERVERNAME)
```

where *SERVERNAME* is the name of your Domino server.

*Note* To stop all Domino servers on a system, right-click Domino and select Stop -> All Servers.
Stopping a Domino server immediately

To stop a Domino server immediately using iSeries Navigator, follow these steps:

**Note** You must have *JOBCTL special authority to perform this task.

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click **Network**.
4. Click **Servers**.
5. Click **Domino**.
6. Right-click the Domino server and select **Stop -> Server Immediately**.

**Note** To stop all Domino servers and Java Server Controllers on the system, right-click **Domino** and select **Stop -> All Servers Immediately**.

**Tip** You can also use the following i5/OS command to stop a Java Server Controller:

```
ENDDOMSVR SERVER(servername) OPTION(*IMMED)
```

where _servername_ is the name of your Domino server.

Stopping a Domino subsystem

To stop a Domino subsystem using iSeries Navigator, follow these steps:

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click **Work Management**.
4. Click **Subsystems**.
5. Right-click the Domino subsystem you want to stop and select **Stop**.
6. On the Stop Subsystem display, select **Controlled** and click the **Stop** button.

**Note** If the subsystem does not stop in 20 minutes, follow these steps again, but select **Immediate** instead of **Controlled**.
Starting the Java Server Controller

To start the Java Server Controller using iSeries Navigator, follow these steps:

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click Network.
4. Click Servers.
5. Click Domino.
6. Right-click the Domino server and select Start -> Controller.

Note When you start the Java Server Controller, the Domino job that is normally called SERVER will now be called QJVAEXEC. When viewing the job log, be sure to look for this job under the new name.

Note To start all Java Server Controllers on the system, right-click Domino and select Start -> All Controllers.

Tip You can also use the following i5/OS command to start a Java Server Controller:

```
STRDOMSVR SERVER(SERVERNAME) JSC(*ONLY)
```

where SERVERNAME is the name of your Domino server.

The JSC can also be started when running the STRTCP, STRTCPSVR SERVER(*AUTOSTART), or STRTCPSVR SERVER(*DOMINO) commands if *JSC or *ALL was selected in the AUTOSTART parameter during server configuration.

For more information on using the Java Server Controller, see the Domino administration documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF).

Starting a Domino server and the Java Server Controller

To start a Domino server and the Java Server Controller using iSeries Navigator, follow these steps:

Note You must have *JOBCTL special authority to perform this task.

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click Network.
4. Click Servers.
5. Click Domino.
6. Right-click the Domino server and select Start -> Server and Controller.

   **Note** To start all Domino servers and Java Server Controllers on the system, right-click Domino and select Start -> All Servers and Controllers.

   **Tip** You can also use the following i5/OS command to start a Java Server Controller:

   ```
   STRDOMSVR SERVER(servername) JSC(*YES)
   ```

   where `servername` is the name of your Domino server.

---

### Stopping a Domino server and the Java Server Controller

To stop a Domino server and the Java Server Controller using iSeries Navigator, follow these steps:

   **Note** You must have *JOBCTL special authority to perform this task.

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click **Network**.
4. Click **Servers**.
5. Click **Domino**.
6. Right-click the Domino server and select Stop -> Server and Controller.

   **Note** To stop all Domino servers and Java Server Controllers on the system, right-click Domino and select Stop -> All Servers and Controllers.

   **Tip** You can also use the following i5/OS command to stop a Java Server Controller:

   ```
   ENDDOMSVR SERVER(servername) JSC(*YES)
   ```

   where `servername` is the name of your Domino server.

### Stopping a Domino server and Java Server Controller immediately

To stop a Domino server and the Java Server Controller immediately using iSeries Navigator, follow these steps:

   **Note** You must have *JOBCTL special authority to perform this task.

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click **Network**.
4. Click **Servers**.
5. Click **Domino**.
6. Right-click the Domino server and select **Stop -> Server and Controller Immediately**.

**Note** To stop all Domino servers and Java Server Controllers on the system, right-click **Domino** and select **Stop -> All Servers and Controllers Immediately**.

**Tip** You can also use the following i5/OS command to stop a Java Server Controller:

```plaintext
ENDDOMSRV SERVER(servername) JSC(*YES) OPTION(*IMMED)
```

where `servername` is the name of your Domino server.

---

**Starting the Domino Server Setup Wizard to configure a new server**

You can start the Domino Server Setup Wizard to configure a new Domino server by following these steps:

**Note** To configure a new Domino server, you must have *ALLOBJ, *JOBCTL, *SECADM, and *IOSYSCFG special authorities.

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click **Network**.
4. Click **Servers**.
5. Right-click the Domino and select **New -> New Domino Server**.

---

**Adding a Domino application**

To add a Domino application on a Domino server using iSeries Navigator, follow these steps:

**Note** The Domino server must already be set up on the system, and the licensed program and option being added must be installed.

**Note** You must have *ALLOBJ, *SECADM, and *IOSYSCFG special authorities to perform this task.

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click **Network**.
4. Click **Servers**.
5. Click **Domino**.
6. Right-click the Domino server and select **Add Application**.
Determining the server status

To determine the status of a Domino server using iSeries Navigator, follow these steps:

**Note** You must have at least one of the following authorities to complete this task: *ALLOBJ, *JOBCTL, *SECADM, or *IOSYSCFG

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click Network.
4. Click Servers.
5. Click Domino.

On the right, there is a list of all Domino servers configured on the system. Look under the **Status** column to determine the status of your Domino server.

**Tip** You can also use the following i5/OS command to check the status of Domino servers:

```
WRKDOMSVR
```

The following table shows the possible values and their meanings:

<table>
<thead>
<tr>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting</td>
<td>The server is being started. However, it is not yet available for use by Notes clients.</td>
</tr>
<tr>
<td>Started</td>
<td>The server is running and can be accessed from a workstation.</td>
</tr>
<tr>
<td>Stopping</td>
<td>The server is in the process of stopping.</td>
</tr>
<tr>
<td>Stopped</td>
<td>The server is not active. All server tasks are stopped. This status may also be displayed if a server is configured to use a release that is not currently installed on this partition.</td>
</tr>
<tr>
<td>Unknown</td>
<td>The system cannot determine the status of the server.</td>
</tr>
</tbody>
</table>

Viewing active jobs related to Domino servers

To view the active jobs related to Domino servers on a system, follow these steps:

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click Network.
4. Click Servers.
5. Right-click Domino and select Domino Jobs. The jobs are displayed in a new window, sorted by subsystem.
Changing a Domino server's properties

To change a Domino server's properties using iSeries Navigator, follow these steps:

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click Network.
4. Click Servers.
5. Click Domino.
6. Right-click the Domino server and select Properties.
7. Edit the properties of the server as needed, then click OK to save your changes.

Tip You can also use the following i5/OS command to change the properties of a Domino server:

```
CHGDOMSVR SERVER(SERVERNAME)
```

where SERVERNAME is the name of your Domino server.

For more information on server settings, see "Deciding what to specify for server characteristics" in Chapter 6.

Editing the NOTES.INI file

Depending on your operating environment, you may need to change settings in the NOTES.INI file. To make changes to the NOTES.INI file using iSeries Navigator, follow these steps:

Caution Making changes to the NOTES.INI file is only recommended for experienced administrators. Even minor changes to the NOTES.INI file can introduce errors into the file and impair the operation of a Domino server.

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click Network.
4. Click Servers.
5. Click Domino.
6. Right-click the Domino server and select Properties.
7. Select the Initialization File tab and click Edit.

Note If the Edit button is dimmed, you cannot change this file.

8. When finished editing, click Save and then click OK.
Why are partial server properties displayed?

If you are unable to see all of the server properties when using iSeries Navigator, the issue is most likely with your i5/OS authorities. When using iSeries Navigator to manage your Domino server, the i5/OS user profile is authenticated. Make sure you are using a user profile with the correct authorities.

For more information on this topic, see Chapter 3 "Installing Domino."

Installing the Domino Administrator client

To manage your Domino environment using the Domino Administrator client, you must install and configure at least one workstation to act as the Administration workstation. To install and configure your workstation, follow these steps:

1. Insert the Notes Client CD-ROM into your workstation's CD-ROM drive.
2. When the installation wizard appears, follow the instructions to install the Notes client and Domino Administrator client. If you need help with any display in the wizard, click the Help button.
3. Using FTP or the drag-and-drop method in iSeries Navigator, copy the certifier ID and administrator ID files from the Domino data directory on your system to the Notes data directory on the Administrator workstation.
4. Open Lotus Notes and follow the instructions on the setup wizard to configure the Notes client.

Caution You must use the Domino Administrator 7 client to manage Domino 7 servers. Do not attempt to use an R6 Administrator client.

For detailed information on setting up the Domino Administrator client, see the Lotus Domino Administrator 7 Help online or the Domino Administrator Help database (HELP7_ADMIN.NSF).

Launching the Domino Administrator client

If you want to manage your Domino server using the Domino Administrator client, you can open the client interface either from the Notes client or from iSeries Navigator.

Launching the Domino Administrator client from Notes
To launch the Domino Administrator client from Notes, simply click the Domino Administrator icon from the navigation bar on the left.
Launching the Domino Administrator client using iSeries Navigator
To launch the Domino Administrator client using iSeries Navigator, follow these steps:

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click Network.
4. Click Servers.
5. Click Domino.
6. Right-click the Domino server and select Server Administration.

The Domino Administrator client will launch and connect to the server document for your Domino server.

For more information about using the Domino Administrator client, see the Domino Administrator documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF).

Launching the Domino console
To launch the Domino console using iSeries Navigator, follow these steps:

Note You must have *JOBCTL special authority to perform this task.

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click Network.
4. Click Servers.
5. Right-click Domino and select Start -> Domino Console.

Deleting a Domino server
To delete a Domino server from a system using iSeries Navigator, follow these steps:

Note You must have *ALLOBJ, *JOBCTL, *SECADM, and *IOSYSCFG special authorities to perform this task.

1. Start iSeries Navigator.
2. Open the system where you installed Domino.
3. Click Network.
4. Click Servers.
5. Click Domino.
6. Right-click the Domino server and select **Delete**.

**Tip** You can also use the following i5/OS command to delete a Domino Server:

```
CFGDOMSVR SERVER(servername) OPTION(*REMOVE)
```

where `servername` is the name of your Domino server.
Chapter 11  
Registering and managing users

A Domino server on i5/OS can have three types of users:

- **Domino-only users.** These users connect to the Domino server from a Notes client or a browser. They do not use any i5/OS functions except the Domino server. These users do not need an i5/OS user profile.

- **Domino and i5/OS users.** These users connect to the server from a Notes client or a browser. They also access the system in other ways, such as with 5250 workstation emulation or iSeries Access. These users need both an i5/OS user profile and a Domino registration.

- **Domino users who need DB2 UDB for iSeries access.** These users might not appear to run an i5/OS application. However, they might use a Notes application that accesses DB2 UDB for iSeries data. Whether they need an i5/OS user profile depends on how you design your Notes application.

**Note**  Only US ASCII characters are supported for an Internet mail address. There is no support for accented characters. Therefore, users who are registered as Notes users using accented characters must have an equivalent Internet address using only US ASCII characters. If the Internet address contains accented characters that do not have US ASCII equivalents (as with Greek or Cyrillic), the Internet address is left blank. The Domino administrator must manually enter a US ASCII Internet address.

Setting up Domino for i5/OS users

When you set up a new Domino user on a server, the server application creates the following:

- A Person document in the server Domino Directory.

- An ID file for the user. The ID file contains the certificate that the Notes client uses to authenticate with the server. The user’s workstation must have a copy of this ID file for the user to connect to the server successfully.

From a Notes client workstation connected to the Domino server, you can use the administration function that is part of Domino to set up a new user. This method does not create an i5/OS user profile for the Domino user.

To create an i5/OS user profile, your Domino administrator’s i5/OS user profile must have *SECADM special authority. To give a user *SECADM special authority, change the special authority field in the user's profile.
About Domino for i5/OS Single Logon

Domino for i5/OS Single Logon is a security feature that provides password synchronization for users of Microsoft Windows, Lotus Notes, and i5/OS. This capability allows users to log on once and not have to separately log on to the Notes client or to iSeries Access.

You can obtain the Single Logon feature and installation instructions from the following Web site:


After you install Single Logon on the workstation and log onto Windows, the Windows password is used for authentication so that iSeries Access for Windows security can automatically connect to systems. Single Logon also integrates with the Lotus Notes security to provide the Windows password when opening Notes databases. The user IDs for logging onto Windows and i5/OS do not have to be the same as those for Lotus Notes, but the user IDs must all have the same password.

Note The Windows and i5/OS user IDs must be the same in order to log on to the system.

When it is time to change passwords, Single Logon synchronizes Windows, Notes, and selected i5/OS passwords. While changing the Lotus Notes password, the Windows and i5/OS passwords are also synchronized to the same value. This one-step process provides easy password management of all passwords and allows the Windows password to be used later for single logon. Windows users can also choose to change passwords using the Windows password services.

For an updated list of the Windows clients supported with this feature, see the following Web site:

Chapter 12
Using Domino for i5/OS multi-version capabilities

With the 6.0.3 and 6.5.0 releases of Domino, IBM introduced multi-version capabilities for Domino on the i5/OS platform. Previous implementations of multiple Domino releases on one system required separate logical partitions (LPARs), which is not always a viable solution for some users. Starting with 6.0.3 and 6.5.0, Domino for i5/OS supports multiple releases of Domino on the same LPAR.

This added capability is designed to allow increased flexibility for Domino for i5/OS customers. You can now run different applications on different release levels of Domino in one partition. One significant advantage of this capability is that you do not have to end servers of one release in order to install another release. Since the existing servers that are configured to use one release are not automatically updated when installing a different release, these servers can remain active. This provides a very useful environment for running production servers on one release and testing new servers and applications on another release without impacting each other.

Operating in this mixed environment can help increase the stability of both testing and production environments.

Installing and using multiple versions of Domino on one partition is optional. You can still operate in a single version environment, but there may be some action you need to take to make sure your environment works with these multi-version enabled releases. For more information, see "Preparing for multi-version capable releases" later in this chapter.

Overview of multi-version terms and concepts

This section describes terms and concepts that are important in a multi-version capable environment.

Release

A major release, also called version, of Domino such as Domino 7 includes significant changes or enhancements to the product. Each version has Maintenance Releases, also called MRs. For example, MRs of Domino 7 are referred to as 7.0.x.

In a multi-version capable environment, any number of multi-version capable Domino versions and releases can be installed at the same time. For example, you can install Domino 6.5.0, 6.5.1, and 7.0 on the same partition. These releases and versions do not have to be installed or removed in any particular order.
**Note** Installing a multi-version capable release on the same partition as a release that is not multi-version capable will result in an automatic upgrade of each server to the multi-version capable release. You cannot install a release that is not multi-version capable on the same partition as releases that are multi-version capable. For example, you cannot install Domino 6.0.2 (which is not multi-version capable) on the same partition where 6.0.3, 6.5.0, or 7.0 are installed. For more information and considerations for installing the first multi-version capable release, see "Installing multi-version capable releases" later in this chapter.

**Primary release**
For systems with multiple versions installed, the term primary release is a way of indicating which installed release provides the most function. The primary release is always the most recently shipped release installed on a partition. For example, on a server with Domino 6.0.3 and 6.5.0 installed, 6.5.0 is the primary release. If 6.0.4 is installed later, 6.0.4 becomes the primary release. If 7.0 is installed after 6.0.4, then 7.0 becomes the primary release.

There are some situations where Domino will default settings to those of the primary release. In these situations, manual steps are required to manipulate the settings of a server with a release other than the primary release. For more information, see "Managing multi-version capable releases" later in this chapter.

**Multi-version capable**
This term refers to releases of Domino 6.0.3 and later, and Domino 6.5.0 and later. This includes Domino 7. All releases of Domino prior to 6.0.3 and 6.5.0, including all R5 releases, are not multi-version capable.

**Logical partition (LPAR)**
Logical partitions allow you to distribute resources within a single system to make it function as if it were two or more independent servers. LPAR technology allows for virtual and shared resources, dynamic load balancing, and much more. For more information on LPAR technology, see the following Web site:


**Partition**
This term is used synonymously with LPAR. If you are not using multiple LPARs on a system, then the term "partition" would mean the system itself.

**Updating a Domino server**
The term "updating" is sometimes used synonymously with "upgrading." These two terms are emerging to imply two different things. Updating refers to applying a newer release of software, while upgrading refers to hardware.
With multi-version capable releases of Domino for i5/OS (Domino 6.0.3, 6.5, 7 and later), the servers are no longer updated automatically during product installation.

The only exception to this is when installing a multi-version capable release over a release that is not multi-version capable. After installing a multi-version capable release of Domino - either by itself or upgrading an existing multi-version capable release - you must also use the UPDDOMSVR command for each server that you want to update to a later release. For more information on this situation, see "Installing multi-version capable releases" later in this chapter.

Preparing for multi-version capable releases

For Domino releases that are not multi-version capable, the software is installed into the library QNOTES and the directory /QIBM/PRODDATA/LOTUS/NOTES. To enable multiple versions of Domino on a single partition, several significant changes will be seen by all administrators and developers whether they choose to install one or multiple releases of Domino:

- Beginning with Domino 6.0.3 and 6.5.0, every Domino release is now multi-version capable and is installed into its own unique library and directory. For example, Domino 6.5.0 is installed into library QDOMINO650 and directory /QIBM/PRODDATA/LOTUS/DOMINO650. Domino 6.0.3 is installed into library QDOMINO603 and directory /QIBM/PRODDATA/LOTUS/DOMINO603. Domino 7.0 is installed into library QDOMINO700 and directory /QIBM/PRODDATA/LOTUS/DOMINO700.

Prior to multi-versioning support, all Domino releases installed into library QNOTES and directory /QIBM/PRODDATA/LOTUS/NOTES. The QNOTES library and /QIBM/PRODDATA/LOTUS/NOTES path still exist but are shared among multi-version capable releases.

- Every new release of Domino is packaged as a Domino product option so that when it is installed, it uses its own product library and product directory. For example, release 6.0.3 for 5733LD6 is installed using option 13 of that product. Release 6.5.0 for 5733L65 is installed using option 10 of that product. New releases of these products will be installed with their own options for that product.

- For major new versions of Domino, new licensed product IDs are used. For example, Domino 6.0.x uses 5733LD6, Domino 6.5.x uses 5733L65, and Domino 7.0 uses 5733LD7.
The multi-versioning support was developed with the intent of impacting customer environments as little as possible. However, based upon how you use Domino or how your applications may be written, some changes may be required. Please review the sections below as necessary to make sure you understand the possible impacts.

Installing a multi-version capable release on the same partition as Domino R5 or a release of Domino 6 prior to 6.0.3/6.5.0 will mean that all the existing servers configured on that partition will be updated during installation. These servers should be backed up before the new release of Domino is installed. Once the servers are updated as part of the installation of the new release, there is no way to revert the server and its configuration if it had not been saved. For more information on backing up a Domino server that is not multi-version capable, see either Installing and Managing Domino for AS/400 (as400hlp.pdf) or Installing and Managing Domino 6 for iSeries (i400help.pdf). These guides are available from the Lotus developerWorks Documentation Library at the following Web site:

http://www.ibm.com/lotus/ldd/doc

### Installing multi-version capable releases

Installing a multi-version capable release of Domino usually consists of installing the *BASE option of the product, then installing the option with the specific release, such as 7.0. This differs from R5 and early Domino 6 releases in that the release of the product was also packaged in the *BASE option. Since releases prior to 6.0.3 and 6.5 were not multi-version capable, it was acceptable that each new release installation would overwrite the release already installed.

Since a multi-version capable release is no longer overwritten when you install an updated release, doing so will result in having multiple releases on the same partition. If you do not wish to have multiple versions installed on the same partition, you must manually remove one of the releases. For more information on removing a multi-version capable release, see "Removing multi-version capable releases" later in this chapter.

To install a multi-version capable release of Domino, you must first install the *BASE option of the product if it is not already installed. For example, if you install the *BASE option from the 6.5.0 media, you can install option 10, which is the 6.5.0 release. Since option 11 is not available in this *BASE option, you cannot install the 6.5.1 release. However, if you install the *BASE option from the 6.5.1 media, both options 10 and 11 are available, allowing you to install both 6.5.0 and 6.5.1 releases. To install multi-version capable Domino 7, first install the *BASE option and then install option 10, which is the 7.0 release.
Installing a multi-version capable release

You can install a multi-version capable release from the product CD-ROM using the LODRUN command or the InstallShield GUI, or from a save file using the RSTLICPGM command.

- If you choose to use install the release from the product CD-ROM with the LODRUN command or the InstallShield GUI, the installation process will determine if the *BASE option for that release is already installed. If that particular release's *BASE option is not installed, the installation program will install the *BASE option from the CD-ROM. After that option has been installed, it will install the release option of Domino, such as option 10 for Domino 7.0.

- Installing the release from a save file using the RSTLICPGM command involves a few additional steps. If the *BASE option for this release is not already installed on this partition, you must install it before installing the release option. To install the *BASE option using the RSTLICPGM command, type the following at any i5/OS command line and press Enter:

```
RSTLICPGM LICPGM("PRODUCTID") DEV(*SAVF) OPTION(*BASE)
LNG(2924) SAVF(QNOTES)
```

where PRODUCTID is the Licensed Program identifier, such as 5733LD7.

Once the *BASE option is installed, you can install the release option by typing the following command and pressing Enter:

```
RSTLICPGM LICPGM("PRODUCTID") DEV(*SAVF) OPTION(10) LNG(2924)
SAVF(QNOTESRL)
```

where PRODUCTID is the same Licensed Program identifier you used above.

In this example, option 10 is specified, which installs the 7.0 release of 5733LD7 from the save file QNOTESRL. The actual option you specify depends on which release you are installing.

Note You can remove this release of Domino and leave all other multi-version capable releases of Domino on the partition by removing the release option only. For example, to remove only the 7.0 release of Domino, type the following command and press Enter:

```
DLTLICPGM LICPGM(5733LD7) OPTION(10)
```

For more information on removing releases of Domino, see "Removing multi-version capable releases" later in this chapter.

Chapter 12: Using Domino for i5/OS multi-version capabilities  83
Installing a release that is not multi-version capable after installing a multi-version capable release

In order to install a release that is not multi-version capable after installing a multi-version capable release, you must first remove the multi-version capable release. To remove a multi-version capable release, type the following at an i5/OS command line and press Enter:

```
DLTLICPGM LICPGM(PRODUCTID) OPTION(*ALL)
```

where `PRODUCTID` is the Licensed Program identifier, such as 5733L65 or 5733LD7.

**Note** Any Domino servers that are configured to use the multi-version capable release will still be configured to use that release, but you will not be able to use them until that multi-version capable release is reinstalled on that partition.

Updating to a multi-version capable release from a release that is not multi-version capable

As you install your first multi-version capable release on a system with Domino servers already configured, all servers that are not multi-version capable will automatically be updated during the install process. For example, if you install Domino 7.0 on a partition that has Domino 6.0.2 servers, they will all be updated to the 7.0 release.

To perform this update, all servers configured to run a Domino release prior to 6.0.3/6.5.0 must be ended before you can install the *BASE option of the multi-version capable release. After the *BASE option has been installed, as you install the multi-version capable release option, all existing servers configured to use a release prior to 6.0.3/6.5.0 will automatically be updated to use this new release.

**Note** You cannot run multi-version capable releases of Domino on the same partition as releases that are not multi-version capable.

Installing multiple releases of Domino

To use multiple releases of Domino on the same partition, the option for each multi-version capable release must be installed. To install the option for a particular release, the *BASE option that defines that option must be installed. For example, the *BASE option for 6.5.0 defines option 10. If you only have this *BASE option installed on your partition, you can not install option 11, which is Domino 6.5.1. However, if you have the *BASE option for 6.5.1 installed, it defines the both options 10 and 11, allowing you to install either 6.5.0 or 6.5.1 by specifying the appropriate option during installation.

This approach to defining and packaging every new maintenance release of Domino as options will continue as each one becomes available. With each new maintenance release, the *BASE option that defines it will also be made available.
Domino 7 for i5/OS is defined and packaged in the same way. Each subsequent Maintenance Release will be defined as an option of the 5733LD7 product. The first release of Domino 7 for i5/OS is 7.0, and its corresponding option is 10. For example, to install this release using the LODRUN command, place the product CD-ROM in the optical drive of your server, type the following command and press Enter:

```
LODRUN DEV(*OPT) DIR('OS400')
```

When a second multi-version capable release is installed, servers that are configured to use any other multi-version capable release should not have to be ended. If a multi-version capable release is reinstalled, any servers that are configured to use that release must first be ended.

**Note** You can use multi-version capable releases of Domino from the 5733LD6, 5733L65, and 5733LD7 products on the same partition. The order in which you install the different releases does not matter.

**C API restriction with multiple releases installed**
The C API option of the Domino product (option 1) is not multi-version capable, so installing the C API option for one release completely overwrites the C API for another release. For example, if the C API option for 6.5.3 is installed, then the C API option for 7.0 is installed, the 7.0 version becomes the only installed version. This is important for users that develop applications that use a specific C API release.

If you need to change the installed release of the C API option, simply install (or reinstall) the option from the release you want, as this option can be installed or reinstalled in any order.

### Removing multi-version capable releases

There are some special considerations to keep in mind for removing multi-version capable releases of Domino.

Any Domino servers that are configured to use a multi-version capable release must be ended before that release's option can be removed. Failure to end a Domino server before attempting to remove that release's option will result in an error message notifying you that the server must be ended.

Once a particular release has been removed, any remaining Domino servers configured to use that release will not start. To use these Domino servers again, you must either update the server to a release of Domino that is installed, or reinstall the release option.
Multi-version capable releases of Domino can be removed in any order. For example, if your partition has both 6.5.0 and 6.5.1 releases installed, you can remove either release without affecting the other. For example, release 6.5.1 can be installed while 6.5.0 servers remain active.

**Note** When a Domino server's release is the primary release on a partition, some objects are copied to QSYS and QNOTES during installation. If this release is removed, these common objects are also removed from QSYS and QNOTES. If other releases of Domino are installed on the same partition, objects from the next primary release are automatically copied into QSYS and QNOTES.

To completely remove a release of Domino, you must remove every option including *BASE. To do this, type the following at any i5/OS command line and press Enter:

\[
\text{DLTLICPGM LICPGM(\text{PRODUCTID}) OPTION(*ALL)}
\]

where \text{PRODUCTID} is the Licensed Program identifier, such as 5733L65.

---

**Managing multi-version capable releases**

One significant change to consider when dealing with multi-version capable releases, is how the installed releases are integrated with each other. There are certain objects that can only exist once on a partition. The multi-version capable releases are designed to recognize this and accommodate this as part of their installation. Whenever a more recent multi-version capable release is installed, its commands, panel groups, and message files are copied to QSYS and QNOTES. When these commands are used on the system in an interactive session or a batch program, the primary release version of the commands are used.

Other commands can be used against any release, no matter which release the command originated from. For example, the command ENDDOMSVR SERVER(*ALL) will end all active servers on the partition that are currently running. It does not matter which release of Domino the servers are configured to use, or which release of Domino defined the command.

**Note** Even when a library qualified use of this command is entered, all currently active servers on that partition are ended, no matter which release they are configured to use. For example, on a server with Domino 6.5.3 and 7.0 installed, the following command would still end all active servers:

\[
\text{QDOMINO603/ENDDOMSVR SERVER(*ALL)}
\]

The following subsections detail how different commands work in a multi-version capable environment. There are also details on a new command, UPDDOMSVR.
**WRKDOMSVR**

Issuing the WRKDOMSVR command displays all configured Domino servers on a particular partition, regardless of which release a server is configured to use.

To display a server's configured release library and Domino release level, press F11 from the main display for the WRKDOMSVR command.

If any server is configured to use a specific release of Domino that is not installed, the server's status will show *UNAVAIL.

All functions of the WRKDOMSVR display are supported and all can be used against any server displayed.

**Note** There are two exceptions. You cannot start or change a Domino server with a status of *UNAVAIL. Attempting to start it will fail with message LNT0218, and attempting to change it will fail with message LNT0215.

The following shows a sample of the WRKDOMSVR display after pressing F11.

```
<table>
<thead>
<tr>
<th>Opt</th>
<th>Server 1</th>
<th>Subsystem</th>
<th>Library</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DOMINOTEST</td>
<td>DOMIN001</td>
<td>ODOMIN0550</td>
<td>6.5.0</td>
</tr>
<tr>
<td>2</td>
<td>FAX50</td>
<td>DOMIN002</td>
<td>ODOMIN0550</td>
<td>6.5.0</td>
</tr>
<tr>
<td>3</td>
<td>FAK50</td>
<td>DOMIN003</td>
<td>ODOMIN0550</td>
<td>6.5.0</td>
</tr>
<tr>
<td>4</td>
<td>DMSVR</td>
<td>DOMIN004</td>
<td>ODOMIN0550</td>
<td>6.5.0</td>
</tr>
<tr>
<td>5</td>
<td>DOMSRVR</td>
<td>DOMIN005</td>
<td>ODOMIN0550</td>
<td>6.5.0</td>
</tr>
<tr>
<td>6</td>
<td>SERV001</td>
<td>DOMIN006</td>
<td>ODOMIN0550</td>
<td>6.5.0</td>
</tr>
<tr>
<td>7</td>
<td>TEST002</td>
<td>DOMIN007</td>
<td>ODOMIN0550</td>
<td>6.5.0</td>
</tr>
<tr>
<td>8</td>
<td>TEST003</td>
<td>DOMIN008</td>
<td>ODOMIN0550</td>
<td>6.5.0</td>
</tr>
</tbody>
</table>
```

**CFGDOMSVR**

When multiple releases of Domino are installed on one partition, new Domino servers can be configured to use any of the installed releases of Domino. The CFGDOMSVR command is one that can be library qualified and run against specific releases.
If you use CFGDOMSVR without library qualifying it, it will use the primary release of Domino installed. For example, if you have both Domino 6.5.0 and 7.0 installed, the following command will only create servers that are configured to use 7.0:

```bash
CFGDOMSVR SERVER (SERVERNAME)
```

where `SERVERNAME` is the name of your Domino server.

If you library qualify the CFGDOMSVR command, you can configure a server to use any installed Domino release. For example, to configure a Domino 6.5.0 server in the above environment, you would use the following command:

```bash
QDOMINO650/CFGDOMSVR SERVER (SERVERNAME)
```

where `SERVERNAME` is the name of your Domino server.

Using the *REMOVE option in any multi-version capable release can be used to remove any configured Domino server. Therefore, if the specific release that a Domino server is configured to use is no longer installed, you can still remove that server using the following command:

```bash
CFGDOMSVR SERVER (SERVERNAME) OPTION (*REMOVE)
```

where `SERVERNAME` is the name of the Domino server you are removing.

**CHGDOMSVR**

The CHGDOMSVR command is used to change the configuration of existing Domino servers. You can use this command on any server, from any installed library. This command detects the release of the server you specify and displays the appropriate parameter options for that server's release. This means that you must have that server's release currently installed on your partition for this command to work properly. If a server's release is not installed, and you try to change its configuration, you will receive the error message LNT0218. You can either update your server to an installed release, using the UPDDOMSVR command, or install the appropriate release for that server.

**UPDDOMSVR**

The UPDDOMSVR command allows you to update specific Domino servers to newer releases. You can update all servers, or select specific servers, allowing you to control which servers are configured for specific Domino releases.

Prior to releases 6.0.3/6.5, servers were automatically upgraded during the product installation process. However, this process no longer occurs during installation. With any multi-version capable release, you must run the UPDDOMSVR command before installation in order to update that server to the newer release.

**Note** You must end the Domino server before attempting to update it.
You can only update a Domino server to a release that is currently installed on your partition. While it is not possible to update a Domino server to a previous release, you can update a Domino server to its own release.

For more information on the UPDDOMSVR command, see Appendix C "Using i5/OS Commands With Domino for i5/OS."

Using applications with multi-version capable releases

The intent of this section is to provide a brief overview of ways you can more easily use Domino applications in a multi-version capable environment. For more detailed information on these and other application development issues, see the book Application Development Guide (apdev400.pdf) which is available from the Lotus developerWorks Documentation Library at the following address:

http://www.ibm.com/lotus/ldd/doc

In many circumstances, Domino applications continue to function in a multi-version capable environment as they did previously. There are some things to consider in regard to applications, and actions you can take to ensure your applications work as expected in a multi-version capable environment.

The primary issue for making sure your applications run correctly is ensuring they use the proper path. In previous releases, Domino set the path for applications to /QIBM/PRODDATA/LOTUS/NOTES. With multi-version capable releases, this path still exists as a symbolic link to the most recent release’s path. The actual path for a given release now contains the specific release name. For example, Domino 6.0.3 will set the path to /QIBM/PRODDATA/LOTUS/DOMINO603. Therefore, if your application has the old path hard coded, it will only refer to the path of the most recent release installed and may fail in a multi-version capable environment.

To make sure your applications function correctly in a multi-version capable environment, you must correctly set up your Domino run time environment. Your applications should be designed to work with any Domino server, no matter which release it is configured to use. The application should be coded so that the run time environment set up checks the server’s current configuration and automatically sets up the environment to be consistent with the server’s configured release. The following commands and APIs are useful tools to help you accomplish this in your applications:

Note All of these commands and APIs are available beginning with Domino 5.0.12 and 6.0.1. You can use these in your applications even if you are not yet using multiple versions of Domino on the same partition.
RUNDOMCMD

The Run Domino Command utility runs a given program against a server after setting up the environment for a particular server. When this command is run interactively, it will restore the current environment back to what it was before issuing the RUNDOMCMD utility.

For example, to use the RUNDOMCMD utility to run the C API called "acllog" type the following on an i5/OS command line and press Enter:

```
RUNDOMCMD SERVER(servername) CMD(call PGM(qnotessdk/acllog) parm(acllog.nsf)) BATCH(*NO)
```

where `servername` is the name of your Domino server where you are running this API.

Note In Domino R5, RUNDOMCMD was installed into a library. This example assumes that the library is in the Library List for the job. With Domino 6, the RUNDOMCMD utility is copied into the QSYS library.

SETDOMENV

The Set Domino Environment command is installed automatically into QNOTES and copied into the QSYS library with Domino 7 for i5/OS. This command is used to set the current environment for the specified server and specific job. Unlike the RUNDOMCMD utility, there is no command parameter. Once the SETDOMENV command has been issued, the environment is set until the job ends.

The possible parameters for SETDOMENV are as follows:

- **SERVER** - You must enter the name of the Domino server where information about the environment is retrieved.

- **USER** - You must specify one of the following two options:
  - *CURRENT specifies that the user profile will not be switched.
  - *SERVER specifies that the user profile associated with the server configuration should be switched for the current profile. For any Domino server using any release of Domino for i5/OS, this user profile is restricted to be QNOTES.

  **Note** If SETDOMENV is used to switch the profile to QNOTES in an interactive job, the command line can no longer be used since QNOTES is a restricted profile. Sign-off will still work from the command line.

- **PATH** - You must specify one of the following three options:
  - *REPLACE specifies that the current environment variable path will be set to the server's data directory, executable directory, and Domino user directory.
  - *APPEND specifies that the server's data directory, executable directory, and user directory names will be appended to the current value for the path environment variable.
Note If there are other Domino directory names in the path ahead of your server's, Domino may open a database in one of those other directories instead of your server's directory.

- **PREPEND** specifies that the server's data directory, executable directory, and Domino user directory names will be prepended to the current value for the path environment variable. They will appear first in the path environment variable.

For example, to use the SETDOMENV command, type the following on an i5/OS command line and press Enter:

```
SETDOMENV SERVER('servername') USER(*SERVER) PATH(*REPLACE)
```

where `servername` is the name of your Domino server.

**QnninSetDominoEnv**

QnninSetDominoEnv is a Domino for i5/OS API included in the *BASE option for Domino 7. This API is provided by the QNOTES/QNNINLDS SRVPGM, and works in a similar manner as the SETDOMENV command, but with a few differences. The API sets the environment for a specific Domino server, but it saves the current job environment. The API must be run again to reset the environment back to its original profile before it can be run again in the same job.

This API is useful for developers, as it removes the necessity for knowing specific environment information about each Domino server.

Using these APIs allows an application to set the Domino environment that is appropriate to a server’s current configuration. The application doesn’t have to be aware that different servers might be configured to use different releases of Domino or that a server has been updated to use a new release of Domino.

**Writing applications to use existing environment variables**

Applications can be written to correctly set the Domino environment so that a server can access Domino tasks or data in a Domino database, even without using the provided APIs. The environment must be specific to the server that owns the tasks or databases which the application needs to access. This must be done for every Domino server accessed in the same job before the server is accessed.

Applications should not be written with specific directory path names that are associated with Domino servers, as these path names change as the servers are updated to newer releases.

One exception to this rule is the Domino user directory. This directory should always be last in the path environment variable an does not change based on a server's current configuration. The Domino user directory path is `/QIBM/USERDATA/LOTUS/NOTES`.
To correctly set the Domino environment, the application should be written using QnninRtvDominoServerI (Retrieve Domino Server Information). This API is provided by the QNOTES/QNNINLDS SRVPGM. Given the server's name, this API will retrieve the server's executable directory path and data directory path. The application can be written to use these returned values to always set up the correct environment for any Domino server.

For more information on using the QnninSetDominoEnv and QnninRtvDominoServerI APIs, see the Application Development Guide (apdev400.pdf), which is available from the following Web site:

http://www.ibm.com/lotus/ldd/doc
Chapter 13
Domino for i5/OS security overview

A key strength of deploying Domino on i5/OS is the security that these two products provide. This chapter highlights the security built into both Domino and i5/OS.

About the QNOTES user profile

Every i5/OS job runs under an i5/OS user profile. The user profile defines operational characteristics for the job. The user profile is also the source for privileges (special authorities) that the job needs for system functions and for the authority that the job needs to perform operations on i5/OS objects.

Domino for i5/OS includes a user profile called QNOTES. The QNOTES user profile provides the mechanism for Domino access control to work with the underlying system security. To function correctly, all Domino applications must run under the QNOTES user profile. You should not change the QNOTES user profile.

For more information, see "About i5/OS support for Domino access control" later in this chapter.

Processes that automatically run under the QNOTES user profile

The following Domino processes run under the QNOTES user profile:

- The Domino server
- Programs that the Domino server starts as a result of ServerTasks or ServerTasksAt settings in the NOTES.INI file
- Programs that start as a result of Program documents in the Domino Directory
- Hook drivers and extension managers that run in the Domino server
- Agents that run in the Domino server
- Programs that start when you enter the Load command at the Domino server console
Ensuring that your Domino application runs under the QNOTES user profile

If your Domino application is not designed to run in a process that automatically runs under the QNOTES user profile, use one of the following techniques to ensure that your application runs under the QNOTES user profile:

- Use the i5/OS command Submit Job (SBMJOB) to run the job in the background (in batch) under the QNOTES user profile. The SBMJOB command has a parameter to specify the user profile that the job should run under. Following is an example for using the SBMJOB command to run the CUSTSVC program in the CUSTPGM library:

  SBMJOB CMD(CALL PGM(CUSTPGM/CUSTSVC)) USER(QNOTES)

  To submit a job that runs under QNOTES, the user must have *USE authority to the QNOTES user profile. In general, you should avoid giving users authority to the QNOTES user profile because the QNOTES user profile has the authority to change or delete any object on your Domino server.

- Inside your application, swap to the QNOTES user profile by using the following i5/OS system APIs:
  - QSYGETPH - get profile handle
  - QWTSETP - set profile

  If you use this technique, be aware of the following:
  - When the program swaps to the QNOTES user profile, the program will not have access to typical programmer functions such as debug commands. To minimize potential security exposures, the QNOTES user profile provides only *USER level authority to i5/OS functions.
  - The program should include an exception or cancel handler to swap back from the QNOTES profile in the event the program aborts or is canceled.

    For more information, see "About authority when i5/OS programs access Domino databases " in this chapter.

- Use the RUNDOMCMD utility that ships with Domino.

  This utility switches to the QNOTES user profile, runs your application, then switches back to the user profile you were using. Using this utility, you do not need to write additional code in your applications. For more information on the RUNDOMCMD utility, see Appendix C "Using i5/OS commands with Domino for i5/OS."
Example: Swapping to the QNOTES user profile

Following is a coding example for using the system API to swap to the QNOTES user profile:

    /* header files to include */
    #include <qsygetph.cleinc>   /* Header file for the QSYGETPH */
    #include <qwtsetp.cleinc>    /* Header file for the QWTSETP */
    #include <qusec.h>       /* Error code structure */
    #include <qsnapi.h>      /* Error code structure */
    /* declarations */
    Qus_EC_t err_code;
    char user_prof_handle[13];
    char qnotes_prof_handle[13];
    /* get the handle to the QNOTES profile */
    QSYGETPH(qnotes_user,
             qnotes_password,
             qnotes_prof_handle,
             &err_code);
    if(err_code.Bytes_Available)
    {
        /* Error retrieving handle to QNOTES user profile. */
        return -1;
    }
    /* get the handle to the profile we are currently running under */
    QSYGETPH(cur_user,
             NULL,
             user_prof_handle,
             &err_code);
if(err_code.Bytes_Available)
{
    /* Error retrieving handle to current user profile. */
    return -1;
}
/* switch to QNOTES user profile */
QWTSETP(qnotes_prof_handle,&err_code);
if(err_code.Bytes_Available)
{
    /* Error switching to QNOTES user profile. */
    return -1;
}
/******************************
/* do notes APIs or functions */
/******************************
/* switch back to current user */
QWTSETP(user_prof_handle,&err_code);
if(err_code.Bytes_Available)
{
    /* Error switching to current user profile. */
    return -1;
}

About i5/OS support for Domino access control

Domino security and the underlying i5/OS security work together to achieve
two objectives:

- The portability of Domino applications: access control for Domino for i5/OS
  must work just like it does on other Domino server platforms.
- The security and integrity of other applications that might share the same
  system: Domino for i5/OS must follow the security rules that apply to every
  other system application.
To understand how Domino security and i5/OS work together to achieve these objectives, you need some basic information about how Domino security works and about how i5/OS stores Domino databases.

- Domino provides the capability to define an access control list for every Domino database. Access control lists provide authorities that are similar to i5/OS object authorities. For example, in Domino, editor authority lets a user change any document in a database. However, an editor cannot delete a database or give other users authority to the database.

  Similarly, in DB2 UDB for iSeries, *CHANGE authority lets a user add, change, or delete records in a database file. However, *CHANGE authority does not allow a user to delete the file or authorize others to use the file.

- When you configure a Domino for i5/OS server, you specify the data directory for server databases. For example, you might specify /NOTES/DATA. Domino for i5/OS databases (files with an .NSF extension) always reside in the i5/OS integrated file system.

  Domino for i5/OS creates the Domino data directory with public authority set to *EXCLUDE. Whenever a Domino user creates a new database, the public authority for the new database is *EXCLUDE. This prevents i5/OS users from accessing Domino databases outside of Domino.

  **Note**  A user with *ALLOBJ special authority can access or delete any database.

- Domino for i5/OS provides a user profile called QNOTES, which owns the Domino data directory and all the objects in the directory. The QNOTES user profile has *ALL authority to the objects. Domino server jobs run using the QNOTES user profile.

  **Note**  By default, the QNOTES user profile owns the Domino data directory. You can change the owner, but you must ensure that the QNOTES user profile has *ALL authority to the directory and the objects in it or your server will not function properly.

  **Note**  Beginning with Domino 7, the user profile QNOTESDB2 is also created during product installation. The QNOTESDB2 user profile is created to enable future capabilities that are not present in release 7.0.
Now you can put the pieces together and see what happens when a Notes user tries to access a Domino database:

1. The operating system checks to see whether the user has authority to the object in the integrated file system (such as /NOTES/DATA/MYDB.NSF). To the operating system, the user appears to be the QNOTES user profile, which owns all of the objects in the /NOTES/DATA/ path. Therefore, access is allowed.

2. Control passes to Domino for i5/OS. Domino recognizes the Notes user who has established a connection with the server and provided authentication. The Domino server checks that user's authority on the access control list for the database. If the user has the correct authority, Domino for i5/OS allows the user's request to proceed.

About authority when i5/OS programs access Domino databases
The database integration between Domino and the operating system works in both directions. Your Domino applications can retrieve (and potentially update) DB2 UDB for iSeries databases. Similarly, i5/OS applications can retrieve (and potentially update) information in Domino databases. Following are the basic steps to gain access to a Domino database from an i5/OS program:

1. To access a Domino database, an operating system program uses Domino application programming interfaces (APIs). These Domino APIs are available for C, C++, and Java programming languages.

2. Domino processes the database request as a server program (not a client/server program). Therefore, the Domino user for the database request is the user who is associated with the server.

3. A Domino server can have more than one NOTES.INI file. The NOTES.INI file specifies the user for server jobs for that INI file.

4. Your i5/OS program can use an API to point to the INI file that is appropriate for the Domino databases that the program wants to access. If your i5/OS program does not explicitly specify an INI file, Domino uses the default user for the server.

5. The Domino user must have the necessary authority to the Domino database.

6. To gain access to the Domino server and the NOTES.INI file, the i5/OS program that contains the API calls must run under the QNOTES user profile. This program cannot use adopted authority because adopted authority does not work with the integrated file system (Domino databases reside in the integrated file system on i5/OS).

For your Domino server to function properly, the QNOTES user profile must have *ALL authority to all of the Domino objects. Therefore, you should avoid giving users authority to the QNOTES user profile, either directly or indirectly. Instead, use specific programs for specific functions and use profile swapping. The topic that follows provides an example of this technique.
Setting up authority for accessing Domino databases from i5/OS programs

Following is an example for providing access to Domino data from an i5/OS program while protecting the QNOTES user profile:

1. Create an i5/OS program that contains the API program calls to access specific Domino databases. For the example, the program is a C++ program called ACCESSDOM. Following are the security characteristics of the ACCESSDOM program:
   - Public authority is *EXCLUDE.
   - The QNOTES user profile owns the program.
   - The program does not adopt authority.
   - No users have private authority to the program.

2. Create a program that provides the i5/OS user interface. The program might display information from both i5/OS databases and a Domino database. For the example, the program is an RPG program called USERDB1. Following are the security characteristics of the USERDB1 program:
   - Public authority is *EXCLUDE.
   - The QNOTES user profile owns the program.
   - The program adopts the authority of the QNOTES user profile.
   - Authorized users have private authority to the program.

3. Provide access to the Domino database through the following steps:
   - An authorized user runs the USERDB1 program.
   - Program USERDB1 uses an i5/OS API to swap to the QNOTES user profile. (The user does not have direct authority to swap to the QNOTES user profile. However, the USERDB1 program adopts the authority of the QNOTES profile and, therefore, has sufficient authority to swap to the QNOTES user profile.)
   - Program USERDB1 calls the ACCESSDOM program and passes parameters about the database request.
   - The ACCESSDOM program runs the Domino API program calls to retrieve the Domino data and return it to the USERDB1 program.
   - The USERDB1 program swaps back to the user profile of the requesting user. It displays the Domino data for the user.

Following is a summary of the security features of this example:

- Public authority to the ACCESSDOM program is *EXCLUDE. No user (except a user with *ALLOBJ special authority) can run this program directly. Therefore, OS/400 users cannot gain access to Domino databases outside the control of the USERDB1 program.
• Public authority to the USERDB1 program is also *EXCLUDE. Only specific i5/OS users have the authority to run the program.

• The ACCESSDOM program can specify a NOTES.INI file. The NOTES.INI file can point to a Domino user who has the desired database authorities.

• This example does not require that any i5/OS users have *USE authority to the QNOTES user profile.

For more information and a coding example, see "Example: Swapping to the QNOTES user profile" earlier in this chapter.

Security recommendations for Domino for i5/OS
Following are recommendations to protect both your Domino server and your other i5/OS applications and data:

• The QNOTES user profile owns all of the objects in the Domino data directory. It has the capability to change or delete any Domino database. The settings for the QNOTES user profile are designed to protect your Domino data. For example, the QNOTES user profile does not have a password. Its initial menu is *SIGNOFF. You should not change the QNOTES user profile.

• Public authority to the QNOTES user profile is *EXCLUDE. This prevents users from submitting jobs that run under the QNOTES user profile. You should not change the public authority to the QNOTES user profile. Grant private authority to the QNOTES user profile with extreme caution.

  Note To ensure that users cannot submit jobs under the QNOTES user profile, the security level (QSECURITY system value) for your system must be 40 or higher. Otherwise, a job description that runs under the QNOTES user profile represents a security exposure.

• The QNOTES user profile owns the Domino database directory and the objects in it. To ensure that Domino applications run properly, you should not change the ownership to these objects.

• Public authority to the Domino database directory and the objects in it is *EXCLUDE. To ensure that Domino security works correctly, you should not change the public authority to the directory or the objects.

  Note The Domino data directory is the directory that you specify when you configure the Domino server, such as /NOTES/DATA.
Chapter 14
Integrating Domino for i5/OS with other database management systems

Domino 7 for i5/OS has the flexibility to integrate with many other database management systems, enhancing your existing environment.

About DECS
The Domino Enterprise Connection Services (DECS) is a forms-based technology in Domino that provides the capability to integrate live data from i5/OS into Domino applications. Using DECS, you can build live links from Domino pages and forms to data in the DB2® Universal Database™ for iSeries. The DB2 UDB for iSeries database can be on either a local system or a remote system. For details on setting up DECS, see "Setting up DECS" later in this chapter.

About LEI
Lotus Enterprise Integrator (LEI) is a server-based data distribution product that enables a high performance, scalable exchange of data between Lotus Domino and other host and relational applications. LEI allows you to schedule data synchronization for high volume transfers when server usage is low. For more information on LEI, see the following Web site:


Note Beginning with Domino 6, the LEI version used must match the Domino version. For example, LEI 6.5 must be used with Domino 6.5. Previous versions of LEI (such as 3.0) are not supported on Domino 7.

About LS:DO
LotusScript Data Object provides properties and methods for accessing and updating tables in external databases using LotusScript. LS:DO is easy to learn and integrate with i5/OS.
About DB2 UDB
DB2 Universal Database for iSeries is a fully integrated relational database manager that provides functions and features such as triggers, stored procedures, and dynamic bitmapped indexing that serve a wide variety of application types. These applications range from traditional host-based applications to client/server solutions to business intelligence applications. For more information on DB2 UDB for iSeries, see the database section of the IBM eServer iSeries Information Center at the following Web address:
http://www.ibm.com/eserver/iseries/infocenter

About wire protocol drivers
Starting with Domino 7 and Domino 6.5.3, the Lotus Branded DataDirect Connect for ODBC wire protocol drivers are installed by the Domino installation program to the directory /QIBM/ProdData/Lotus/DOMINOxxx/EITODBC/, where DOMINOxxx is the directory corresponding to the release of Domino (for example, DOMINO700 for Domino 7.0). The user is no longer required to download and install the drivers.
Lotus Branded DataDirect Connect for ODBC consists of a number of database drivers that are compliant with the Open Database Connectivity (ODBC) specification. The drivers enable you to connect to a variety of relational databases.

Setting up DECS
The DECS software is installed as part of the base installation of Domino for i5/OS. When you set up the Domino server, use the Connection services option to make DECS available on the server.

Note For details on installing the Domino software and setting up a Domino server, see Chapter 3 "Installing Domino."

If you want to enable DECS for an existing Domino server using iSeries Navigator, follow these steps:

1. Start iSeries Navigator.
2. Open the system with the Domino server you want to change.
3. Click Network.
4. Click Servers.
5. Click Domino.
6. Right-click the Domino server and select Properties.
7. On the Properties display, click the Services tab.
8. Check the box next to Domino Enterprise Connection Services (DECS) to enable DECS.
Tip  You can also use the CHGDOMSVR command to enable DECS on an existing Domino server. For more information on the CHGDOMSVR command, see Appendix C "Using i5/OS commands with Domino for i5/OS."

The DECS files that are installed include a DECS Administrator database template (DECSADM.NTF) and three documentation databases:

- Domino Connectors Setup Guide (LCCON.NSF)
- Domino Enterprise Connection Services User's Guide (DECSDOC.NSF)
- LotusScript® Extension for Domino Connectors Reference Guide (LSXLC.NSF)

The three documentation databases are installed in the DOC subdirectory of the data directory for your server. The User's Guide contains more information about DECS.

When you restart the server after enabling DECS, the DECS Administrator database (DECSADM.NSF) is created from the DECSADM.NTF template the first time the DECS server task is loaded. The DECS Administrator database is then available to add to your Notes workspace. Use the DECS Administrator database to define connections and real-time relationships.

About authority when Domino applications access DB2 UDB for iSeries

An important feature of Domino for i5/OS is the integration between Domino and DB2 UDB for iSeries databases. Several methods are available for Domino applications to access (and potentially update) DB2 UDB for iSeries databases:

- LotusScript applications use LS:DO (LotusScript Data Object) as an interface to DB2 UDB for iSeries data.
- Agents written using the Domino formula language can use @Db instructions to interact with a relational database, including DB2 UDB for iSeries.
- Domino Enterprise Connection Services (DECS) provides real-time access to DB2 UDB for iSeries data through a Domino application.

All of these methods for accessing DB2 UDB for iSeries from Domino establish a connection from Domino to i5/OS. The connection specifies both the user profile whose authority the system uses to access DB2 UDB for iSeries database files and a password for that user profile.

Authority when Domino applications use LS:DO or @Db to access DB2 UDB for iSeries

A Domino application can use either LS:DO (LotusScript Data Object) or @Db functions to provide access to DB2 UDB for iSeries databases. With both methods, the application establishes a connection with the DB2 UDB for iSeries database. The connection specifies an i5/OS user profile and password. Before allowing the connection, i5/OS checks for the following:

- A valid user profile and password combination.
- The user's authority to the DB2 UDB for iSeries database file.
Following are security considerations for protecting your DB2 UDB for iSeries databases when you provide access from Domino applications.

1. For real-time applications (applications connected to a client), decide which i5/OS user profile the Domino applications will use to access DB2 UDB for iSeries data. You might decide based either on the Domino application or on the DB2 UDB for iSeries database. Following are the options:
   - Use the user profile of the user who is running the Domino application. With this method, you need an i5/OS user profile for every Domino user who needs to run an application that accesses DB2 UDB for iSeries data. "Connecting a Domino application to DB2 UDB for iSeries with a matching i5/OS user profile" describes how your Domino application can provide the i5/OS user profile and password.
   - Set up special i5/OS user profiles whose only function is to provide Domino access to i5/OS data. This eliminates the need for each Domino user to have an i5/OS user profile. "Connecting a Domino application to DB2 UDB for iSeries with a special i5/OS user profile" discusses considerations for this method.
   - Use a combination of these methods. Create special user profiles to provide the equivalent of public (or anonymous) access to Domino users. This technique might be appropriate for database files that every user can view. Rely on the Domino user's i5/OS user profile either for higher levels of access or for confidential files.

2. For scheduled applications (such as agents), you also need to provide an i5/OS user profile when you connect to DB2 UDB for iSeries. Scheduled applications run on the server without a connected client. Therefore, the application cannot request a user ID and password from a Domino user. See "Connecting a Domino application to DB2 UDB for iSeries with a special i5/OS user profile" for alternatives.

Consider using adopted authority to provide tighter control over the actions a Domino program can perform on DB2 UDB for iSeries data.

**Connecting a Domino application to DB2 UDB for iSeries with a matching i5/OS user profile**

When a Domino application accesses a DB2 UDB for iSeries database, the Domino application needs to establish a connection with DB2 UDB for iSeries. The connection requires a valid i5/OS user profile and password.
When you want your Domino application to connect by using the Domino user's i5/OS profile, do one of the following:

- **Prompt the user:** Your application can prompt the Domino user for an i5/OS user profile name and password during the first connection within a session. Be sure that your application protects this information carefully. You should avoid storing the passwords for individual i5/OS user profiles on your server.

- **Store the user ID and password:** You can provide a form and database for your Domino users who need i5/OS database access. The form would prompt the user for the i5/OS user profile name and password. The application would encrypt the information and store it in a secure database on the client. Therefore, only the user or an application running on that user's behalf would be able to decrypt the password.

When you use this method, your users do not need to enter their i5/OS user profile and password every time they make a connection from Domino to DB2 UDB for iSeries. They will, however, need to use the form to update their database record when they change their i5/OS password.

**Connecting a Domino application to DB2 UDB for iSeries with a special i5/OS user profile**

When a Domino application accesses a DB2 UDB for iSeries database, the Domino application needs to establish a connection with DB2 UDB for iSeries. The connection requires a valid i5/OS user profile and password.

You might want to create special user profiles for the purpose of providing connections between Domino applications and DB2 UDB for iSeries databases. Do the following for your special user profiles:

1. Decide how many special user profiles to create. Possible options are:
   - A single i5/OS user profile to provide anonymous (or public) access to non-confidential databases.
   - Multiple special-purpose profiles to provide access to DB2 UDB for iSeries data. You might think of these user profiles as similar to group profiles. Their role is to simplify the management of authority. Keep in mind that with this method, i5/OS does not know anything about the real Domino user. The Domino application sets the user profile name. You are relying on the Domino administrator to control who can use the application.
2. Decide whether to use passwords for the connection. Possible options are:
   - Your connection can specify a user profile name and *NOPWD. The QNOTES user profile must have *USE authority to the user profile. With this method, any Domino application can use this i5/OS user profile to attempt to access data.
   - Your application can store the user profile name and a password. You can protect this information so that only trusted programmers can view and update it. However, you must update the application whenever the i5/OS password changes.

   With this method, only Domino users who have authority to the program that contains the user profile and password can attempt to access DB2 UDB for iSeries data with it. The QNOTES profile does not need *USE authority to the user profile.

3. Set up the user profile to protect it from unintended use:
   - Set the initial program to *NONE.
   - Set the initial menu to *SIGNOFF.

Using adopted authority for Domino access to DB2 UDB for iSeries data
On your system, you might wish to use adopted authority to manage how users update information. For example, the typical user might have *USE authority to the open order file (which allows viewing but not creating, changing, or deleting). However, you want to make sure that only certain users can create or change orders. You want to make sure that a new order passes edit checks before it goes into the open order file. You accomplish this kind of control on i5/OS with adopted authority. A user profile with *CHANGE authority to the open order file owns the program that provides the create and change function. Certain users have *USE authority to run the program.

To use a similar technique when you want to manage the ability to update DB2 UDB for iSeries data from Domino applications, do the following:

1. If necessary, design and create i5/OS programs that perform the desired tasks (such as changing a specific record in a database). You can probably adapt programs that you already have.
2. Set up the programs to adopt the authority of a user profile that has appropriate authority to the database file. Do the following:
   - To transfer ownership of the program to the appropriate user profile, use the Change Object Owner (CHGOBJOWN) command.
   - To specify that the program should adopt authority, use the Change Program (CHGPGM) command. Specify *OWNER for the User Profile (USRPRF) parameter.
3. Define the programs as stored procedures for the DB2 UDB for iSeries database files that you want to update.

106 Installing and Managing Domino 7 for i5/OS
4. Design and create your Domino programs to use the stored procedures to update the DB2 UDB for iSeries database files.

5. When your Domino programs connect to DB2 UDB for iSeries, specify a user profile name that has *USE authority to the stored-procedure programs.
Chapter 15
Using Domino as a mail server

The mail features in Domino 7 for i5/OS boast a streamlined deployment that improves performance and eases administration. Using the Domino SMTP function, each server in your environment can be bound to its own IP address, boosting server performance by reducing the infrastructure overhead.

The options you specify when you set up the Domino server define the type of mail support that is used for the server. Whether you set up the server using the Domino Server Setup Wizard (domwzd.exe) or the i5/OS command Configure Domino Server (CFGDOMSVR), the options you specify are essentially the same. You can set up your Domino server to have SMTP, IMAP, and POP3 services.

When setting up Domino, specify which type of mail support you want:

- For Internet mail packages, specify SMTP, IMAP, or POP3.
- For SMTP services, Domino is the default, and the only accepted value.

Note  If the server is already set up, you can reconfigure the server by using either iSeries Navigator or the Change Domino Server (CHGDOMSVR) command.

If you set up more than one server on the same iSeries with SMTP enabled, each server must have a separate Internet (IP) address. Otherwise, they may compete for the same communications port, creating a port conflict.

The setup process creates or changes documents in the Domino Directory for the server. No additional setup is needed.

Once the SMTP mail support is set up, you can verify that the support is active by checking the status of the Domino SMTP. If you are also running i5/OS SMTP on the same system, make sure it binds to a specific IP address, or it will compete with the Domino SMTP for the same communications port. If these two versions of SMTP are bound to the same IP address, they may not function simultaneously on the same server.

Configuring multiple instances of SMTP

With Domino 7 for i5/OS, you have the option of configuring multiple Domino SMTP servers and one i5/OS SMTP server on the same system. This type of setup allows for more granular control over servers and users, increases server scalability, and lowers your total cost of ownership.
Planning the deployment of this type of configuration is very important. The i5/OS SMTP server and each Domino SMTP server must bind to a specific TCP/IP address. Once this is configured, the Domino SMTP servers can send and receive mail with the i5/OS SMTP server, as if they were communicating over the Internet. The following illustrates this configuration.

To configure multiple instances of SMTP, you must ensure the following:

- Domino partitioning must be enabled
- Each instance must bind to a specific IP address

Follow these steps to bind your servers to specific TCP/IP addresses for configuring multiple SMTP servers on the same system:

**Note** The following steps do not include steps for setting up a complex network environment. It is important to understand your network and plan your environment accordingly. For help with setting up a complex network environment, see the Networking section of the IBM eServer iSeries Information Center at the following Web address:

http://www.ibm.com/eserver/iseries/infocenter
1. Obtain all of the necessary TCP/IP addresses required for the configuration. One address is required for each Domino SMTP server and the i5/OS SMTP server.

2. Update the Host Table entries for each server. You can either use iSeries Navigator or the CFGTCP command, selecting option 10.

3. Update the Domain information for each server. You can either use iSeries Navigator or the CFGTCP command, selecting option 12.

4. Edit the NOTES.INI file for each Domino SMTP server. Set the variable TCPIP_TcpIpAddress for each Domino SMTP server to the address you assigned to it earlier. For example, edit the NOTES.INI variable as follows:
   
   TCPIP_TcpIpAddress=0,9.xx.xx.100
   
   where 9.xx.xx.100 is the IP address of your Domino SMTP server.

5. Bind the i5/OS SMTP server to a specific IP address using the ADDSMTPLE command. For example, issue the following two commands, substituting your IP address for the one given:

   ADDSMTPLE TYPE(*SVRBIND) INTNETADR('9.xx.xx.50')
   ADDSMTPLE TYPE(*CLTBIND) INTNETADR('9.xx.xx.50')

---

**Settings for Domino SMTP support**

When you set up mail support using the built-in Domino SMTP, the setup processing creates or changes two documents in the Domino Directory for the Domino server:

- Server document
- Configuration document

The following tables summarize the key settings in each document. The tables show the tab that contains the setting, the name of the field, and the setting.

### Server document

<table>
<thead>
<tr>
<th>Tab</th>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basics</td>
<td>Routing tasks</td>
<td>SMTP Mail Routing is added</td>
</tr>
<tr>
<td>Basics</td>
<td>SMTP Listener task</td>
<td>Set to Enabled</td>
</tr>
<tr>
<td>Basics</td>
<td>Fully qualified Internet host name</td>
<td>Set to the fully qualified Internet host name, which is retrieved from the system TCP/IP configuration settings</td>
</tr>
</tbody>
</table>
### Configuration document

<table>
<thead>
<tr>
<th>Tab</th>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basics</td>
<td>Group or Server name</td>
<td>Set to server name that was specified in the server setup</td>
</tr>
<tr>
<td>Router/SMTP</td>
<td>SMTP used when sending messages outside of the local Internet domain</td>
<td>Set to Enabled</td>
</tr>
</tbody>
</table>

### Modifying the existing Domino configuration

If you are upgrading to Domino 7 from a Domino 5 environment with MSF, you must reconfigure each Domino server to use a unique TCP/IP address, following these steps:

1. Using a Domino Administrator client, edit the server settings in the Server document so that the Domino SMTP server binds to a resolvable Host Name.
   - Click **File**.
   - Select **Database**.
   - Select **Open**.
   - In the server field of the Open Database dialog, specify the server name that you just configured.
   - Open the Domino directory. In the File name field, type the following and click **Open**:
     ```
     names.nsf
     ```
   - In the left pane of the Domino directory, click **Server**.
   - Click **Servers**.
   - Select the Domino server.

2. Enter values for the following fields:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basics</td>
<td>Routing tasks</td>
<td>SMTP Mail Routing is added</td>
</tr>
<tr>
<td>Basics</td>
<td>SMTP Listener task</td>
<td>Set to Enabled</td>
</tr>
<tr>
<td>Basics</td>
<td>Fully qualified Internet host name</td>
<td>Set to the fully qualified Internet host name, which is retrieved from the system TCP/IP configuration settings</td>
</tr>
</tbody>
</table>
3. In the Configuration Document, enter values for the following fields:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basics</td>
<td>Group or Server name</td>
<td>Set to server name that was specified in the server setup</td>
</tr>
<tr>
<td>Router/SMTP</td>
<td>SMTP used when sending messages outside of the local Internet domain</td>
<td>Set to Enabled</td>
</tr>
</tbody>
</table>

4. Stop and restart the Domino server to make the changes take effect.
Chapter 16
Using Domino as a Web server

The Domino server includes HTTP server technology that transforms Domino into a Web applications server. In general, you set up and use a Domino Web server on i5/OS in the same way that you would a Domino Web server on any other platform. However, there are some issues you need to know about:

- WebSphere and Domino integration
- HTTP server options
- Avoiding HTTP server conflicts between i5/OS and Domino
- Serving documents from the QSYS.LIB file system
- Setting up CGI-BIN programs
- Creating SSL key ring files

For more information about the Domino Web server, see the Domino administration documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF).
IBM WebSphere Application Server and Domino integration

Domino 7 ships a servlet engine as part of the base product. If you want to use advanced servlet functions, including Java Server Pages (JSP), Enterprise Java Beans (EJB), and single signon, you must configure a servlet engine.

The following table details the supported integration points for WebSphere Application Server and Domino 7.

<table>
<thead>
<tr>
<th>Product</th>
<th>ACC</th>
<th>HTTP</th>
<th>SSO</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebSphere Application Server 5.0.x Express</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>WebSphere Application Server 5.0.x Base Edition</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>WebSphere Application Server 5.0.x Network Deployment Edition</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>WebSphere Application Server 5.1 Express</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>WebSphere Application Server 5.1 Base Edition</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>WebSphere Application Server 5.1 Network Deployment Edition</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>WebSphere Application Server 6.0 Express</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>WebSphere Application Server 6.0 Base Edition</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>WebSphere Application Server 6.0 Network Deployment Edition</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

**Note**  The headings in this table represent the following:

- **ACC** - Access to Domino Data from WebSphere applications
- **HTTP** - Use of Domino HTTP server to access WebSphere resources (Domino plug-in)
- **SSO** - Single signon between Domino and WebSphere applications

Using these two products together allows you to serve both Domino and WebSphere Application Server Web content. For updated information on integrating Domino 7 with WebSphere Application Server, see the Domino 7 Release Notes and the following Web site:


For more information on the WebSphere Application Server product, see the following Web site:

http://www.ibm.com/eserver/iseries/websphere

116 Installing and Managing Domino 7 for i5/OS
Using IBM HTTP Server with Domino

With Domino 7 for i5/OS, customers can take advantage of the HTTP Server (powered by Apache) to forward HTTP traffic to their Domino 7 servers. This is an alternative to exclusively using the built-in HTTP server provided with Domino.

The plug-in service program QZSRVAP20A is provided with the HTTP Server product (5722DG1) as a PTF in i5/OS V5R3 to provide this function. When an HTTP request is received by the HTTP Server (powered by Apache), the plug-in will forward it to the Domino server (if appropriate). The QZSRVAP20A plug-in uses a configuration file called domino-plugin-cfg.xml to control which HTTP ports are used and which HTTP requests are forwarded to the Domino server. The QZSRVAP20A plug-in is compatible with Apache version 2.0.49 and above.

This plug-in is based on WebSphere 6.0 technology, but does not require WebSphere to be installed on the system (it is a completely separate plug-in and has no direct ties to WebSphere). It can be loaded and run simultaneously with any of the WebSphere plug-ins within the same HTTP Server (powered by Apache) instance. See the topic "Configuring Domino and WebSphere under the same HTTP Server instance" for more information.

This section provides instructions on installing and configuring the IBM HTTP Server plug-in for Domino. There may be additional updates to this documentation after Domino 7 is released. For the latest instructions, including the latest required PTFs, see the following Web page:


Reasons to use IBM HTTP Server with Domino

Some of the key reasons for using IBM HTTP Server (powered by Apache) with Domino include the following:

- HTTP Server provides a single point of entry for all HTTP traffic, including WebSphere and Domino.
- HTTP Server allows you to easily control how URIs are distributed to your application servers using a configuration file. See the topic "Configuration File Details" for more information.
- You can use the WEBADMIN.NSF database via the Web to do administrative tasks.
- There are several additional features like enhanced SSL and Highly Available HTTP Server.

For more detailed information see the HTTP Server (powered by Apache) Web site:

Requirements for the IBM HTTP Server plug-in for Domino

This section lists the required software, individual PTFs, and group PTFs for the IBM HTTP Server plug-in for Domino.

Note There may be additional updates to these PTF requirements after Domino 7 is released. For a list of the latest required PTFs, go to: http://www-1.ibm.com/servers/eserver/iseries/domino/apache.html

Required software

The following are the software requirements for the IBM HTTP Server plug-in for Domino:

- IBM i5/OS V5R3, 5722SS1, with latest PTFs applied
- IBM HTTP Server, 5722DG1

Group PTFs

The following group PTF is required. Apply this group PTF before applying individual PTFs.

- SF99099 - IBM HTTP Server for iSeries V5R3 PTF Group, Level 6 or later

Individual PTFs

The individual PTFs correspond to the version of Apache. If you order the HTTP Server Group PTF, you will obtain the most recent version of Apache and plug-in PTFs that match that version.

The following IBM HTTP Server individual PTFs are required. Apply individual PTFs after applying the group PTF.

- SI18499 - HTTPSVR PROBLEMS WITH WAS6 PROFILES FOR REMOTE SERVERS (includes support for the plug-in's graphical interface)
- SI18425 - Domino plug-in for HTTP server (powered by Apache)

To check the HTTP Server PTF level, enter the following on an i5/OS command line:

DSPPTF 5722DG1

For more information on HTTP Server PTFs, see the HTTP Server PTFs and Support page on the Web at:

Additional requirement if you upgraded from Domino R5 or Domino 6

After upgrading from Domino R5 or Domino 6 to Domino 7, one change may be required to enable HTTP Server to work properly with Domino. If necessary, change the authority on the /QIBM/ProdData/Lotus directory from *PUBLIC *EXCLUDE to *PUBLIC *RX.

To assign the proper authority, enter the following on an i5/OS command line:

```
CHGAUT OBJ('/qibm/proddata/lotus') USER(*PUBLIC) DTAAUT(*RX)
```

**Note** If you previously used the HTTP Server (original) with Domino R5 or the IBM HTTP Server (powered by Apache) with Domino 6, see the topic "Migrating from HTTP Server (original) to HTTP Server (powered by Apache)."

Configuring the IBM HTTP Server plug-in

Follow these steps to configure the IBM HTTP Server plug-in for Domino.

1. Add the following entry to the NOTES.INI file of the Domino 7 server that is the target of the forwarded HTTP requests:

   `HTTPEnableConnectorHeaders=1`

   You must restart the server before this value takes affect.

2. Make sure your Domino 7 server has HTTP configured and running, and note what port it is listening on for HTTP traffic (this value will be used in the Domino server HTTP port number field described below).

3. If the administrative HTTP server on your system is not already running, start it by entering the following command on an i5/OS command line:

   `STRTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN)`

4. Use the IBM Web Administration for iSeries interface to create or update an HTTP server (powered by Apache) instance. To access the IBM Web Administration for iSeries interface, enter the following into the location bar of a Web browser:

   `http://hostname.yourco.com:2001/HTTPAdmin`

   where `hostname.yourco.com` is the fully qualified host name of your system.

   **Note** Make sure the IP address/port number pair used by the HTTP server (powered by Apache) is different than the IP address/port number pair used by the target Domino server. These cannot be the same. It is best if you use different port numbers. If you want to use the same port number for both, you must use different IP addresses for each HTTP server, and you may need an additional entry in your domino-plugin-cfg.xml file. See "Using the same HTTP port number " for details.
5. Once you have created or selected an HTTP server (powered by Apache) instance, click **Domino Application Server** to configure the plug-in.
   - Under the General Settings tab, select **Enable Domino plug-in for this HTTP instance**.
   - Fill in the Domino server host name field. If your Domino server is on the system where the HTTP Server (powered by Apache) is running, you can funnel all HTTP traffic through the HTTP Server by placing LOCALHOST in this field and then binding your Domino server to the LOCALHOST host name. This prevents inbound HTTP traffic from using the Domino server's HTTP port directly.
   - Fill in the Domino server HTTP port number field. This is the port number that your Domino server is configured to listen on for HTTP traffic.
   - Click **Apply** or **OK**.

6. Restart the HTTP Server instance.

**Using the same port number for IBM HTTP Server (powered by Apache) and the Domino HTTP server**

In order for the HTTP plug-in for Domino to work, two HTTP servers must be running: the HTTP server (powered by Apache) and the Domino server's HTTP server. The HTTP server (powered by Apache) gets an HTTP request from a browser, and the plug-in forwards it to Domino's HTTP server. The IP address/port number pairs for these two HTTP servers must be unique. The easiest way to make sure they are unique is to use a different port number for each. However, if you want both servers to use the same port number, do the following:

- Make sure each HTTP server is bound to a specific and unique IP address.
- Add the following entry to the VirtualHostGroup section of the `domino-plugin-cfg.xml` file:

```
<VirtualHost Name="*:<xxxx>">
  ...
</VirtualHost>
```

where `<xxxx>` is the port number. If you do not add this entry, only URLs that explicitly specify the decimal notation of the IP address will be forwarded to Domino. The * allows any valid URL to be passed on to Domino.

**Note**  The default `*:80` is included in the VirtualHostGroup section of the `domino-plugin-cfg.xml` file. Use the IBM Web Administration for iSeries interface to change this default or add an IP address or DNS name for the IP address. Click **Domino Application Server** and select the **Virtual Host Settings** tab. Once you have made your changes, click **Apply** and then **OK**. You must restart the IBM HTTP Server (powered by Apache) instance for any changes to take affect.
For example, consider the following two IP addresses:

- 9.0.2.333 = myco.apache.com
- 9.0.2.444 = myco.domino.com

If you explicitly bind your HTTP server (powered by Apache) to myco.apache.com:80 and your Domino server to myco.domino.com:80, and do not update domino-plugin-cfg.xml, only URLs like the following will be forwarded to Domino:

http://9.0.2.333/names.nsf

The following URL would not be forwarded:

http://myco.apache.com/names.nsf

If you add the entry to the domino-plugin-cfg.xml and specify 80 as the port number, then both URLs are passed on to Domino.

**Configuration file details**

The following is an example of the domino-plugin-cfg.xml file. This file typically exists in the /www/<instance>/conf directory, but might be located elsewhere depending on how the instance was configured.

```xml
<?xml version="1.0" encoding="UTF-8" ?>
- <Config RefreshInterval="60">
- - <!--
- - The log level controls the amount of information written to the
- - plugin log file. Possible values are Error, Warn, and Trace.
- - -->
- - <!--
- - Server clusters provide a mechanism of grouping like servers
- -->
- - <!--
- (or "clones") together for the purpose of balancing workload
- -->
```

Chapter 16: Using Domino as a Web server  121
in a high demand environment.

--> 
- <ServerCluster Name="DOMSVRCLT1" RetryInterval="60">
- <Server Name="DOMSVR1" ConnectTimeout="0">
- <!--
A transport defines hostname and port values the plugin
--> 
- <!--
will use to communicate with the application server.
--> 
- <Transport Hostname="localhost" Port="1880" Protocol="http" />
</Server>
</ServerCluster>

--> 
- <!--
Virtual host groups provide a mechanism of grouping virtual
--> 
- <!--
hosts together.
--> 
- <VirtualHostGroup Name="DOMVHOSTGRP1">
  <VirtualHost Name="*:80" />
</VirtualHostGroup>

--> 
- <!--
URI groups provide a mechanism of grouping URIs together. Only
the
--> 
- <!--
context root of Web applications need to be specified, unless you
-->
- <!--
only want specific URIs to be passed to the application
server.
-->
- <UriGroup Name="DOMURIGRP1">
  <Uri Name="/*.nsf*" />
  <Uri Name="/icons/**" />
  <Uri Name="/domjava/**" />
</UriGroup>
- <!--
A route ties together each of the above components.
-->
  <Route ServerCluster="DOMSVRCLT1" UriGroup="DOMURIGRP1"
  VirtualHostGroup="DOMVHOSTGRP1" />
</Config>

**Key elements of the domino-plugin-cfg.xml file**

The following tables describes the key elements in the domino-plugin-cfg.xml file.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Transport | - Hostname - The host name for the Domino server that is the target of the forwarded HTTP requests. This is the value used for the Domino server host name field.  
- Port - The port number the Domino server uses to listen on for inbound HTTP requests. This is the value used for the Domino server HTTP port number field. |
| VirtualHost | - Name - The IP address and port number pair that the HTTP Server (powered by Apache) is listening on for incoming requests. This is automatically filled in based on the values configured in the HTTP Server instance.  
  **Note**  If the "Server IP addresses and ports to listen on" value is changed in your HTTP instance (under the General Settings tab), click Apply and then OK on the Domino Application Server form to update the domino-plugin-cfg.xml file with the new IP address and port settings. These values map directly to new Virtual Host element(s). |
| Uri | The three Universal Resource Identifier (URI) elements included in the domino-plugin-cfg.xml file allow access to Domino databases on the Domino server. They should not be removed. |
Configuring Domino and WebSphere Application Server under the same HTTP Server instance

To configure the HTTP Server (powered by Apache) instance to handle both Domino and WebSphere Application Server traffic through the same IP address and port, use IBM Web Administration for iSeries to configure a "Domino Application Server" and a "WebSphere Application Server" using the links provided.

Caution  Do not overlap Universal Resource Identifier (URI) entries, as unpredictable results will occur. For example, if a WebSphere Application Server handles all URI's with the pattern "/servlet/**" then do not create the following entry in the domino-plugin-cfg.xml file:

\<Uri Name="/servlet/**" /\>

Upgrading to the IBM HTTP Server plug-in

If you are upgrading to Domino 7 and previously used IBM HTTP Server with Domino, follow the instructions in this section to upgrade to the new IBM HTTP Server plug-in. This section covers the following upgrade scenarios:

- Upgrade from IBM HTTP Server (original) to HTTP Server (powered by Apache)
- Upgrade from a previous version of the plug-in
- Maintenance of multiple versions of the plug-in on the same system

Upgrading from IBM HTTP Server (original) to IBM HTTP Server (powered by Apache)

In Domino 5, the HTTP Server (original) could be used as the HTTP server for your Domino server. Use of the HTTP Server (original) is not supported in Domino 7.

If the HTTP Server (original) is configured to work with a Domino 5 server, and an upgrade to Domino 7 is planned, follow these instructions to create a new HTTP Server (powered by Apache) or migrate the existing HTTP Server (original) to work with the upgraded Domino 7 server.

Note  You will need to change the Domino server to use HTTP in Domino 7. In Domino 5 with the HTTP Server (original), the value of the HTTP Server instance was used in the WEB parameter and Domino's HTTP server was not started and used. In Domino 7, change the WEB parameter to *HTTP and then configure a port on which the Domino HTTP server will listen (default port is 80).
Creating a new instance

Creating a new HTTP Server (powered by Apache) instance is the easiest way to "migrate" from the HTTP Server (original) if you did not customize your instance (i.e. only default values were used and the instance was updated only to communicate with the Domino server).

Follow these steps to create a new HTTP Server (powered by Apache) instance:

1. Create a new HTTP Server (powered by Apache) using IBM Web Administration for iSeries and re-use the port(s) from the HTTP Server (original).
2. See "Configuring the IBM HTTP Server plug-in" to configure the new HTTP Server (powered by Apache) to forward HTTP requests to the Domino server.

Upgrading an existing instance

If the HTTP Server (original) instance was customized, follow these instructions:

1. Use the "Migrate Original to Apache" wizard provided with IBM Web Administration for iSeries to create a new IBM HTTP Server (powered by Apache) instance.
2. After choosing the new Apache instance, select the Manage tab and click Edit Configuration File.
3. Remove the following lines from that file (<xxxxxxxx> is the Domino data directory, and <yyyyyyyy> is the instance directory):
   <Directory /<xxxxxxxx>/JAVA>
   Allow From all
   </Directory>
   <Directory /<xxxxxxxx>/icons>
   Allow From all
   </Directory>
   AliasMatch ^/icons/(.*) /<xxxxxxxx>/icons/$1
   AliasMatch ^/domjava/(.*) /<xxxxxxxx>/JAVA/$1
   AliasMatch ^/(.*) /<yyyyyyyy>/$1
4. See "Configuring the IBM HTTP Server plug-in" to configure the new server to forward HTTP requests to the Domino server.
Troubleshooting

To turn on logging in the plug-in, change the following line in the domino-plugin-cfg.xml file from LogLevel="Error" to LogLevel="Trace." You must restart the HTTP server for this new value to take effect.

```xml
<Log LogLevel="Error" Name="/www/instance/logs/native.log"/>
```

This file is typically located in the /www/instance/conf directory where `<instance>` is the HTTP Server instance, but might be located elsewhere depending on how the instance was created. This line also identifies the directory and name of the log file (/www/instance/logs/native.log in this case).

**Note** You can also turn on logging in the plug-in through the IBM Web Administration for iSeries interface. To do this, start IBM Web Administration for iSeries and access the configuration settings for your IBM HTTP Server (powered by Apache) instance. Click Domino Application Server and select the Plug-in Logs tab. Change the Logging Level from Error to Trace, and click Apply and then OK to save your changes. Restart the HTTP server.

To obtain a detailed trace of the HTTP Server (powered by Apache) activity, specify the -vv option on the instance startup value parameter of the STRTCSVR command:

```bash
STRTCPSVR SERVER(*HTTP) HTTPSVR(server1 '-vv')
```

A spool file associated with the main i5/OS HTTP server job will contain the trace when you stop the HTTP Server instance. This trace file can be found using the following i5/OS command:

```bash
WRKSPLF QTMHHTTP
```

Upgrading from a previous version of the plug-in

If you have existing Domino servers using older versions of the IBM HTTP Server plug-in, you can upgrade them to the new plug-in using the IBM Web Administration for iSeries interface. The IBM Web Administration for iSeries interface automatically updates the plug-in configuration to use the latest plug-in service program installed on the system the first time you edit your configuration settings and save the changes.

**Note** If you have existing Domino servers using an older version of the plug-in and do not wish to upgrade them to the new plug-in, see "Maintaining multiple versions of the plug-in on the same system."

To upgrade to the latest version of the IBM HTTP Server plug-in for Domino, follow these steps:

1. Install the required PTFs. See "Requirements for the IBM HTTP Server plug-in for Domino" for more information.
2. If the administrative HTTP server on your system is not already running, start it by entering the following command on an i5/OS command line:

   `STRTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN)`

3. Access the IBM Web Administration for iSeries interface by entering the following into the location bar of a Web browser:

   `http://hostname.yourco.com:2001/HTTPAdmin`

   where `hostname.yourco.com` is the fully qualified host name of your system.

4. Select the Manage tab and then the HTTP Servers tab.

5. Select your HTTP server from the Server menu.

6. Click Domino Application Server in the left navigation pane.

7. (Optional) At this point, you may wish to review the plug-in configuration settings to see if any changes are necessary.

8. Click Apply and then OK. Any changes you made to your plug-in configuration are saved, and the plug-in configuration is automatically upgraded to the latest plug-in installed on the system.

9. Restart the HTTP server so that the changes take effect.

10. Verify that the new plug-in is working as expected. You should be able to access files on the Domino server through the IBM HTTP Server (powered by Apache) port.

**Maintaining multiple versions of the plug-in on the same system**

If you have IBM HTTP Server (powered by Apache) instances using previous versions of the plug-in, those instances will continue to run with their existing configurations. However, the first time you update a plug-in configuration using IBM Web Administration for iSeries, the interface automatically updates the instance to use the latest plug-in service program installed on the system. Therefore, in order to maintain configurations based on previous versions of the plug-in service program, you cannot use the IBM Web Administration for iSeries interface to make configuration changes. In addition, any new configurations for Domino 6 or Domino 7 servers will automatically use the new plug-in service program.

To make changes to an existing configuration without upgrading it to the new service program, or to create a new configuration using a previous version of the plug-in service program, you must first remove the PTFs for the latest plug-in service program. After making your changes, re-apply the PTFs for the latest plug-in service program.
Avoiding conflicts between HTTP Server and the Domino HTTP server

The i5/OS operating system includes several TCP/IP application servers, including IBM HTTP Server (powered by Apache). Domino 7 for i5/OS also provides an HTTP server capability, which enables Notes databases to be seen as HTML documents on the Web.

You can have both HTTP servers installed and running. However, the Domino HTTP server and the HTTP server (powered by Apache) are both set up to use TCP/IP port 80 by default. If both HTTP servers are configured to use the same port and IP address, the second server that is started will have a problem accessing the port. To eliminate this problem, do one of the following:

Change the IP address or port for IBM HTTP Server (powered by Apache)

You can change either the IP address or port for the IBM HTTP Server (powered by Apache) using the IBM Web Administration for iSeries interface.

1. If the adminstrative HTTP server on your system is not already running, start it by entering the following command on an i5/OS command line:

   STRTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN)

2. Start the IBM Web Administration for iSeries interface by entering the following into the address bar of a Web browser:

   http://hostname.yourco.com:2001/HTTPAdmin

   where hostname.yourco.com is the fully qualified host name of your system.

3. Click the Manage tab.

4. Click the HTTP Servers subtab.

5. Select your HTTP Server name from the Server list.


7. Click General Server Configuration.

8. Click the General Settings tab in the form.

9. Do one of the following:
   - Select an existing IP address and port from the Server IP address and port to listen on table to modify or delete.
   - Click Add under the Server IP address and ports to listen on table to add a new IP address and port.

10. Click Enabled or Disabled in the FRCA column. Only select Enabled if you are using or will be using FRCA.

11. Click Continue.

12. Click OK.

128 Installing and Managing Domino 7 for i5/OS
Change the IP address or port for the Domino HTTP server
You change the IP address or port number for the Domino HTTP server using the CHGDOMSVR i5/OS command. For more information, see Appendix C "Appendix C Using i5/OS Commands With Domino for i5/OS."

Serving documents from the QSYS.LIB file system
Domino for i5/OS can serve HTML documents from the integrated file system, including the QSYS.LIB file system. When serving HTML files and CGI-BINs that are not Notes databases, be aware of the following:

- You must add the appropriate MAP and PASS directives to the domcfg.nsf database (or to the HTTPD.CNF configuration file in the Domino data directory). The data in the HTTPD.CNF file is ASCII. To edit the file, use the i5/OS command EDTF or copy the file to an ASCII system. Make sure the QNOTES user profile has the authority to read HTTPD.CNF after making changes. Use the i5/OS command Work with Object Links (WRKLNK) to change the authority as follows:
  - Display the contents of the data directory for the server. For example:
    WRKLNK '/NOTES/DATA/*'
  - Enter a 9 (Work with authority) next to the HTTPD.CNF file.
  - Verify that either QNOTES or *PUBLIC has at least read (*R) data authority. If necessary, you can use option 1 or 2 to correct the authority for the file.

- If you serve files from the QSYS.LIB file system, the suffix is either .mbr or .MBR. You must add an AddType directive to the HTTPD.CNF file for the .MBR and .mbr suffix to set the appropriate type. For example, add the following line to the HTTPD.CNF file to allow data in the QSYS.LIB file system to be served as an HTML document:
  AddType .MBR text/html 8bit 1.0 # QSYS file system

- Data served from the QSYS.LIB file system is mapped from the file EBCDIC code page to ASCII.

- In addition to authenticating access to Domino databases, Domino for i5/OS can also authenticate users for access to files in the integrated file system, including QSYS.LIB. You can use the PasswdFile subdirective to indicate how the authentication should be done.
The PasswdFile subdirective can contain either \%\%SYSTEM\%\% or the name of a validation list object. \%\%SYSTEM\%\% is used to indicate all valid i5/OS users. The validation list object is the i5/OS substitute for a password file. You can build a validation list object that contains "Internet" users; that is, names that have an associated password but cannot sign onto the iSeries server. You can build the validation list object using i5/OS APIs. Here are examples of using the PasswdFile subdirective.

To specify that you want to use i5/OS user profiles to validate user names and passwords:

```
PasswdFile \%\%SYSTEM\%
```

To specify that you want validation list object VLDL in library QUSRSYS to be used for a protection mechanism:

```
PasswdFile QUSRSYS/VLDL
```

**Setting up CGI-BIN programs**

There are two ways in which you can define the location in which the server should look for a CGI-BIN program:

- Change the Server document in the Domino Directory to specify the desired directory (location).
- Use the Mapping form in the Domino Configuration database (DOMCFG.NSF) to map the CGI-BIN URL to the desired directory (location) and specify EXECUTE access.

You can also use ILE RPG and ILE COBOL programs as CGI-BIN programs.

**Defining the location of a CGI-BIN program**

The ILE C CGI-BIN program named MYLIB/CGIEXMP is referenced from an HTML document with the following tag:

```
<form method=POST action="/cgi-bin/cgiexmp.pgm">
```

This example assumes that the default CGI-BIN path is /cgi-bin. To have the server pick up the desired CGI-BIN program, use one of the following procedures:

**Change the server document in the Domino Directory**

2. In the HTTP Server section, type in the CGI directory field:

```
/qsys.lib/mylib.lib
```
3. Save the document and restart the Web server.
Change the Domino Configuration database

1. Open the Domino Configuration database (DOMCFG.NSF) and choose **Create**
   -> Mapping URL -> Directory.
2. In the URL path field, type:
   /cgi-bin
3. In the directory field, type:
   /qsys.lib/mylib.lib
4. Click **Execute**.
5. If you are creating a mapping for a virtual server, specify its IP address in the IP
   address field.
6. Save the document and restart the Web server.

Creating SSL key ring files

The Certificate Authority application (CERTCA.NSF) allows you to establish a
Certification Authority (CA) within your organization. As an internal CA, you are
responsible for handling certificate requests from Domino server administrators
within your organization and adding client certificates to the Domino Directory.

Setting up an internal CA simplifies the process of creating and managing
certificates when your users do not need to communicate with external servers or
when external users do not need to access your servers. In addition, setting up an
internal CA allows you to avoid unnecessary fees that external CAs charge to create
and recertify certificates.

The Certificate Authority application allows you to create the CA certificate and key
ring file, sign server certificates, and add client certificates to the Domino Directory.

Before you can use the Certificate Authority application, you must create the
database using the Certificate Authority template (CERTCA.NTF) and enforce
database and server security.

To use the Server Certificate Administration application for your Domino server on
i5/OS, you need to map a network drive to the Domino server's data directory and
specify that drive when creating your key ring and certificate files. To map a
network drive, you must have either of the following on the workstation:

- iSeries Access support
  For more information about iSeries Access, see one of the following:
  - The IBM eServer iSeries Information Center on the Web at:
    http://www.ibm.com/eserver/iseries/infocenter
  - The EZ Setup CD-ROM that is provided with your server

Chapter 16: Using Domino as a Web server  131
• iSeries NetServer support

For more information about iSeries NetServer, see the iSeries NetServer Web site at the following address:

http://www.ibm.com/eserver/iseries/netserver

See the Windows online help for instructions on how to map a network drive.

It is more secure to run the Certificate Authority application from a workstation and keep the certificate authority CA key ring on the workstation. In other words, the Certificate Authority database (CERTCA.NSF) resides on the Domino server (for Web availability) but the CA key ring file resides on the workstation hard disk. For detailed descriptions of how to set up SSL certificates, see the Lotus Domino 7 Release Notes and the Domino administration documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF).

You can also use the following methods to manage your key ring and certificate files:

• Create the key ring files and certificates using Domino on another platform and then use FTP to copy them in binary mode to your Domino data directory on your iSeries server. Make sure the QNOTES user profile has read (*R) authority to the files after you copy them to the data directory.

• Use the HTTP server powered by Apache to create your key ring files and certificates. For more information, see the following Web site:

http://www.ibm.com/eserver/iseries/http
Chapter 17
About directory services and Domino

Domino 7 for i5/OS provides directory services to help you get the most out of your environment, including support for the following:

- Using directory synchronization
- Using a centralized directory architecture
- Using Lightweight Directory Access Protocol

**Note** xSP Hosting is not available with Domino 7 for i5/OS.

Using Directory synchronization

In Domino 6, support for directory synchronization between the OS/400 System Distribution Directory (SDD) and the Domino Directory was removed. If you want to deploy a similar solution in Domino 7, you can set up an LDAP server so that the SDD publishes information to the LDAP server. Then set up your Domino Directory to use the LDAP directory. You can set up a replication schedule to provide a similar solution to the former directory synchronization support.

Using a centralized directory architecture

In a centralized directory architecture, a relatively few number of servers in the domain have replicas of a central directory that contains the entire contents of the Domino Directory. The other servers in the domain have smaller, selective replicas of the central directory, known as configuration directories, that contain only documents used for Domino configuration. A server with a configuration directory looks up user, group, and any customer-defined entries in a central directory. Configuration directories can be beneficial because they require less disk space, less replication, and less view indexing than the primary Domino Directory in the traditional distributed directory architecture.

For information on setting up and using a centralized directory with Domino, see the Domino administration documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF).
Using Lightweight Directory Access Protocol

You can set up Domino to use a new or existing Lightweight Directory Access Protocol (LDAP) directory. The following improvements were made in Domino 6 to better interact with IBM Directory Server:

- Client authentication against IBM Directory Server for all Internet services
- A new schema database simplifies schema extension
- A schema daemon maintains consistency across the entire domain

For information on setting up and using an LDAP directory with Domino, see the Domino administration documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF).

LDAP port conflict

The i5/OS system directory services (LDAP) is always started by default when TCP is started and will bind port 389 to all configured IP addresses. When starting a Domino server that has the directory configured, it will attempt to bind to port 389. A port conflict will result and the following message will be shown:

`LDAP Server: Listener failure: The requested TCP/IP port is in use on this system.`

In order to allow the Domino server's directory task to serve LDAP client requests, the i5/OS administrator must end the system directory services and configure the system to not automatically start the i5/OS directory service.

If the IBM Directory Server on i5/OS is required in addition to running the Domino Directory task, then one of the following steps will be necessary:

- Change the port number used for the Domino server's directory support (in the server document) to another unused IP port.
- End i5/OS system directory services and change the port number used from 389 to another unused IP port and then restart system directory services.

For more information, see the following Web site:

http://www.ibm.com/eserver/iseries/ldap

Changing the default directory port number to a value other than 389 also requires that all LDAP clients configured to connect via port 389 must also be reconfigured to use the new IP port number in order to allow their directory requests to be served via the new port.

If changing the port number is not an option, consider modifying the Domino Directory and the IBM Directory Server on i5/OS directory services to each bind port 389 to a specific IP address.
With V5R2 and later releases, the function to bind the IBM Directory Server on i5/OS to a specific IP address is included.

**Note** During an upgrade from Domino 5.0.x, or during a new server setup, Domino will detect whether or not your environment uses an LDAP server. If your environment does not, Domino will disable the listener port to eliminate this conflict. However, if you later decide you would like to use an LDAP server, you will have to enable the listener port, and follow one of the steps above to eliminate the potential conflict.

---

**xSP Hosting support removed**

Support for xSP Hosting has been removed in Domino 7 for i5/OS. If the CFGDOMSVR or CHGDOMSVR commands specify XSP(*YES), the setting is ignored.
Chapter 18
Managing Backup and Recovery

There are many options available for backup and recovery on i5/OS. You can save and restore objects by using a magnetic tape, optical media, or a save file. You can even take advantage of a networked environment to save and restore objects with another system.

There are also a number of independent products available to help you implement a backup and recovery strategy.

One product that works well with Domino for i5/OS is Backup Recovery and Media Services (BRMS) for iSeries. For more information about BRMS for iSeries, see the section, "Configuring and using BRMS for Domino" later in this chapter.

About backing up a Domino for i5/OS server

A Domino server often contains important business information that may not exist elsewhere in your organization. For example, users may rely on e-mail for important communications that are not documented anywhere else. Similarly, an online customer service application might contain records that do not exist in printed form.

To protect the data from disasters (such as a site loss or hardware loss) and from human error, such as accidentally deleting a critical database, develop a good strategy for regularly backing up the information on your Domino server. Make a plan to back up the following:

- Objects that change infrequently, such as programs for the Domino product.
- Objects that change regularly, such as Domino databases.

"Backing up Domino programs and product files" in this chapter describes options for backing up the relatively static (unchanging) parts of your Domino server. "Backing up all Domino databases" describes the options for backing up the dynamic (changing) parts of your Domino server.

Domino for i5/OS takes advantage of the single-level store architecture. Domino databases and programs are spread across all the disk units, along with other system objects. The i5/OS operating system automatically manages the allocation of disk space so that you do not need to. To back up information on i5/OS, you back up logically (by library or directory), not physically (by disk unit). To plan a backup strategy, you need to understand the logical location of your Domino for i5/OS databases and programs.
For more information, see "Libraries and directories for the Domino for i5/OS product."

**Backup tips**

For information about planning a backup strategy for your server, see the *Backup and Recovery* book (SC41-5304-06). If you are new to i5/OS, also see the descriptions of using the Save menu and using the SAVxxx and RSTxxx commands. This book comes with your i5/OS software. It is also available in the i5/OS supplemental manual library in the IBM eServer iSeries Information Center.

Here is some additional information that might be helpful in planning backup strategies for your Domino for i5/OS servers:

- Options 21, 22, and 23 from the Save menu place the system in a restricted state, which includes stopping all active subsystems with the End Subsystem (ENDSBS) command. The ENDSBS command is not the preferred method for ending Domino servers because it might result in data loss or corruption. Therefore, before you run option 21, 22, or 23 from the Save menu, end all of your Domino servers with the ENDDOMSVR command or by issuing the Quit server command at the Domino console for each server.

- When you run an i5/OS save command with the SAVACT (save while active) option, the system does not save files that are open for write. From a system perspective, any Domino database that is in use is open for write. Therefore, to ensure that you completely save your Domino databases, make sure the databases are not open. Before saving your Domino databases, either end the Domino servers or use the Drop All server command followed by the Dbcache Flush server command.
Libraries and directories for the Domino for iSeries product

System libraries contain programs for the Domino for i5/OS server product, programs that are available for your Domino developers to copy to their workstations, and customization information such as subsystem descriptions. The following table lists the Domino 7 product and user data libraries:

<table>
<thead>
<tr>
<th>Item</th>
<th>OS/400 Library</th>
<th>Path for Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domino for i5/OS product</td>
<td>QDOMINOxxx</td>
<td>/qsys.lib/qdominoxxx.lib</td>
</tr>
<tr>
<td>C API</td>
<td>QNOTESAPI</td>
<td>/qsys.lib/qnotesapi.lib</td>
</tr>
<tr>
<td>Objects common to all multi-version capable releases</td>
<td>QNOTES</td>
<td>/qsys.lib/qnotes.lib</td>
</tr>
<tr>
<td>Customization information (such as subsystem descriptions and job descriptions)</td>
<td>QUSRNOTES</td>
<td>/qsys.lib/qusrnotes.lib</td>
</tr>
</tbody>
</table>

where xxx corresponds to the release of your Domino server.

Directories in the integrated file system contain product information, customization files, and Domino databases. The following table lists the Domino server and user data directories:

<table>
<thead>
<tr>
<th>Item</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release specific product information</td>
<td>/QIBM/ProdData/Lotus/DOMINOxxx</td>
</tr>
<tr>
<td>Common product information (symbolic link to Primary release)</td>
<td>/QIBM/ProdData/Lotus/Notes</td>
</tr>
<tr>
<td>Customization information</td>
<td>/QIBM/UserData/Lotus/Notes</td>
</tr>
<tr>
<td>Directory for databases on the server</td>
<td>Specified when you set up the Domino server (for example, /NOTES/DATA)</td>
</tr>
</tbody>
</table>

where xxx corresponds to the release of your Domino server.

Backing up Domino programs and product files

After you install Domino for i5/OS, including any optional features, you should save a copy of the product offline. You should also save a copy of the product periodically; for example, when you update to a new release or apply fixes. Following are two options for backing up the libraries and directories that contain the relatively static information for your Domino for i5/OS server product.

Note If your server is already running other applications, you probably already use one of these options.

- To back up your entire system, including your Domino programs, product files, and databases, use option 21 (Entire system) from the Save menu. You access the Save menu by typing GO SAVE from an i5/OS command line.
To back up only product libraries and directories that contain information for i5/OS licensed programs, including Domino for i5/OS, use option 22 (System data only) from the Save menu. Option 22 saves the QDOMINOxxx libraries and the /QIBM/ProdData/Lotus/DOMINOxxx directory, where xxx corresponds to the release of Domino (for example, 700 for Domino 7.0).

Back up all Domino databases

Develop a plan to back up all Domino databases, including users' mail databases and system databases, such as the Domino Directory.

When you configure a Domino server, you specify the directory for that server, such as /NOTES/DATA. By default, all the databases for the server are in that path. Your Domino administrators might have the authority to place a Domino database in another path (by using an integrated file system command). Typically, end users cannot create Domino databases in any location except the default path for the server.

If you are responsible for backing up a Domino for i5/OS server, you should develop a backup strategy that matches your policy for where information is stored. Choose one of the following:

Limiting the location of Domino databases

Use a combination of policies and security to keep all Domino databases within the default directory (path) for the Domino server. With this approach, you need to back up only the Domino server's data directory (for example, /NOTES/DATA) and the directory that contains customization information (/QIBM/UserData/Lotus/Notes).

Following is an example of the steps to back up the data directory for your Domino for i5/OS server and the directory with customization information. Substitute the name of your tape device for TAP01 and the name of your Domino server data directory for /NOTES/DATA.

1. Sign on to your system using a user profile that has *JOBCTL and *SAVSYS special authorities.

2. To ensure that you get a complete copy of your server, stop the server before you start the save operation. Use the following command:

   ENDDOMSVR SERVER (SERVERNAME)

   where SERVERNAME is the actual name of your Domino server.

3. To back up the directories, use the following command. Substitute your directory name for /NOTES/DATA.

   SAV DEV('/QSYS.LIB/TAP01.DEVD') OBJ('/NOTES/DATA/*')
   ('/QIBM/UserData/Lotus/Notes/*')

   Note If you already use option 21 or option 23 from the Save menu regularly, you do not need to back up your Domino server separately.
Backing up everything
With this approach, you assume that Domino databases might exist anywhere in the integrated file system (in either the root directory or the /QOpenSys directory). Therefore, you need to back up the entire root directory and /QOpenSys directory. Use any of the following methods:

- Back up your entire system (option 21 from the Save menu).
- Back up all user data (option 23 from the Save menu).
- Use the SAV (Save Object) command to back up everything except the QSYS.LIB file system, the QDLS file system, and directories that contain static program product information. Substitute your tape device name for TAP01.

```
sav dev('/qsys.lib/tap01.devd') obj('/**') ('qsys.lib' *omit) ('/qdl.s.lib' omit) ('/QIBM/ProdData' *omit) ('QOpenSys/QIBM/ProdData' *omit)) updhist(*yes)
```

Note When you use option 21 or 23 from the Save menu, the system automatically stops all activity (goes to a restricted state). When you use commands (instead of the Save menu) to back up your server information, you must stop the server before you back up. This ensures that the databases are in a known state for the backup operation. You can use the End Domino Server (ENDDOMSVR) command to stop the server.

Backing up mail databases
This topic describes specifically how to back up mail from your Domino for i5/OS server. If you already have a strategy for backing up all the user information from your Domino server, you probably do not need a separate procedure for backing up only mail. However, you might discover that your backup interval for your entire server is not frequent enough for e-mail because mail is so volatile.

Your Domino server stores mail in multiple databases:

- The MAIL.BOX database on each server contains mail for the server to route to individual user mailboxes or to another server.
- Each Lotus Notes user has an individual mail database. The name of the mail database is typically the user's ID with the NSF extension. (The Domino administrator has the option to use different names for mail databases.) For example, the mail database for user GNELSON is GNELSON.NSF. Typically, all the individual mail databases are in a dedicated subdirectory, such as /NOTES/DATA/MAIL.
To back up mail, do the following:

1. Sign on to your system using a user profile that has *JOBCTL and *SAVSYS special authorities.

2. From a command line, use the following command to stop the Domino server:

   ```
   enddomsvr server(servername)
   ```

   where `servername` is the actual name of your Domino server.

   To back up a database, the system must be able to lock the database so that no changes occur during the backup operation. To successfully back up Domino mail, you will need to stop the Domino server that contains the mail databases.

3. Mount the appropriate backup tape in the tape device.

4. Use the Save Object (SAV) command to back up the mail databases. Following is an example. Substitute your server directory name for /NOTES/DATA. Substitute your tape device name for TAP01.

   ```
   sav dev('/qsys.lib/tap01.devd')
   obj('/notes/data/mail/*.nsf')
   ```

**Examples: Backing up mail from your Domino server**

Following are examples of using the Save Object (SAV) command to back up mail from your Domino server. Substitute your server directory name for /NOTES/DATA. Substitute your tape device name for TAP01.

- To back up a specific database, such as the MAIL.BOX database, use the following command:

  ```
  SAV DEV('/QSYS.LIB/TAP01.DEVD') OBJ('/NOTES/DATA/MAIL.BOX')
  ```

- To back up all the files of a specific type in the MAIL subdirectory, use the following command:

  ```
  SAV DEV('/QSYS.LIB/TAP01.DEVD')
  OBJ('/NOTES/DATA/MAIL/*.NSF')
  ```

- To back up a specific user's mail database, such as GNELSON's mail database, use the following command:

  ```
  SAV DEV('/QSYS.LIB/TAP01.DEVD')
  OBJ('/NOTES/DATA/MAIL/GNELSON.NSF')
  ```

**Notes about the examples:**

1. To back up a database, the system must be able to lock the database so that no changes occur during the backup operation. To successfully back up Notes mail, do one of the following before you use the SAV command:

   - Stop the Domino server that contains the mail databases. (Use the ENDDOMSVR (End Domino Server) command to stop the server.)
• Stop activity on the databases file by using drop all and dbcache flush. However, with this method, any attempted mail delivery during the backup operation results in the mail being returned to the user with a message that the server is busy/in use.

2. To reduce the downtime of your server during backups, use clustered servers. Domino for i5/OS can support clustered servers on the same system.

Backing up specific databases

You might want to back up a specific Domino database to tape for several reasons. For example:

• To create a backup copy before you make programming changes or test a new agent.
• To create an archive copy at the end of an accounting period.

To back up a specific database or group of databases from your Domino server, do the following:

1. Sign onto your system using a user profile that has *JOBCTL and *SAVSYS special authorities.
2. Ensure that no one is using the database. You want a copy at a known point when no changes are occurring to the database.
3. Mount a tape for the backup operation.
4. Use the SAV (Save Object) command for the database. For example, to back up a database called CUSTINF.NSF in the /NOTES/DATA directory, use the following command. Substitute your tape device name for TAP01:

```
sav dev('/qsys.lib/tap01.devd')
obj('/notes/data/custinf.nsf')
```

Examples: Backing up a specific Domino database

Following are examples for using the Save Object (SAV) command to back up specific Domino databases to tape. Substitute your server directory name for /NOTES/DATA. Substitute your tape device name for TAP01.

• To back up all the Domino databases in the DEPT57 subdirectory (folder), use the following command:

```
SAV DEV('/QSYS.LIB/TAP01.DEVD')
OBJ('/NOTES/DATA/DEPT57/*.NSF')
```

• To back up the HRINFO database from the HRDPT directory, use the following command:

```
SAV DEV('/QSYS.LIB/TAP01.DEVD')
OBJ('/NOTES/DATA/HRDPT/HRINFO.NSF')
```
• To back up all the HR files (not in a specific subdirectory), use the following command:

```
SAV DEV('/QSYS.LIB/TAP01.DEVD') OBJ('/NOTES/DATA/HR*.NSF')
```

Notes about the examples

1. To back up a database, the system must be able to lock the database so that no changes occur during the backup operation. Either make sure that no one has the database open or stop the server for the backup operation.

2. To reduce the downtime of your server during backups, use clustered servers. Domino for i5/OS can support clustered servers on the same system.

Backing up changed objects from your Domino for i5/OS server

i5/OS provides the capability to back up only objects that have changed either since a specific date and time or since the last backup operation. This type of backup capability is sometimes called an incremental backup. You might find a combination of complete backup and incremental backup particularly useful if your Domino server has many databases that do not change very often.

Strategies for incremental backup

Following are the two most common strategies for incremental backups:

• Backing up changes since last full backup. With this strategy, you back up everything that has changed since you last backed up all the databases from your Domino server. For example, assume that you back up your entire server on Saturday night. On Sunday night, you would back up everything that has changed since Saturday night. On Monday night, you would back up everything that has changed since Saturday night. On Tuesday night, you would back up everything that has changed since Saturday night, and so on.

The advantage to this strategy is that it makes recovery simple. When you need to recover, you need to use only your tapes from your full backup and your tapes from your most recent incremental backup. The disadvantage to this strategy is that your backups grow larger (both in media usage and duration) each day until your next complete backup.

• Backing up changes since the last incremental backup. With this strategy, you back up only objects that have changed since the most recent backup. For example, assume that you back up your entire server on Saturday night. On Sunday night, you would back up everything that has changed since Saturday night. On Monday night, you back up everything that has changed since Sunday night. On Tuesday night, you back up everything that has changed since Monday night, and so on.

The advantage to this strategy is that the size of your incremental backup is smaller (both in media usage and duration). The disadvantage is that recovery is more complex. When you need to recover, you need to use your tapes from your full backup and your tapes from each incremental backup.

144  Installing and Managing Domino 7 for i5/OS
Examples: Backing up changed objects from your Domino server
Following are examples for backing up changed objects from your Domino server. Substitute your server directory name for /NOTES/DATA. Substitute your tape device name for TAP01.

Backing up all changes (since previous full backup)
To perform a nightly incremental backup of all changes that have occurred since that last full backup, do the following:

1. On Saturday evening, perform a complete backup (for example, by using option 23 from the Save menu). Make sure that you specify UPDHST(*YES) on the SAV command so that the system updates the object information with the time and day of the most recent backup.

2. On Sunday evening, use the following command:
   ```
   sav dev('/qsys.lib/tap01.devd') obj('/notes/data/*.*')
   chgperiod(*lastsave) updhst(*yes)
   ```

3. On Monday evening, use the following command:
   ```
   sav dev('/qsys.lib/tap01.devd') obj('/notes/data/*.*')
   chgperiod(*lastsave) updhst(*yes)
   ```

   Continue using the same command every night until your next full backup.

Backing up one day's changes
To perform a nightly incremental backup of what has changed since the previous incremental backup, you need to adjust the CHGPERIOD parameter each night. Following is an example:

1. On Saturday evening at 8 PM, perform a complete backup (for example, by using option 23 from the Save menu). Make sure that you specify UPDHST(*YES) on the SAV command so that the system updates the object information with the time and day of the most recent backup.

2. On Sunday evening, November 9 at 10 PM, use the following command:
   ```
   sav dev('/qsys.lib/tap01.devd') obj('/notes/data/*.*')
   chgperiod('11/08/97' 200000) updhst(*yes)
   ```

3. On Monday evening, November 10 at 9 PM, use the following command:
   ```
   sav dev('/qsys.lib/tap01.devd') obj('/notes/data/*.*')
   chgperiod('11/09/97' 220000) updhst(*yes)
   ```

4. On Tuesday evening, November 11 at 8 PM, use the following command:
   ```
   sav dev('/qsys.lib/tap01.devd') obj('/notes/data/*.*')
   chgperiod('11/10/97' 210000) updhst(*yes)
   ```

5. Each evening, run the SAV command. Alter the Change Period parameter to the time and date of the previous backup.
Notes about the examples

- To back up a database, the system must be able to lock the database so that no changes occur during the backup operation. To successfully back up Domino databases, you must either ensure that no one is using the databases or stop the Domino server that contains the databases. (Use the ENDDOMSVR (End Domino Server) command to stop the server.)

- To reduce the downtime of your server during backups, use clustered servers. Domino for i5/OS can support clustered servers on the same system.

Recovery of Domino for i5/OS

Domino for i5/OS programs and product files reside in libraries in the QSYS.LIB file system on your iSeries server. Domino databases reside in the integrated file system in a directory path that you specify when you configure your server. Your backup strategy for Domino for i5/OS should include backing up both the libraries (infrequently) and the database directories (frequently).

You might need to recover Domino for a variety of reasons, for example:

- Damage to your server, such as fire or flooding
- Hardware problems, such as a disk failure
  
  **Note**  i5/OS provides disk protection options (mirrored protection and device parity protection) both to increase availability and to ensure that disk failures do not cause loss of data. You can find out more about disk protection in the *Backup and Recovery* book (SC41-5304-06).

- User or operator error, such as deleting a database or running a month-end procedure twice

Sometimes, you must recover your entire server. At other times, you must recover a specific directory. The following topics provide general information about recovery steps for Domino for i5/OS:

- Recovering an entire Domino server
- Recovering Domino mail
- Recovering Domino databases
- Restoring changed objects to a Domino server

For complete procedures and considerations, see the *Backup and Recovery* book (SC41-5304-06) and the Domino documentation.
Recovering an entire Domino for i5/OS server

If you are faced with a system disaster, such as a site loss or the failure of an unprotected disk unit, you must recover (restore) your entire system from a backup. Because the IBM eServer i5 server is a highly integrated system, you must recover objects in the correct sequence to rebuild the proper links between objects. The Backup and Recovery book (SC41-5304-06) provides complete instructions for performing a full system recovery.

If you are faced with a problem that requires recovering only your Domino for i5/OS server, not your entire system, you can use the Restore Object (RST) command to recover your Domino directories from tape. Following is an example of the steps:

1. Sign onto your system using a user profile that has *SAVSYS and *JOBCTL special authority.
2. To make sure that no one is using the server that you plan to recover, stop the server. Use the End Domino Server (ENDDOMSVR) command.
3. Mount the tape that has the most recent backup copy of the directories for the server.
4. Use the appropriate restore (RST) command for your Domino directory. For example, if your Domino directory is /NOTES/DATA and your tape device is TAP01, use the following command:

   \[ \text{RST DEV('QSYS.LIB/TAP01.DEVD') OBJ('/NOTES/DATA/*')} \]

   This process restores the physical contents of the data directory for your server to your system disk storage. Consult the Domino documentation for any special recovery activities that you might need to perform after you have restored the directories.

Recovering Domino Directories

If possible, you should recover both the Domino Directory and the i5/OS system distribution directory from backup tapes that were created at the same time.

To recover the i5/OS system distribution directory, use the following restore command:

\[ \text{RSTOBJ OBJ(QAOK*) SAVLIB(QUSRSYS) OBJTYPE(*FILE) DEV(TAP01)} \]

Recovering Domino mail

If you need to recover one or more mail databases from your backup tapes, use the Restore Object (RST) command. Following is an example of the steps:

1. Sign onto your system with a user profile that has *SAVSYS and *JOBCTL special authority.
2. Stop the server that contains the mail databases that you want to recover; for example, use the End Domino Server (ENDDOMSVR) command.
3. Mount the tape that has the most recent backup of the mail databases.

4. Use the appropriate Restore Object (RST) command for the mail databases that you want to recover. For example, to recover all the databases to the MAIL subdirectory from device TAP01, use the following command:

```
RST DEV('/QSYS.LIB/TAP01.DEVD') OBJ('NOTES/DATA/MAIL/*')
```

**Examples: Recovering Domino mail**

The name of a user's mail database is usually the user's ID (short name) with the .NSF extension. (The Domino administrator has the option to use different names for mail database files.)

- To recover a specific user's mail database, such as the mail database for user GNELSON, use the RST command and specify the database name:

  ```
  RST DEV('/qsys.lib/tap01.devd')
  OBJ('/notes/data/mail/gnelson.nsf')
  ```

- You can specify more than one file on the RST command. To recover mail databases for GNELSON, LSMITH, and JPETERS, use the following command:

  ```
  RST DEV('/qsys.lib/tap01.devd')
  OBJ('/notes/data/mail/gnelson.nsf')
  '/notes/data/mail/lsmith.nsf' '/notes/data/mail/jpeters.nsf')
  ```

**Notes about the examples**

- You cannot restore over a database that is in use. All users must close the database before you can restore a backup copy.
- All of the examples assume that the directory for your Domino server is /NOTES/DATA.
- Substitute the name of your i5/OS tape device for TAP01.

**Recovering Domino databases**

You might need to recover a specific Domino database or a group of databases. Use the Restore Object (RST) command. Following is an example of the steps for recovering all the files to the HRDPT subdirectory:

1. Sign on to your system using a user profile that has *SAVSYS and *JOBCTL special authority.

2. Stop the server that contains the databases that you want to recover. Use the End Domino Server (ENDDOMSVR) command. (You can restore a database when the server is running. However, you need to make sure that no one is using the database. Stopping the server is the best way to ensure that no one is using the database.)

3. Mount the tape that has the most recent backup of the databases.
4. Use the appropriate Restore Object (RST) command for the mail files that you want to recover. For example, to recover all the files to the HRDPT subdirectory from device TAP01, use the following command:

```plaintext
RST DEV('/QSYS.LIB/TAP01.DEVD')
OBJ('/NOTES/DATA/HRDPT/*.NSF')
```

**Examples: Recovering Domino databases**

In the examples, substitute your server directory for /NOTES/DATA. Substitute your tape device name for TAP01.

- To recover a specific database named HRINFO to the HRDPT subdirectory (folder), use the following:

  ```plaintext
  rst dev('/qsys.lib/tap01.devd')
  obj('/notes/data/hrdpt/hrinfo.nsf')
  ```

- To recover all the Domino databases to the CUSTSVC subdirectory, use the following:

  ```plaintext
  rst dev('/qsys.lib/tap01.devd')
  obj('/notes/data/custsvc/*.nsf')
  ```

- To recover all the Domino databases that have names beginning with INV to the main directory for your server, use the following:

  ```plaintext
  rst dev('/qsys.lib/tap01.devd') obj('/notes/data/inv*.nsf')
  ```

**Note** You cannot restore over a database that is in use. All users must close the database before you can restore a backup copy. The best way to ensure that databases are not in use is to stop the server.

**Recovering changed objects to a Domino server**

To reduce the length of your backup window, your backup strategy might include backing up only changed objects from your Domino server during the business week. When you need to use these backup tapes to recover, you must decide on your recovery sequence and determine the location of the most recent copy of each database.

**Examples: Recovering changed objects to a Domino server**

Following are examples of different recovery scenarios and an overview of the recovery steps for each. Substitute your server data directory for /NOTES/DATA. Substitute your tape device name for TAP01.

**Recovering all changed Domino objects from a cumulative backup**

Assume that your strategy for backing up changed objects is cumulative (each night you back up everything that changed since the last complete backup). To recover your entire Domino data directory, do the following:

1. Sign on to your system using a user profile that has *JOBCTL and *SAVSYS special authorities.
2. To ensure that no one is using the databases, stop the Domino server; for example, use the End Domino Server (ENDDOMSVR) command.

3. Locate the tapes from your most recent complete backup. Mount the correct tape in the tape unit.

4. To recover the entire Domino data directory, use the Restore Object (RST) command. For example,
   \[ \text{rst dev(''/qsys.lib/tap01.devd'') obj(''/notes/data/*'')} \]
   Substitute your Domino data directory for /NOTES/DATA and your tape device name for TAP01.

5. Locate and mount your most recent backup tapes (from backing up changed objects).

6. To recover all the changed objects on the tape (everything that has changed since your full backup), use the following command:
   \[ \text{rst dev(''/qsys.lib/tap01.devd'') obj(''/notes/data/*'')} \]
   Substitute your Domino data directory for /NOTES/DATA and your tape device name for TAP01.

**Recovering all changed Domino objects from a nightly backup**

Assume that your strategy for backing up changed objects is nightly (each night you back up only objects that have changed since the previous night). To recover your entire Domino data directory, do the following:

1. Sign on to your system using a user profile that has *JOBCTL and *SAVSYS special authorities.

2. To ensure that no one is using the databases, stop the Domino server; for example, use the End Domino Server (ENDDOMSVR) command.

3. Locate the tapes from your most recent complete backup. Mount the correct tape in the tape unit.

4. To recover the entire Domino data directory, use the Restore Object (RST) command. For example,
   \[ \text{rst dev(''/qsys.lib/tap01.devd'') obj(''/notes/data/*'')} \]
   Substitute your Domino data directory for /NOTES/DATA and your tape device name for TAP01.

5. Locate and mount your first backup tapes (from backing up changed objects). For example, if you back up everything on Saturday night, locate your backup tapes from Sunday night.
6. To recover all the changed objects on the tape (everything that has changed since the previous night), use the following command:

   \texttt{rst dev('/qsys.lib/tap01.devd') obj('/notes/data/*')} \\
   Substitute your Domino data directory for /NOTES/DATA and your tape device name for TAP01.

7. Repeat steps 5 and 6 for each nightly backup tape until your directory is current. For example, if you are recovering on Thursday, you need to use the tapes for Monday, Tuesday, and Wednesday nights.

**Recovering a specific Domino database from an incremental backup**

To recover a specific database named HRINFO to the HRDPT subdirectory (folder), do the following:

1. Sign on to your system using a user profile that has *JOBCTL and *SAVSYS special authorities.

2. To ensure that no one is using the databases, stop the Domino server; for example, use the End Domino Server (ENDDOMSVR) command.

3. Locate the most recent tape that has the database. Do one of the following:
   - Consult the log that the system creates during the save operation.
   - Use the Display Tape (DSPTAP) command to display the contents of the tape.

4. Mount the tape in the tape unit.

5. To recover the database, use the following command:

   \texttt{rst dev('/qsys.lib/tap01.devd')} \\
   \texttt{obj('/notes/data/hrdpt/hrinfo.nsf')} \\
   Substitute your tape device name for TAP01.

**Recovering changed objects to a specific Domino subdirectory**

To recover all the Domino databases to the CUSTSVC subdirectory, use the same approach that you use to recover the entire server. Do the following:

1. Sign onto your system using a user profile that has *JOBCTL and *SAVSYS special authorities.

2. To ensure that no one is using the databases, stop the Domino server; for example, use the End Domino Server (ENDDOMSVR) command.

3. Locate the tapes from your most recent complete backup. Mount the correct tape in the tape unit.

4. To recover the entire directory from the tapes from your last full backup, use the RST (Restore Object) command. For example, to recover objects in the CUSTSVC subdirectory from the TAP01 device, use the following command:

   \texttt{rst dev('/qsys.lib/tap01.devd')} \\
   \texttt{obj('/notes/data/custsvc/*')}
5. If your incremental backup tapes are cumulative, mount your most recent incremental backup tape. Use the same restore command (step 4) to recover the changes.

Otherwise, if your backup tapes are nightly, repeat this step for each incremental backup tape. Start with the oldest tape and work forward, using the RST command from step 4.

About user-defined file systems and availability

Normally, all disk units attached to a system are treated as a single logical disk unit. The operating system places data across the disk units to optimize performance and disk utilization. However, an i5/OS administrator has the option to create logical groupings of disk units, called auxiliary storage pools or ASPs. Auxiliary storage pools provide several possible benefits, for example:

- ASPs provide the option for different strategies for backup and disk protection. For example, you might have large history databases that do not change very often. By segregating them in a separate ASP, you can easily set up a less frequent backup schedule. You might also choose not to use RAID5 disk units for this ASP if availability of the information is not time-critical.

- ASPs provide the option to isolate database journals from the databases both for protection from data loss and for performance.

If you want to place your Domino data directory in a user ASP, you need to create a user-defined file system (UDFS) to map the integrated file system directory to the correct ASP.

You can read more about ASPs and creating user-defined file systems in the Backup and Recovery book (SC41-5304-06).

Configuring and using BRMS for Domino

BRMS is an IBM i5/OS licensed program that is designed to help with your backup and recovery efforts. Domino for i5/OS allows the configuration of a basic set of defaults for use with BRMS, enabling you to back up databases for your Domino server while the server is active. To use these functions, you must install the following on your system:

- i5/OS V5R3 (5722SS1) or later
- Backup Recovery and Media Services (5722BR1) or later
- The latest PTFs available for your BRMS release
Note  Backing up your Domino server databases should not replace your occasional complete system backups. For instructions on doing a complete system backup through BRMS, see the iSeries BRMS documentation, available through the Information Center at the following Web address:

http://www.ibm.com/eserver/iseries/infocenter

To use BRMS to perform an online backup of your Domino database, you should understand the following concepts:

- **Media** - Removable storage, such as a tape cartridge.
- **Media identifier** - A name given to a physical piece of media.
- **Media class** - A logical grouping of media with similar physical or logical characteristics, such as density.
- **Control group** - A grouping of items (such as libraries or stream files) to back up and attributes associated with how to back them up.
- **Policies** - A set of defaults that are commonly used (such as device and media class). The BRMS system policy contains general use defaults. The BRMS backup policy contains defaults related to backups.

Before you can back up Domino for i5/OS, you need to create the BRMS components to enable you to back up your Domino databases while the server is active and to exclude Domino databases from other system backups. For more information, see "Configuring BRMS integration components" later in this chapter.

**Performing an online backup of Domino databases**

Using BRMS to perform an online backup of your Domino databases involves the following steps:

1. Determine the device and media class to use.
2. Add media to the media class scratch pool.
3. Start the backup.

**Backing up database indexes**

When you back up a Domino database via BRMS (using the SAVDOMBRM command), its index is not saved. If you want to back up the database index files, you need to save them using the method that you use to back up other files in the i5/OS integrated file system, such as the SAV command. If you save both the database and index files at the same time and restore them both at the same time, the index should be up to date with the database. However, if a database with an index is restored to a previous version of the database and the index is not restored, the index may have inaccurate links. To ensure that indexed databases are accurate after a restore, rebuild the index.
Excluding Domino databases from your online backup
You may want to exclude Domino databases from your online backup. For example, you may not need to back up the Domino help databases (such as HELP.NSF). You can exclude Domino databases from your online backup by changing the control group for the Domino server to omit the databases by name.

Excluding Domino databases from other system backups
In addition to backing up your Domino databases, you should also use BRMS to back up the rest of your system so that you can recover all of your data through BRMS. To allow your Domino databases to be used while you back up the rest of your system, you should exclude the Domino databases from the backup. To do this, you'll need to change your backup control group to use the QDOMEXCL link list.

Recovering your Domino data
After a successful backup, BRMS will help you plan for a complete recovery of your system by allowing you to print a complete disaster recovery plan. To enable recovery of all your data, use BRMS to back up the rest of your system in addition to your Domino server databases. See the iSeries BRMS documentation for more information on performing a complete backup and recovery of your system.

To recover Domino databases, you can perform one of following types of recovery:

- Recover your entire system. Refer to the BRMS documentation for the steps to recover your entire system.
- Recover all databases for all of your Domino servers.
- Recover all databases for a specific Domino server.
- Recover a single database.

Performance Considerations
Because of performance limitations of the tape media devices, Domino databases are packaged and saved in groups. By default, five databases are put in backup mode and are then saved. The changes that occurred to all five databases while being backed up are also saved along with the databases. The number of files in the group (the default is five) can be configured to optimize backup and recovery time for your Domino server.

Configuring BRMS integration components
To enable the BRMS integration feature for a server, the following components need to be created to enable backup using BRMS:

- A control group for performing an online backup of the databases for a Domino server.
- A BRMS link list to exclude Domino databases when backing up i5/OS directories.
A control group for performing an online backup of the databases for all Domino servers. This control group is optional and is not needed if you have only one Domino server on your system.

The following are example procedures for each situation.

**Control group for online backup of databases for a Domino server**

This control group will be defined to perform an online backup of all databases for a specific Domino server. You can use any name for the control group. However, we recommend that you use the name of the i5/OS subsystem in which the Domino server runs. You can determine the subsystem name by entering the following i5/OS command:

```
WRKDOMSVR
```

In the following procedure, we represent the control group name by `dominox`. Substitute the actual server subsystem name for `dominox`.

1. Enter the following i5/OS command:
   ```
   GO BRMS
   ```
2. Type a 2 at the command prompt and press Enter to select Backup.
3. On the Backup display, type a 1 and press Enter.
4. On the Backup Planning display, type a 2 and press Enter.
5. On the Work with Backup Control Groups display, type a 1 in the Opt column to create a control group.
6. Type dominox in the Control Group column and press Enter.
7. On the resulting display, enter the following sets of Seq values:
   - Type 10 in the Seq column, *exit in the Backup Items column, and *dftact in the Weekly Activity SMTWTFS column. Press Enter.
   - Type 20 in the Seq column, *exit in the Backup Items column, and *dftact in the Weekly Activity SMTWTFS column. Press Enter.
   - Type 30 in the Seq column, *exit in the Backup Items column, and *dftact in the Weekly Activity SMTWTFS column. Press Enter.
8. Position the cursor to the Seq 20 entry and press F10.
10. In the Server name field, type the name of your Domino server; for example, domserv1.
11. In the Control Group field, type the name that you specified in step 6; for example, dominox.
12. If desired, position the cursor to the Files to omit field and specify the location of objects that you want to omit (databases you do not want saved). You must specify the location of the objects as the directory path relative to the server data directory. For example, if you want to omit the file named mydb.nsf that is located in the server data directory /notes/data, type mydb.nsf in the Files to omit field, not /notes/data/mydb.nsf. You can use the wildcard character (*) in the object name.

13. Press Enter twice.


15. Select option 1 and press Enter to save and exit the session.

16. Press F3 four times.

**BRMS link list to exclude Domino databases**

Because Domino databases are backed up using other control groups created by the BRMS integration feature, they should be excluded from backups of the rest of the i5/OS integrated file system. This will allow your Domino server to remain active while the rest of the file system is backed up. You can define the QDOMEXCL link list to allow exclusion of Domino databases from backups of the rest of the file system. To create the QDOMEXCL link list, follow these steps:

1. Type the following i5/OS command and press Enter:
   
   ```
   GO BRMS
   ```

2. Type a 2 at the command prompt and press Enter to select Backup.

3. On the Backup display, type a 1 and press Enter.

4. On the Backup Planning display, type a 5 and press Enter.

5. On the Work with Backup Lists display, type a 1 in the Opt column to add a Backup list, QDOMEXCL in the List Name column, *BKU in the Use column, and *LNK in the Type column.

6. Press Enter.

7. Type a text description, such as "All integrated file system objects except Domino server databases" and press Enter.

8. Type a 2 next to the QDOMEXCL list name and press Enter.

9. Use sets of the Name field and Include or omit field to define the system objects in the list. For example:
   
   - Include all of the i5/OS integrated file system. Type '/*' in one of the Name fields and type *INCLUDE in the associated Include or omit field.
   
   - Omit the QSYS.LIB file system. Type '/QSYS.LIB' in a Name field and type *OMIT in the associated Include or omit field.
   
   - Omit the QDLS file system. Type '/QDLS' in a Name field and type *OMIT in the associated Include or omit field.
• Omit all of the file extensions for Domino databases (*.nt* and *.ns*). Use fully qualified path names to specify the location of these databases. For example, if you want to omit the *.ns* databases that are located in the server data directory at /notes/data, type `/notes/data/*.ns*` in the Name field.

You can now use this list in a control group instead of the *LINK special value. In BRMS, *LINK means all objects in the i5/OS integrated file system. If you are doing an online backup of Domino databases, you do not need to include them in a backup of the entire integrated file system. However, you should do a full system backup each week. This means using the *LINK value to include the entire integrated file system.

**Control group for online backup of databases for all Domino servers (optional)**

This control group will be defined to perform an online backup of all databases for all Domino servers. For the control group name, we use *qd Domino*. You can use a different name.

1. Enter the following i5/OS command:
   ```i5/OS
   go brms
   ```
2. Type a 2 at the command prompt and press Enter to select Backup.
3. On the Backup display, type a 1 and press Enter.
4. On the Backup Planning display, type a 2 and press Enter.
5. On the Work with Control Groups display, type a 1 in the Opt column and type *qd Domino* in the Control Group column.
6. Press Enter.
7. On the resulting display, enter the following sets of Seq values:
   - Type 10 in the Seq column, *exit in the Backup Items column, and *dftact in the Weekly Activity SMTWTFS column. Press Enter.
   - Type 20 in the Seq column, *exit in the Backup Items column, and *dftact in the Weekly Activity SMTWTFS column. Press Enter. This Seq entry will represent the first Domino server that you want to back up.
   - Type 30 in the Seq column, *exit in the Backup Items column, and *dftact in the Weekly Activity SMTWTFS column. Press Enter. This Seq entry will represent the second Domino server that you want to back up.
   - Add additional Seq entries until you have one entry for each Domino server that you want to back up. Type xx in the Seq column, where xx is a number such as 40 or 50. Like the previous Seq entries, type *exit in the Backup Items column and *dftact in the Weekly Activity SMTWTFS column. Press Enter after typing in the values for each Seq entry.
8. Position the cursor to the Seq 20 entry and press F10.
10. In the Server name field, type the name of your Domino server; for example, domserv1.

11. In the Control Group field, type the control group name you specified in step 5; for example, qdomino.

12. If desired, position the cursor on the Files to omit field and specify the location of objects that you want to omit (databases you do not want saved). You must specify the location of the objects as the directory path relative to the server data directory. For example, if you want to omit the file named mydb.nsf that is located in the server data directory at /server1/data, type mydb.nsf in the Files to omit field, not /server1/data/mydb.nsf. You can use the wildcard character (*) in the object name.

13. Press Enter twice.

14. Repeat steps 8 through 11 for each Seq entry that represents a Domino server that you want to back up. Specify the appropriate Domino server name and the control group name from step 5. Also specify any objects to omit.

15. Add a final Seq entry that has *exit in the Backup Items column and *dftact in the Weekly Activity SMTWTF column, but does not invoke the SAVDOMBRM command. That is, for this final Seq entry, skip steps 8 though 11.


17. Select option 1 and press Enter to save and exit the session.

18. Press F3 four times.

---

**Incremental online backup**

BRMS has been enhanced to include incremental save and restore of Domino server files. This allows file changes since the previous backup or restore to be managed.

---

**Determining the device and media class to use**

During the installation process, BRMS chooses a default device based on the fastest and most automated tape drive attached to your system.

BRMS also creates media classes based upon the devices attached to your system. For example, if you have a 6380 tape device attached to your system, media classes such as QIC2GB would be created (6380 uses a media format called *QIC2GB).
To review the system policy and to determine the default device and media class, follow these steps:

1. Enter the following i5/OS command:
   ```
go brms
   ```
2. Type an 11 at the command prompt and press Enter.
3. On the Policy Administration display, type a 1 and press Enter.
4. On the System Policy display, type a 1 and press Enter.
5. On the Change System Policy display, look at the values in the Devices and Media class fields. To use a different device or media class, see the instructions in the iSeries BRMS documentation.
6. Press F3 four times.

---

**Adding media to the media class scratch pool**

Adding media to a BRMS media class allows BRMS to use, track, and protect active data on the media. You should add pre-initialized media to BRMS by using the steps outlined in this section. Once media is added to a media class of available media, BRMS will drive backup operations and use this media, requesting you to load tapes as necessary.

**Note** If your media is not pre-initialized, see the BRMS documentation for details on how to add existing media content information into the BRMS catalog of information.

It is important to have sufficient media enrolled in the media class before performing a backup operation. It is recommended that you enroll at least three pieces of media, for example three tapes. In determining the number of media to add, you should consider the capacity of your media and the size of your Domino server data.

To add media, use one of the following methods based on the type of device you have:

A tape library device is an enclosed unit with many pieces of media that allows for random access to any piece of media. If you will be backing up using a tape library device, perform the following steps:

1. Make sure that your media is in the automated tape library.
2. Enter the following i5/OS command:
   ```
go brms
   ```
3. Type a 1 at the command prompt and press Enter.
4. On the Media Management display, type a 9 and press Enter.
5. On the Work with Media Libraries display, type an 8 and press Enter three times to work with the current inventory of the automated tape library.
6. Type a 1 next to the media to be added and press Enter.
7. Type the media class you recorded when you determined the device and media class from the system policy. See "Determining the device and media class to use" earlier in this chapter.
8. Press Enter twice.
9. Repeat steps 6 through 8 until you have enrolled the recommended number of media.
10. Press F3 three times.

Tip You can also use the Add Media Library Media to BRMS (ADDMLMBRM) command to perform this operation.

If you are not using a tape library device, you are backing up to a stand-alone device. Therefore, perform the following steps:
1. Enter the following i5/OS command:
   ```
   go brms
   ```
2. Type a 1 at the command prompt and press Enter.
3. On the Media Management display, type a 2 and press Enter twice to work with the BRMS media inventory.
4. On the Work With Media display, type a 1 in the Opt column and press Enter.
5. Type the volume identifier from the media label and the media class that you recorded from the system policy. See "Determining the device and media class to use" earlier in this chapter.
6. Press Enter twice.
7. Repeat steps 4 through 6 until you have enrolled the recommended number of media.
8. Press F3 four times.

Tip You can also use the Add Media to BRMS (ADDMEDBRM) command to perform this operation.

---

Excluding databases from your online backup

The section, "Configuring BRMS Integration components," described how to create a control group for your Domino for i5/OS server. This control group can be used to back up all the Domino databases in the data directory for your Domino server on your system. You can exclude databases from these backups by changing the control group entries. To change your control group entries, perform the following steps:

1. Enter the following i5/OS command:
   ```
   go brms
   ```
2. Type a 2 at the command prompt and press Enter.
3. On the Backup display, type a 1.
5. Position the cursor in the Opt column next to the control group you want to change. To change the control group that is used to back up all your Domino servers, position the cursor next to the QDOMINO entry.
6. Type a 2 and press Enter to edit the entries.
7. Press F11.
8. Position the cursor on the line where the value for Exit command column starts with SAVDOMBRM and the value in the SERVER parameter is the same as your Domino server name.
11. Position the cursor to the Files to omit field and specify the location of objects that you want to omit (databases you do not want saved). You must specify the location of the objects as the directory path relative to the server data directory. For example, if you want to omit the file named mydb.nsf that is located in the server data directory at /notes/data, type mydb.nsf in the Files to omit field, not /notes/data/mydb.nsf. You can use the wildcard character (*) in the object name.
12. Press Enter twice.
14. Press Enter.
15. Press F3 four times.

Excluding databases from your system backup

The QDOMEXCL link list is designed to allow backup of the integrated file system excluding Domino databases. If you use the QDOMEXCL link list during your backup processing, your Domino databases will continue to be accessible while a backup of the rest of the integrated file system is being performed. To create a new control group that uses QDOMEXCL based on an existing control group, perform the following steps:

1. Enter the following i5/OS command and press Enter:
   
   GO BRMS

2. Type a 2 at the command prompt and press Enter.
3. On the Backup display, type a 1.
5. Position the cursor in the Opt column next to the control group you want to use as the basis for the new control group.

6. Type a 3 and press Enter.

7. Type a name for the new control group and press Enter.

8. Position the cursor next to the newly created control group, type a 2, and press Enter.

9. Note the sequence number value for the Backup Item listed as *LINK.

10. Type a value for the blank Seq field that is one greater than the sequence number noted in step 9. Type QDOMEXCL for the Backup Items field and *LNK for the List Type field.

11. Position the cursor next to the Backup Item listed as *LINK and space over the sequence number.

12. Press Enter.


14. Press Enter.

15. Press F3 four times.

---

**Starting a backup**

To start the online backup of all databases for your Domino server, load a tape and use the Start Backup BRMS command as follows:

```
STRBKUBRM CTLGRP(DOMINOX) SBMJOB(*NO)
```

where dominox corresponds to the control group you created for a specific Domino server.

During the backup processing, you may encounter certain errors that require user intervention, such as loading a tape. A message at the bottom of the screen may appear indicating that a message has been sent to the system operator for a reply. While the cursor is on any i5/OS message text, you can press F1 to see more information about the message.

The processing time of the backup operation depends on system processor size, device capabilities, amount of data being saved, and activity associated with your Domino server.

During the backup and recovery process, BRMS for Domino creates a subdirectory in the server's data directory called "brms" in which it stores temporary files (*.brmschgs files). These files store changes made to a database that occurred while the database was being saved or backed up. These files were previously stored in the same directory as their associated database.
When the backup operation is complete, review the job log to make sure that the backup was successful. To display the job log, enter the following i5/OS command:

```
DSPJOBLOG
```

On the display, press F10 and page up to see the details of any messages logged during backup processing.

To see the BRMS catalog of what has been backed up, follow these steps:

1. Enter the following i5/OS command:
   ```
   GO BRMS
   ```
2. Type a 2 at the command prompt and press Enter.
3. On the Backup display, type a 3 and press Enter.
4. On the Display Backup Activity display, type a 3 and press Enter.
5. On the Display Backup History display, type a 1 and press Enter three times to see the contents of your backup media.
6. Press F3 five times.

**Note** When you back up an integrated file system object, such as a Domino database, the object will appear as a saved item of *LINK.

**Tip** You can also use the Work with Media Information (WRKMEDIBRM) command to perform this operation.

---

**Recovering all the databases for all your Domino servers**

Use the Start Recovery using BRM (STRRCYBRM) command to recover all databases in the data directories of all Domino servers:

1. Enter the following i5/OS command:
   ```
   STRRCYBRM OPTION(*CTLGRP) ACTION(*RESTORE) CTLGRP(QDOMINO)
   ```
2. Type a 1 next to the items matching the version of backup that you want to restore. Use F16 to select all items. A saved item will appear for each database saved.

**Note** The order in which you restore files during a recovery is important. Because the backup of Domino databases can happen while the server is active, the changes that occur to the database while it is being saved are saved separately and need to be restored to the database when it is recovered. To accomplish the complete recovery of the database, the Domino APIs are used. In order for these APIs to be used, certain conditions and files must exist. For example, the NOTES.INI file must be present and available and the server data directory must be valid. If the server data directory is damaged or non-database files are missing, restore the non-database files first before trying to restore.
Domino databases. Non-database files are saved along with other files in the integrated file system.

**Recovering all the databases for a specific Domino server**

Perform the following steps to recover all databases for a specific Domino server:

1. Enter the following i5/OS command:
   
   ```
   STRRCYBRM OPTION(*CTLGRP) ACTION(*RESTORE)
   CTLGRP(CONTROL-GROUP-NAME)
   ```

   For `CONTROL-GROUP-NAME`, substitute the name of the control group (such as dominox) that you created for the Domino server.

2. Type a 1 next to the items matching the version of backup that you want to restore. Use F16 to select all items. A saved item will appear for each database saved.

**Recovering a single database**

Use the Restore Object using BRM (RSTBRM) command to recover a specific Domino database through BRMS. In this command, you must provide the name of the i5/OS device, the name of the database you want to restore, and the path to the i5/OS directory where you want to restore the database. For example, to recover the catalog.nsf database in the `/notes/data` directory, assuming a device of tap01, enter the following i5/OS command:

```
RSTBRM DEV(TAP01) OBJ('/NOTES/DATA/CATALOG.NSF')
```

When the recovery operation is complete, review the job log to make sure that the database was successfully recovered. To display the job log, enter the following i5/OS command:

```
DSPJOBLOG
```

On the display, press F10 and page up to see the details of any messages logged during recovery processing.

**Note** Multiple objects may be associated with a Domino database when it is backed up while online; therefore, multiple messages may appear during recovery.
Performance considerations and configuration options

Because of performance impacts of writing individual Domino databases to physical devices, such as tape, the databases are backed up in groups (5 is the default). You can change this group value by adding the following entry in the NOTES.INI file for the server:

```
SAVDOMBRM_FILES_IN_GROUP=X
```

where X is the number of files to group in one BRMS package.

As you increase this number, your Domino server is backed up more quickly. However, all databases in the group will be journaled during the backup, with the changes backed up separately. Because all the databases in the group are journaled until all databases in the group are backed up, the time during which changes to the databases can occur is increased and the size of the changes backed up will increase. When the databases are recovered, the changes to the database that occurred during the backup will be reapplied. This process takes longer as the number of changes increases.

If your server is being backed up during heavy server usage, you will want to keep this group value relatively small (3 to 7), so that fewer changes occur to the database during the backup operation. As a result, recovery of the database can occur in a reasonable amount of time.

If your server is being backed up during off hours when server use is low, you can set the group value higher (10 to 20 or even higher) to speed up the backup operation, while keeping the recovery time reasonable. The maximum group value is 120.

BRMS restriction

The following restriction applies when using the Domino BRMS support.

- Domino BRMS support does not save Domino database files residing in a "link" subdirectory under the server data directory. Link subdirectories can be created via Domino Administration by selecting Tools -> Folders -> New Link.
Chapter 19
Integrating iSeries Collection Services with Domino

A new feature starting with Domino 6 is the ability to integrate Domino with Collection Services. This i5/OS service can run continuously and store broad statistics about system performance. By integrating this service with Domino, you can store Domino statistics within this system repository.

You can configure the service to store Domino statistics over days or even months. The data can then be exported to DB2 files and cross referenced with other Collection Services data such as CPU use or disk use.

A pre-defined set of Domino statistics is stored in Collection Services. This pre-defined set was determined to be the most useful set of statistics during times of problem determination or problem prevention. The complete set of Domino statistics is available by running the following command from the Domino console:

SHOW STAT

For more information and examples on using this data, see the Domino for i5/OS Application Development Guide (DOMAPPDEV.NSF).

When you install or upgrade to Domino 7, the new COLSRV400 addin task is automatically added to the ServerTasks parameter in the NOTES.INI file. It is used to gather statistics for that Domino server as required for Collection Services. When Collection Services is not running or is not set up to collect Domino statistics, the addin task does nothing. To completely disable this feature from a particular Domino server, the COLSRV400 task can be removed from the ServerTasks entry in that Domino server's NOTES.INI file. However, it is recommended that this is left in the NOTES.INI file.

For more information on iSeries Collection Services, see the IBM eServer iSeries Information Center at the following Web address:

http://www.ibm.com/eserver/iseries/infocenter

Starting Collection Services

To start Collection Services, follow these steps:

1. Open iSeries Navigator.
2. Open the system where you configured Domino.
3. Click Configuration and Service.
4. Right-click Collection Services and select Start Collecting.
Stopping Collection Services
To stop Collection Services, follow these steps:
1. Open iSeries Navigator.
2. Open the system where you configured Domino.
3. Click Configuration and Service.
4. Right-click Collection Services and select Stop Collecting.

Collection Services properties
To view the Collection Services properties, follow these steps:
1. Open iSeries Navigator.
2. Open the system where you configured Domino.
3. Click Configuration and Service.
4. Right-click Collection Services and select Properties.
5. On the General tab, specify the collection interval and a time for the recycle. The default settings will collect data every 5 minutes, and create a collection object every day at 12 AM.
6. On the Data to Collect tab, make sure Domino is listed and selected to be collected at the interval you want. The default is every 5 minutes.

Exporting and viewing the statistics
To export the statistics to a DB2 file for viewing, follow these steps:
1. Open iSeries Navigator.
2. Open the system where you configured Domino.
3. Click Configuration and Service.
4. Click Collection Services.
5. In the right pane, right-click a Collection Name with the Cycled status and select Create Database Files now.
6. You will be prompted to choose a location for creating the database files, the categories you want to export from, and the time interval to export from. In the Data to include field, make sure to at least select Domino Collection Services.
You can now use your favorite DB2 query tool to view the data. The file QAPMDOMINO will contain the Domino data. An example query of "select * from qpfrdata/QAPMDOMINO" would show something similar to the following:

![Display Data]

<table>
<thead>
<tr>
<th>Interval number</th>
<th>Elapsed time</th>
<th>Century</th>
<th>Server</th>
<th>Job</th>
<th>User</th>
<th>Job</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>020626120000</td>
<td>300</td>
<td>1</td>
<td>DOMINO1 SERVER QNOTES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>020626120500</td>
<td>300</td>
<td>1</td>
<td>DOMINO1 SERVER QNOTES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>020626121000</td>
<td>301</td>
<td>1</td>
<td>DOMINO1 SERVER QNOTES</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Collected Statistics**

The following Domino statistics are collected by Collection Services:

**Note** Data Types: $C(x) = \text{Character (characters)}$, $B(x,y) = \text{Binary (Digits, Decimal Places)}$, $PD(x,y) = \text{Packed Decimal (Digits, Decimal Places)}$
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITMNUM</td>
<td>Interval number: the nth sample database interval based on the start time specified in the CRTPRDTA command.</td>
<td>PD (5,0)</td>
</tr>
<tr>
<td>DTETIM</td>
<td>Interval date (ymmd) and time (hmmss): The date and time of the sample interval.</td>
<td>C (12)</td>
</tr>
<tr>
<td>INTSEC</td>
<td>Elapsed interval seconds: The number of seconds since the last sample interval.</td>
<td>PD (7,0)</td>
</tr>
<tr>
<td>DMDBPM</td>
<td>Database.BufferPool.Maximum.Megabytes: The configured maximum size for database control pools that may be used.</td>
<td>B (9,0)</td>
</tr>
<tr>
<td>DMDBPP</td>
<td>Database.BufferPool.Peak.Megabytes: Maximum amount of the buffer pool that has been used by Domino over the life of the server.</td>
<td>B (9,0)</td>
</tr>
<tr>
<td>DMDBPR</td>
<td>Database.Database.BufferPool.PerCentReadsInBuffer: Percentage of database reads present in buffer pool.</td>
<td>B (5,2)</td>
</tr>
<tr>
<td>DMDBCH</td>
<td>Database.DbCache.Hits: Number of hits to the database cache.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMDBCL</td>
<td>Database.DbCache.Lookups: Number of lookups to the database cache.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMNLCH</td>
<td>Database.NAMELookupCacheHits: Number of cache hits when doing name lookups in the server’s name and address book.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMNLCL</td>
<td>Database.NAMELookupCacheLookups: Number of lookups in the server’s name and address book.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMASPN</td>
<td>Platform.LogicalDisk.1.AuxStoragePool: The number of the Auxiliary Storage Pool that includes the Domino data directory.</td>
<td>B (4,0)</td>
</tr>
<tr>
<td>DMASPU</td>
<td>Platform.LogicalDisk.1.PctUsed: Percent of total disk space used in the ASP that includes the Domino data directory.</td>
<td>B (5,2)</td>
</tr>
</tbody>
</table>

Note: This metric is calculated by the server and is based on an internal sample interval as configured for the server.

170 Installing and Managing Domino 7 for i5/OS
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMASPB</td>
<td>Platform.LogicalDisk.1.PctUtil: Percent of time the drives are busy reading or writing in the ASP that includes the Domino data directory. <strong>Note</strong> This metric is calculated by the server and is based on an internal sample interval as configured for the server.</td>
<td>B (5,2)</td>
</tr>
<tr>
<td>DMTRNS</td>
<td>Server.Trans.Total: Number of transactions</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMUSRO</td>
<td>Server.Users: Number of users with open sessions on the server. (this is the current value at time data was sampled)</td>
<td>B (9,0)</td>
</tr>
<tr>
<td>DMUSRP</td>
<td>Server.Users.Peak: Peak number of concurrent users since server was started.</td>
<td>B (9,0)</td>
</tr>
<tr>
<td>DMUSRT</td>
<td>Server.Users.Peak.Time: Time that last peak users occurred (YYYYMMDDHHMMSS).</td>
<td>C (14)</td>
</tr>
<tr>
<td>DMMLCP</td>
<td>Mail.TotalPending: Number of outbound mail messages in this server's MAIL.BOX waiting to be processed by the Domino Router job. Mail will be pending until the Router job wakes up and moves outgoing mail from MAIL.BOX to the destination mail servers. If a mail server cannot be contacted, the message will remain pending in MAIL.BOX (this is the current value at the time data was sampled).</td>
<td>B (9,0)</td>
</tr>
<tr>
<td>DMMLWR</td>
<td>Mail.WaitingRecipients: Number of inbound mail messages in this server's MAIL.BOX waiting to be processed by the Domino Router job. Mail will be waiting until the Router job wakes up and moves incoming mail from MAIL.BOX into user mail files (this is the current value at time data was sampled).</td>
<td>B (9,0)</td>
</tr>
<tr>
<td>DMMLBX</td>
<td>Mail.Delivered: Combined number of inbound and outbound mail messages placed into this server's MAIL.BOX.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMCMCD</td>
<td>Domino.Command.CreateDocument: Count of 'CreateDocument' URLs that have come into the server.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DCMDD</td>
<td>Domino.Command.DeleteDocument: Count of 'DeleteDocument' URLs that have come into the server.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DCMED</td>
<td>Domino.Command.EditDocument: Count of 'EditDocument' URLs that have come into the server.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DCMOA</td>
<td>Domino.Command.OpenAgent: Count of 'OpenAgent' URLs that have come into the server.</td>
<td>B (18,0)</td>
</tr>
</tbody>
</table>

Chapter 19: Integrating iSeries Collection Services with Domino  171
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMCMOB</td>
<td>Domino.Command.OpenDatabase: Count of 'OpenDatabase' URLs that have come into the server.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMCMOD</td>
<td>Domino.Command.OpenDocument: Count of 'OpenDocument' URLs that have come into the server.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMCMOF</td>
<td>Domino.Command.OpenForm: Count of 'OpenForm' URLs that have come into the server.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMCMOI</td>
<td>Domino.Command.OpenImageResource: Count of 'OpenImageResource' URLs that have come into the server.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMCMOV</td>
<td>Domino.Command.OpenView: Count of 'OpenView' URLs that have come into the server.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMCMSD</td>
<td>Domino.Command.SaveDocument: Count of 'SaveDocument' URLs that have come into the server.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMCMTU</td>
<td>Domino.Command.Total: Count of all URLs that have come into the server.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMRQ1M</td>
<td>Domino.Requests.PerMinute.Total: Total requests over the past minute. Value as recorded at sample time.</td>
<td>B (9,0)</td>
</tr>
<tr>
<td>DMNPT1</td>
<td>NET.*.Port 1: Domino port (1 of 4) for which data is being reported.</td>
<td>C (32)</td>
</tr>
<tr>
<td>DMNBR1</td>
<td>NET.*.BytesReceived 1: Number of network bytes received for this port.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMNBS1</td>
<td>NET.*.BytesSent 1: Number of network bytes sent for this port.</td>
<td>B (18,0)</td>
</tr>
<tr>
<td>DMNS1I</td>
<td>NET.*.SessionsEstablished.Incoming 1: Number of Incoming sessions established for this port.</td>
<td>B (9,0)</td>
</tr>
<tr>
<td>DMNSO1</td>
<td>NET.*.SessionsEstablished.Outgoing 1: Number of Outgoing sessions established for this port.</td>
<td>B (9,0)</td>
</tr>
<tr>
<td>DMN*</td>
<td><strong>Note</strong> The above 5 fields are repeated for ports 2, 3, and 4.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 20
Using National Language Versions of Domino

With Domino 7 for i5/OS, fully translated versions of the product are not available. Instead, to deploy Domino in a language other than English, you must first install and configure the English version of Domino and then add the translated language objects from the Language Pack CD-ROM.

You can deploy more than one language on a Domino server or have Domino servers with differing languages through the use of a language pack and multi-lingual database support. For additional information on this type of environment, see the readme.txt file on the Language Pack CD-ROM.

Although the commands, menus, panels, and messages are not translated for Domino 7, the iSeries Navigator plug-in interface is translated into Brazilian Portuguese, French, Italian, German, Japanese, Korean, Simplified Chinese, Traditional Chinese, and Spanish. For all other languages, the plug-in will default to English. The translated interfaces are installed as part of the Language Pack installation process.

Using other languages on English versions of Domino

To enter and display other languages on English versions of Domino for i5/OS, you need to specify that all locale-specific job attributes should be picked up from the locale of the language, by following these steps:

1. Stop the Domino server.
2. Change the locale value of the QNOTES user profile that is used to run Domino tasks (jobs). The locale name is /QSYS.LIB/xxxx.locale where xxxx.locale is the value specified in the third column of the table below.

   Use the i5/OS CHGUSRPRF command to change the locale value. For example, to set the locale for German, use the following command:

   \[
   \text{CHGUSRPRF QNOTES LOCALE('/QSYS.LIB/DE_DE.LOCALE')}
   \]

   \[
   \text{SETJOBATR(*CCSID *DATFMT *DATSEP *DECFMT *SRTSEQ *TIMSEP)}
   \]

   **Note** You may receive an informational message in your job log indicating that the job attribute for sort sequence (*srtseq) was not set for the locale. This will not affect the behavior of your server, and can be ignored.
**Default locale**

For the English version of Domino for i5/OS, the default locale is set to the value listed for "English (USA)."

<table>
<thead>
<tr>
<th>To enter and display text in:</th>
<th>Using CCSID:</th>
<th>Change QNOTES locale to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Albanian</td>
<td>500</td>
<td>SQ_AL.LOCALE</td>
</tr>
<tr>
<td>Arabic</td>
<td>420</td>
<td>AR_AA.LOCALE</td>
</tr>
<tr>
<td>Belgian English</td>
<td>37</td>
<td>EN_BE.LOCALE</td>
</tr>
<tr>
<td>Belgian French</td>
<td>500</td>
<td>FR_BE.LOCALE</td>
</tr>
<tr>
<td>Belgian French (Euro)</td>
<td>1148</td>
<td>FR_BE_E.LOCALE</td>
</tr>
<tr>
<td>Bulgarian</td>
<td>1025</td>
<td>BG_BG_L.LOCALE</td>
</tr>
<tr>
<td>Canadian French (MNCS)</td>
<td>500</td>
<td>FR_CA.LOCALE</td>
</tr>
<tr>
<td>Chinese, Simplified</td>
<td>1388</td>
<td>ZH_CN.LOCALE</td>
</tr>
<tr>
<td>Chinese, Traditional</td>
<td>937</td>
<td>ZH_TW.LOCALE</td>
</tr>
<tr>
<td>Croatian</td>
<td>870</td>
<td>HR_HR.LOCALE</td>
</tr>
<tr>
<td>Czech</td>
<td>870</td>
<td>CS_CZ.LOCALE</td>
</tr>
<tr>
<td>Danish</td>
<td>277</td>
<td>DA_DK.LOCALE</td>
</tr>
<tr>
<td>Netherlands Dutch</td>
<td>37</td>
<td>NL_NL.LOCALE</td>
</tr>
<tr>
<td>Netherlands Dutch (Euro)</td>
<td>1140</td>
<td>NL_NL_E.LOCALE</td>
</tr>
<tr>
<td>Belgium Dutch</td>
<td>500</td>
<td>NL_BE.LOCALE</td>
</tr>
<tr>
<td>Belgium Dutch (Euro)</td>
<td>1148</td>
<td>NL_BE_E.LOCALE</td>
</tr>
<tr>
<td>English (Great Britain)</td>
<td>285</td>
<td>EN_GB.LOCALE</td>
</tr>
<tr>
<td>English (USA)</td>
<td>37</td>
<td>EN_US.LOCALE</td>
</tr>
<tr>
<td>Estonian</td>
<td>1122</td>
<td>ET EE.LOCALE</td>
</tr>
<tr>
<td>Finnish</td>
<td>278</td>
<td>FI_FI.LOCALE</td>
</tr>
<tr>
<td>Finnish (Euro)</td>
<td>1143</td>
<td>FI_FI_E.LOCALE</td>
</tr>
<tr>
<td>French (Euro)</td>
<td>1147</td>
<td>FR_FR_E.LOCALE</td>
</tr>
<tr>
<td>French (France)</td>
<td>297</td>
<td>FR_FR.LOCALE</td>
</tr>
<tr>
<td>French (Switzerland)</td>
<td>500</td>
<td>FR_CH_L.LOCALE</td>
</tr>
<tr>
<td>German (Euro)</td>
<td>1141</td>
<td>DE_DE.E.LOCALE</td>
</tr>
<tr>
<td>German (Germany)</td>
<td>273</td>
<td>DE_DE.LOCALE</td>
</tr>
<tr>
<td>German (MNCS)</td>
<td>300</td>
<td>DE_CH_L.LOCALE</td>
</tr>
<tr>
<td>Greek</td>
<td>875</td>
<td>EL_GR.LOCALE</td>
</tr>
<tr>
<td>Hebrew</td>
<td>424</td>
<td>IW_IL.LOCALE</td>
</tr>
<tr>
<td>Hungarian</td>
<td>870</td>
<td>HU_HU.LOCALE</td>
</tr>
<tr>
<td>Icelandic</td>
<td>871</td>
<td>IS_IS.LOCALE</td>
</tr>
<tr>
<td>Italian (Euro)</td>
<td>1144</td>
<td>IT_IT.E.LOCALE</td>
</tr>
<tr>
<td>Italian (Italy)</td>
<td>280</td>
<td>IT_IT.LOCALE</td>
</tr>
<tr>
<td>Japanese (Latin)</td>
<td>5035</td>
<td>JA_5035.LOCALE</td>
</tr>
<tr>
<td>Korean</td>
<td>933</td>
<td>KO KR.LOCALE</td>
</tr>
<tr>
<td>Latvian</td>
<td>1112</td>
<td>LV LV.LOCALE</td>
</tr>
<tr>
<td>Lithuanian</td>
<td>1112</td>
<td>LT LT.LOCALE</td>
</tr>
<tr>
<td>Macedonian</td>
<td>1025</td>
<td>MK MK.L.LOCALE</td>
</tr>
</tbody>
</table>

*continued*
The language dictionary files are used for spell-checking within Notes and Domino. The English version of Domino for i5/OS installs the following language dictionary files:

- canadien.dic
- uk.dic
- us.dic
- wpdic.dic

Domino for i5/OS installs these files in the directory /QIBM/ProdData/Lotus/DOMINOXXX/DATA/<dict-name.dic>, where XXX corresponds to the release of Domino (for example, DOMINO700 for Domino 7.0) and <dict-name.dic> is the dictionary file. These files are then copied into each server's data directory during update or creation of a Domino server.

Additional dictionary files are contained in the dictions.exe or dictionaries.exe file which may be obtained from the \APPS\DICTIONARIES directory of the Notes or Notes/Domino Designer CD-ROM.

If you want to use one of the dictionary files listed in the table below and find that it has not been installed automatically by Domino, decompress the contents of the self-extracting file to a temporary directory on your PC's hard drive. End your Domino server(s) and then transfer the dictionary file(s) using FTP (or another file

<table>
<thead>
<tr>
<th>To enter and display text in:</th>
<th>Using CCSSID:</th>
<th>Change QNOTES locale to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Norwegian</td>
<td>277</td>
<td>NO_NO.LOCALE</td>
</tr>
<tr>
<td>Polish</td>
<td>870</td>
<td>PL_PL.LOCALE</td>
</tr>
<tr>
<td>Portuguese (Brazil)</td>
<td>37</td>
<td>PT_BR.LOCALE</td>
</tr>
<tr>
<td>Portuguese (Euro)</td>
<td>1140</td>
<td>PT_PT_E.LOCALE</td>
</tr>
<tr>
<td>Portuguese (Portugal)</td>
<td>37</td>
<td>PT_PT.LOCALE</td>
</tr>
<tr>
<td>Romanian</td>
<td>870</td>
<td>RO_RO.LOCALE</td>
</tr>
<tr>
<td>Russian</td>
<td>1025</td>
<td>RU_RU.LOCALE</td>
</tr>
<tr>
<td>Serbian (Cyrillic)</td>
<td>1025</td>
<td>SR_SP_L.LOCALE</td>
</tr>
<tr>
<td>Serbian (Latin)</td>
<td>870</td>
<td>SH_SP.LOCALE</td>
</tr>
<tr>
<td>Slovak</td>
<td>870</td>
<td>SK_SK.LOCALE</td>
</tr>
<tr>
<td>Slovene</td>
<td>870</td>
<td>SL_SI.LOCALE</td>
</tr>
<tr>
<td>Spanish</td>
<td>284</td>
<td>ES_ES.LOCALE</td>
</tr>
<tr>
<td>Spanish (Euro)</td>
<td>1145</td>
<td>ES_ES_E.LOCALE</td>
</tr>
<tr>
<td>Swedish</td>
<td>278</td>
<td>SV_SE.LOCALE</td>
</tr>
<tr>
<td>Thai</td>
<td>838</td>
<td>TH_TH.LOCALE</td>
</tr>
<tr>
<td>Turkish</td>
<td>1026</td>
<td>TR_TR.LOCALE</td>
</tr>
<tr>
<td>Ukrain</td>
<td>1025</td>
<td>UK_UA.LOCALE</td>
</tr>
</tbody>
</table>

Language dictionary files

The language dictionary files are used for spell-checking within Notes and Domino. The English version of Domino for i5/OS installs the following language dictionary files.

- canadien.dic
- uk.dic
- us.dic
- wpdic.dic

Domino for i5/OS installs these files in the directory /QIBM/ProdData/Lotus/DOMINOXXX/DATA/<dict-name.dic>, where XXX corresponds to the release of Domino (for example, DOMINO700 for Domino 7.0) and <dict-name.dic> is the dictionary file. These files are then copied into each server's data directory during update or creation of a Domino server.

Additional dictionary files are contained in the dictions.exe or dictionaries.exe file which may be obtained from the \APPS\DICTIONARIES directory of the Notes or Notes/Domino Designer CD-ROM.

If you want to use one of the dictionary files listed in the table below and find that it has not been installed automatically by Domino, decompress the contents of the self-extracting file to a temporary directory on your PC's hard drive. End your Domino server(s) and then transfer the dictionary file(s) using FTP (or another file

Chapter 20: Using National Language Versions of Domino  175
transfer method) to your Domino server's data directory. The owner of the file
should be changed to QNOTES as shown:

```sql
CHGOWN OBJ('server-data-directory-path'/<dict-name>.dic')
NEWOWN(QNOTES)
```

The dictionary file must be added to the data directory of each server that should
have access to the dictionary. Then restart your Domino server(s).

As always, if you add dictionary files to customize your Domino installation, you
should save (back up) your Domino server(s) after the dictionary file(s) have
been added.

If spell check for International languages does not work, check for the following
conditions:

- Ensure you have the appropriate language dictionaries in either the product
directory (with a SYMBOLIC link in your server's data directory for
dictionaries installed by Domino) or each server's data directory (for
dictionaries installed manually).
- Check your International User Preferences (choose File -> Preferences -> User
Preferences -> International) to ensure you are using the correct international
spelling dictionary.

<table>
<thead>
<tr>
<th>Language</th>
<th>Dictionary File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afrikaans</td>
<td>AFRIKAAN.DIC</td>
</tr>
<tr>
<td>Arabic</td>
<td>ARABIC.DIC</td>
</tr>
<tr>
<td>Catalan</td>
<td>CATALA.DIC</td>
</tr>
<tr>
<td>Czech</td>
<td>CZECH.DIC</td>
</tr>
<tr>
<td>Danish</td>
<td>DANSK.DIC</td>
</tr>
<tr>
<td>Dutch</td>
<td>NEDERLND.DIC</td>
</tr>
<tr>
<td>Dutch Belgian</td>
<td></td>
</tr>
<tr>
<td>Dutch Preferred</td>
<td>NEDPLUS.DIC</td>
</tr>
<tr>
<td>English (Australia)</td>
<td>AUS.DIC</td>
</tr>
<tr>
<td>English (Canada)</td>
<td></td>
</tr>
<tr>
<td>English (Caribbean)</td>
<td>US.DIC</td>
</tr>
<tr>
<td>English (Jamaica)</td>
<td></td>
</tr>
<tr>
<td>English (New Zealand)</td>
<td></td>
</tr>
<tr>
<td>English (United States)</td>
<td></td>
</tr>
<tr>
<td>English (Ireland)</td>
<td>UK.DIC</td>
</tr>
<tr>
<td>English (South Africa)</td>
<td></td>
</tr>
<tr>
<td>English (United Kingdom)</td>
<td></td>
</tr>
<tr>
<td>Finnish</td>
<td>SUOMI.DIC</td>
</tr>
<tr>
<td>French (Belgium)</td>
<td>FRANCAIS.DIC</td>
</tr>
<tr>
<td>French (Luxembourg)</td>
<td></td>
</tr>
<tr>
<td>French (Standard)</td>
<td></td>
</tr>
<tr>
<td>French (Switzerland)</td>
<td></td>
</tr>
<tr>
<td>Language</td>
<td>Dictionary File Name</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>French (Canada)</td>
<td>CANADIEN.DIC</td>
</tr>
<tr>
<td>German (Austria)</td>
<td>DEUTSCH.DIC</td>
</tr>
<tr>
<td>German (Liechtenstein)</td>
<td></td>
</tr>
<tr>
<td>German (Luxembourg)</td>
<td></td>
</tr>
<tr>
<td>German (Standard)</td>
<td></td>
</tr>
<tr>
<td>German (Reform)</td>
<td>DEUTSCH2.DIC</td>
</tr>
<tr>
<td>German (Switzerland)</td>
<td>DSCHEWIZ.DIC</td>
</tr>
<tr>
<td>Hebrew</td>
<td>HEBREW.DIC</td>
</tr>
<tr>
<td>Hungarian</td>
<td>MAGYAR.DIC</td>
</tr>
<tr>
<td>Icelandic</td>
<td>ISLENSK.DIC</td>
</tr>
<tr>
<td>Italian (Standard)</td>
<td>ITALIANO.DIC</td>
</tr>
<tr>
<td>Italian (Switzerland)</td>
<td></td>
</tr>
<tr>
<td>Medical (American)</td>
<td>US.MED</td>
</tr>
<tr>
<td>Medical (British)</td>
<td></td>
</tr>
<tr>
<td>Medical (British IZE)</td>
<td></td>
</tr>
<tr>
<td>Norwegian (Bokmal)</td>
<td>NORBOK.DIC</td>
</tr>
<tr>
<td>Norwegian (Nynorsk)</td>
<td>NORNYN.DIC</td>
</tr>
<tr>
<td>Polish</td>
<td>POLSKA.DIC</td>
</tr>
<tr>
<td>Portuguese (Brazil)</td>
<td>BRASIL.DIC</td>
</tr>
<tr>
<td>Portuguese (Standard)</td>
<td>PORTUGAL.DIC</td>
</tr>
<tr>
<td>Spanish</td>
<td>ESPANA.DIC</td>
</tr>
<tr>
<td>Spanish (Argentina)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Bolivia)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Chile)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Colombia)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Costa Rica)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Dominican Republic)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Equador)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Guatemala)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Mexico)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Modern Sort)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Panama)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Paraguay)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Peru)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Uruguay)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Venezuela)</td>
<td></td>
</tr>
<tr>
<td>Swedish</td>
<td>SVENSK.DIC</td>
</tr>
<tr>
<td>Turkish</td>
<td>TURKIYE.DIC</td>
</tr>
</tbody>
</table>
Changing the date and time formats and separators

International users may need to add the following entries into the NOTES.INI file to customize how Domino displays the date and time format and separators.

**Date format**
The English version of Domino sets the date order to MDY (Month Day Year) and sets the date separator to a "/" (forward slash).

To override the default date order, specify one of the following in the NOTES.INI file:

```ini
dateorder=DMY
dateorder=YMD
dateorder=MDY
```

To override the default date separator, specify:

```ini
dateseparator=x
```

where `x` is any character. For example, to set the date separator to a "." (period), specify:

```ini
dateseparator=.
```

**Time format**
The English version of Domino sets the time format to a 24-hour clock and sets the time separator to a ":" (colon). Note that this is different from Domino R5, in which the default time format was a 12-hour clock.

To override the default time format, specify one of the following in the NOTES.INI file:

```ini
ClockType = 24_HOUR
ClockType = 12_HOUR
```

To override the default time separator, specify the following:

```ini
timeseparator=x
```

where `x` is any character. For example, to set the time separator to a "." (period), specify:

```ini
timeseparator=.
```
Installing the translated Domino plug-in for iSeries Navigator

Installing the translated Domino Plug-in for iSeries Navigator allows you to view the Domino GUI components in the same language as your translated iSeries Navigator interface. Since the plug-in ships with Domino for i5/OS rather than with iSeries Access for Windows (previously called Client Access in OS/400 V5R1), the Domino plug-in must be installed from a system on which Domino has been installed.

If you want the Domino plug-in to be in a translated language, you must add that corresponding language pack to your Domino base code, otherwise you will be using the English Domino plug-in.

To be able to install and use the Domino plug-in in a translated version, the iSeries Navigator code must be installed for the same language as Domino for i5/OS.

Language feature codes available for the Domino plug-in for i5/OS
The iSeries Navigator Domino plug-in is translated into the languages shown in the following table. These are the languages for which a translated version of the Domino plug-in for iSeries Navigator exists and works with the iSeries Navigator of that i5/OS national language version. Only the i5/OS national language versions listed in this table provide translated Domino plug-in support for iSeries Navigator.

<table>
<thead>
<tr>
<th>Language</th>
<th>i5/OS language feature code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arabic</td>
<td>2954</td>
</tr>
<tr>
<td>Brazilian Portuguese</td>
<td>2980</td>
</tr>
<tr>
<td>Iberian Portuguese</td>
<td>2922</td>
</tr>
<tr>
<td>Czech</td>
<td>2975</td>
</tr>
<tr>
<td>Danish</td>
<td>2926</td>
</tr>
<tr>
<td>Dutch</td>
<td>2923</td>
</tr>
<tr>
<td>English</td>
<td>2924</td>
</tr>
<tr>
<td>Finnish</td>
<td>2925</td>
</tr>
<tr>
<td>French</td>
<td>2928</td>
</tr>
<tr>
<td>German</td>
<td>2929</td>
</tr>
<tr>
<td>Greek</td>
<td>2959</td>
</tr>
<tr>
<td>Hebrew</td>
<td>2961</td>
</tr>
<tr>
<td>Hungarian</td>
<td>2976</td>
</tr>
<tr>
<td>Italian</td>
<td>2932</td>
</tr>
<tr>
<td>Japanese DBCS</td>
<td>2962</td>
</tr>
<tr>
<td>Korean</td>
<td>2986</td>
</tr>
<tr>
<td>Norwegian</td>
<td>2933</td>
</tr>
<tr>
<td>Polish</td>
<td>2978</td>
</tr>
<tr>
<td>Russian</td>
<td>2979</td>
</tr>
<tr>
<td>Simplified Chinese DBCS</td>
<td>2989</td>
</tr>
</tbody>
</table>

continued
If the i5/OS national language version is not included in the list of Domino language feature codes in the table above, then a symbolic link (symlnk) is created and points to the English Domino plug-in by default. You can, however, install one of the i5/OS national language versions contained in the list of Domino language feature codes as a secondary language, and then make use of that translated Domino plug-in for that version.

**Installing the translated Domino plug-in**

To install a translated Domino plug-in for iSeries Navigator, follow these steps:

1. Install the language pack for the language you want for iSeries Navigator. For more information on installing the language packs, see the readme.txt file on the Language Pack CD-ROM.
   
   During installation of the language pack, a directory called MRIxxxx is added to the following directory:
   
   `/QIBM/ProdData/OpNavplugin/LOTUS.DOMINO`
   
   where `xxxx` is the i5/OS feature code for that translated version.

2. Make sure the QIBM folder is set up as a shared folder. If it is not, using iSeries Navigator, right-click the QIBM folder and select **Sharing -> New Share**.

3. Open Windows Explorer and select the following directory:
   
   `C:\Program Files\IBM\Client Access\MRIxxx`
   
   where `xxx` is the i5/OS feature code.

4. Click **File** and select **New -> Folder**.

5. Name the folder **lotus.domino**.

6. Go to the i5/OS directory of
   
   `/QIBM/ProdData/OpNavplugin/LOTUS.DOMINO`, and look for the directory `MRIxxxx`, where `xxxx` is the i5/OS feature code for that translated version.

7. Copy the six files included in this directory into the directory you created on your C: drive.

8. In iSeries Navigator, select your iSeries server.

9. Click **Network**.

10. Click **Servers**.
11. Click Domino.
12. Right-click any Domino server displayed in the list, and you should see a translated interface for the displayed menu.

About running Domino using a secondary language

The following are special considerations to keep in mind if you are running Domino in a language other than English.

Support for Chinese Standard GB18030
Domino 7 for i5/OS continues to support the Chinese character set standard, GB18030.

Support for bi-directional languages
Domino 7 for i5/OS continues to support the use of bi-directional languages. To use bi-directional languages, follow these steps:

1. Install the Notes client on a BiDi (bi-directional) Windows workstation.
2. Run the client to complete the setup and verify that everything works properly.
3. To turn on BiDi support, choose File -> Preferences -> User Preferences -> International -> Bidirectional -> Support bi-directional languages.
   
   Note  The Bidirectional tab on the International display will only appear if BiDi is enabled on your system. If you are using Windows 2000, and Arabic or Hebrew locales are added to the system (using the Regional setting in the control panel) then the BiDi support will be active even if the default locale is not BiDi. On Windows NT, Windows 98, and Windows 95, the user must be running a BiDi version of Windows, and the default regional setting must to be set to a BiDi language.

4. Hebrew users who want to force all equations to flow from left to right should also add:
   
   EnableHebrewEquations=1

These settings will be enabled by default in Arabic and Hebrew localized versions of Notes.

Additional BiDi relevant settings may be customized by choosing File -> Preferences -> User Preferences -> International -> Bidirectional -> Support bi-directional languages.
Appendix A
Domino for i5/OS Diagrams

This appendix includes some diagrams that will help explain a few concepts and procedures covered earlier in this document.

Domino installation options

This diagram illustrates the various options available for installing the Domino software on your system. Although there are several ways to initiate the installation, all use the same underlying code in the RSTLICPGM command to perform the actual installation.
Domino configuration options

This diagram illustrates the various configuration options available with Domino for i5/OS. Although there are several tools that can be used for configuring a Domino server, all methods use the underlying code in the CFGDOMSVR command to perform the actual configuration.
Appendix B
Setting Up Remote LAN Services

The remote LAN service allows a Domino server to communicate with a remote Domino server through phone lines. Of course, both servers must be connected to the phone lines through modems. You can use a remote LAN service to perform tasks such as remote Domino server replication or mail routing between two Domino servers. This capability does not affect a remote connection between a Notes client and a Domino server.

Setting up a remote LAN service for iSeries is similar to Domino in a Windows environment. You need to perform the following tasks:

- Create the PPP profiles that define the connections for the remote LAN service.
- Add a Connection document in the Domino Directory for the Domino server on the calling system.
- Add a Server document in the Domino Directory for the Domino server on the calling system.

For more information on setting up a remote LAN service, see the Domino administration documentation or the Lotus Domino Administrator 7 Help database (HELP7_ADMIN.NSF).

Server requirements for remote LAN service

To use a remote LAN service with Domino 7, your server must have the following hardware and software:

**Hardware**
- 2629 IOP
- 2699 IOA
- 2720 PCI WAN/Twinaxial IOA
- 2721 PCI Two-line WAN IOA
- Modems
- Modem cables
Software
- OS/400 Version 5 Release 1 or later with the latest cumulative PTF package applied.
- iSeries Access for Windows, 5722XW1 Version 5 Release 1 or later. You use iSeries Navigator in iSeries Access to create the Point-to-Point Protocol (PPP) profiles.

Creating a PPP profile for remote LAN service
i5/OS supports Dial on Demand, which is a function that allows the use of a specific TCP/IP route to signal i5/OS to initiate a dial connection over that route automatically. Domino for i5/OS is not enabled to use this feature. The Domino Dialup Network capability is supported using PPP dial connections.

Use iSeries Navigator on a Windows workstation to create the PPP connection profiles:
- Create a *DIAL profile on the calling system. The remote LAN service will start the *DIAL connection.
- If the system is the receiving system, create an *ANS profile on that system. You can also use iSeries Navigator to start the *ANS connection.

If the system is both a calling system and a receiving system, create both a *DIAL profile and an *ANS profile. Here are procedures for using iSeries Navigator to create a *DIAL profile and an *ANS profile. For other details on creating a profile, see the iSeries Access help.

Creating the *DIAL profile
To create the *DIAL profile using iSeries Navigator, follow these steps:

1. Open the system where you will create the PPP profile.
2. Click Network.
4. Right-click Originator Connection Profiles and select New Profile.
5. On the New Point-to-Point Connection Profile Setup dialog, make sure PPP is selected and the Operating Mode is set to Dial and click OK.
6. On the New Point-to-Point Profile Properties dialog, specify a name and description of this profile on the General tab.
7. On the Connection tab, specify a Line name, and click Add to specify a phone number of the remote system. If you want to allow this line to both dial and answer, click the check box next to Enable multilink protocol and fill in the appropriate fields in the resulting dialog.
8. On the DNS tab, choose Dynamically assign for both the Local IP address and the Remote IP address. On most systems, the answering system assigns an IP address to an incoming call.
9. If dialing into a Windows NT system, click the Authentication tab and make the following selections:
   - Click Allow the remote system to verify the identity of this iSeries.
   - Click Require unencrypted password (PAP).
   - Specify the User name and Password of a user on the Windows NT system: for example, the Administrator Password.

10. Click OK to create the *DIAL profile.

Creating the *ANS profile
To create the *ANS profile using iSeries Navigator, follow these steps:

1. Open the system where you will create the PPP profile.
2. Click Network.
4. Right-click Receiver Connection Profiles and select New Profile.
5. On the New Point-to-Point Connection Profile Setup dialog, make sure PPP is selected and the Operating Mode is set to Answer and click OK.
6. On the New Point-to-Point Profile Properties dialog, specify a name and description of this profile on the General tab.
7. On the TCP/IP Settings tab, specify an IP address for both the Local IP address and the Remote IP address. For example, specify 199.xx.xx.1 and 199.xx.xx.2.
8. Click OK to create the *ANS profile.

Starting the *ANS profile
Once you have created a PPP profile using iSeries Navigator, you can start it through iSeries Navigator by right-clicking the profile and selecting Start.

Adding the Connection document for remote LAN service
Use the Domino Administrator client on your workstation to add the Connection document for the calling server:

1. From the Notes workspace, choose File -> Tools -> Server Administration.
2. When the Domino Administrator client opens, click the Configuration tab.
3. Click Server.
4. Click Connections.
5. Click the Add Connection button.
6. Specify the values shown in the table below.

   **Note** The login name and password are ignored by the remote LAN program on i5/OS. The system administrator must set up the profiles with the correct user information (usually none) to ensure security of the system. Domino has built-in security which ensures that users must have a proper ID to access the server.

7. Enable or Disable Mail Routing and Replication for this connection.

   If the Mail Routing and Replication is enabled, the Domino server automatically loads LIBRAS.SRVPGM. Once loaded, this program tries to connect to the remote system using the *DIAL profile name that is specified for the Remote connection name in the Connection document.

   **Note** If you want to set up a schedule, make sure you set the Schedule field to ENABLED in the Scheduled Connection section.

8. Click **Save and Close**.

<table>
<thead>
<tr>
<th>Entry</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection type:</td>
<td>Remote LAN service</td>
</tr>
<tr>
<td>Remote LAN port</td>
<td>TCPIP</td>
</tr>
<tr>
<td>Source server:</td>
<td>Local Domino server name (for example, Server1)</td>
</tr>
<tr>
<td>Source domain:</td>
<td>Local Domino domain name (for example, Acme1)</td>
</tr>
<tr>
<td>Destination server name:</td>
<td>Remote Domino server name (for example, Server2)</td>
</tr>
<tr>
<td>Destination domain name:</td>
<td>Remote Domino domain name (for example, Acme2)</td>
</tr>
<tr>
<td>Choose a service type:</td>
<td>Microsoft Remote Access Service (RAS)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> To see the service types, click Choose a Service Type.</td>
</tr>
<tr>
<td>Remote LAN service configuration:</td>
<td><strong>Note</strong> To see the configuration fields, click Modify Remote LAN Service Configuration.</td>
</tr>
<tr>
<td>Remote connection name:</td>
<td>Name of *DIAL profile you created</td>
</tr>
<tr>
<td>Login name:</td>
<td>Ignored</td>
</tr>
<tr>
<td>Password:</td>
<td>Ignored</td>
</tr>
<tr>
<td>Phone number:</td>
<td>Phone number of remote system (overrides the phone number in the *DIAL profile if it is different)</td>
</tr>
<tr>
<td>Optional network address:</td>
<td>IP address of remote system (for example, 199.xx.xx.5)</td>
</tr>
</tbody>
</table>
Adding a Server document for remote LAN service

To add a Server document for the remote server in the Domino Directory of the calling server using the Domino Administrator client, follow these steps:

1. Click the Configuration tab.
2. Click Server.
3. Click All Server Documents.
4. Click the Add Server Document button.
5. Choose Create -> Server -> Server.
6. Specify the server settings for a remote server. Make sure you provide information for the Network Configuration. For an example of the Network Configuration settings, see the table below.
7. Click Save and Close.

<table>
<thead>
<tr>
<th>Port</th>
<th>Notes Network</th>
<th>Net Address</th>
<th>Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP</td>
<td>NETWORK1</td>
<td>199.xx.xx.4</td>
<td>ENABLED</td>
</tr>
</tbody>
</table>

Remote LAN service errors

The Domino console shows any errors that occur during connection. The errors begin with:

RAS 400: xxx.
Appendix C
Using i5/OS Commands With Domino for i5/OS

An alternative to managing your Domino environment using the iSeries Navigator GUI interface is using i5/OS commands.

You start the i5/OS command interface by signing on to your server, such as from a 5250 emulator window on a workstation that is communicating with the server. To enter a command, type the command on any line following the symbol ===> and press Enter. To have the system prompt you for details of a command, type the command name (such as DSPSFWRSC) and press F4 instead of Enter.

The following are the most commonly used commands when managing your Domino environment using the i5/OS command interface.

**Note** Help is available for any command or keyword by pressing F1 when your cursor is on the command or keyword.

**CFGDOMSVR**
The Configure Domino Server command allows you to either set up a Domino server to run natively on your system, or completely remove an existing Domino server.

When configuring a Domino server, you have the option of setting up a first Domino server, or adding a Domino server to an existing Domino domain. For more information on either of these options, see Chapter 6 "Setting up a first Domino server" and Chapter 8 "Setting up an additional Domino server."

You can set the following parameters when using the CFGDOMSVR command:

- Data directory
- Organization
- Administrator
- Time zone
- Daylight savings time
- Get Domino Directory from (*ADD only)
- Domino Directory Type (*ADD only)
- Additional server ID (*ADD only)
- Web browsers
- Internet mail packages
- SMTP services (With Domino 7, values entered into this field are ignored.)
• Directory services
• News readers (With Domino 7, values entered into this field are ignored.)
• Connection services
• Advanced services
• Default ACL settings
• Text description

By pressing F10, you can set the following additional parameters:

• Replace configuration
• Domain name
• Network name
• Country/region code
• Organizational unit
• Certifier ID
• Administrator ID
• Server ID
• Start server
• Start when TCP/IP is started
• Log replication events
• Log client session events
• TCP/IP port options
• Server host name
• Subsystem and object names
• Collation
• Copy Administrator ID file
• Additional services
• Allow Domino Off-Line Services
• Service provider configuration (With Domino 7, values entered into this field are ignored.)

To use the CFGDOMSVR command, you must have the following special authorities:

• *SECADM
• *ALLOBJ
• *JOBCTL
• *IOSYSCFG

192 Installing and Managing Domino 7 for i5/OS
CHGDOMSVR

The Change Domino Server command allows you to change the configuration of an existing Domino server on your system. The following parameters can all be modified using the CHGDOMSVR command:

- Server ID file password
- Time zone
- Daylight savings time
- Web browsers
- Internet mail packages
- Directory services
- Connection services
- Advanced services
- Log replication events
- Log client session events
- TCP/IP port options
- Server host name
- Subsystem and object names
- Additional services
- Collation
- Text description

By pressing F10, you can modify the following additional parameters:

- SMTP services (With Domino 7, values entered into this field are ignored.)
- News readers (With Domino 7, values entered into this field are ignored.)
- Start when TCP/IP started
- Allow Domino Off-Line Services

To use the CHGDOMSVR command, you need the following special authorities:

*SEACADM
*ALLOBJ
*JOBCTL
*IOSYSCFG
**DLTLICPGM**
The Delete Licensed Program command allows you to delete all of the objects that make up a licensed program. When using this command to delete the Domino software, you can choose to delete the entire product or specific options of the product.

To use the DLTLICPGM command, you must have *ALLOBJ special authority.

**DSPDOMCSL**
The Display Domino Console command provides a way to view the status and jobs of a Domino server. When using this command, you can not submit Domino subcommands to the Domino server.

To run this command, you must have either of the following:

- *X data authority to the Domino server's data directory (and its parent directories, if the directory is not directly under the root directory)
- *ALLOBJ special authority

**DSPSFWRSC**
The Display Software Resources command allows you to view, print, or write to an output file the list of installed software resources. This command is useful when verifying what software versions are already installed on your system. When you enter this command, you will see a display that lists the product ID, option, feature code, and a text description of each item. To see the library and release for each item, press F11.

**ENDDOMSVR**
The End Domino Server command allows you to stop a Domino server that is currently running. You can choose to stop all (*ALL) Domino servers on your system, or a specific Domino server. There are two additional options that allow you to stop a Domino server in a controlled manner, or immediately.

- ***CNTRLD** stops all i5/OS jobs used by the Domino server, but the subsystem used by the server remains operational.
- ***IMMED** stops all processing by the Domino server and the subsystem used by the server immediately. Since data could be lost, this option should only be used when the Domino server fails to shut down using the *CNTRLD option.

You can also choose whether or not to stop the Java Server Controller related to your Domino server when the server stops.

To stop a Domino server, you must have *JOBCTL special authority.
LODRUN
The Load and Run Media Program command is commonly used during the installation process of a software product. You can use this command to install a product from tape, diskette, or optical device.

To use the LODRUN command, you must have *SAVSYS special authority.

RUNDOMCMD
The Run Domino Command (RUNDOMCMD) runs an i5/OS command in the context of a particular Domino server. This command sets up the environment that allows the command to be run whether the Domino server is active or not. The setup includes setting the PATH environment variable for the server, setting the directory for the job to the data directory of the server, and running the requested command under the QNOTES user profile.

**Caution** If you use RUNDOMCMD in batch, specifying BATCH(*YES), the RUNDOMCMD setup does not set the current working directory for the job to the server data directory. Instead, the home directory of the QNOTES user profile is used.

To use the RUNDOMCMD command, you must have either of the following:

- *ALLOBJ special authority
- *USE authority to the RUNDOMCMD object (object type *CMD) in the QSYS library and *USE authority to the QNNINRUN object (object type *PGM) in the QNOTES library

RSTLICPGM
The Restore Licensed Program command provides a way to load a licensed program whether you are installing for the first time, updating to a new release of a product, or recovering from a lost or damaged state.

When using the RSTLICPGM command, you must specify a device to use to restore the data. The possible devices are:

- *SAVF - a save file on your iSeries server
- *OPT - optical drive
- *TAP - tape drive

To use the RSTLICPGM command, you must have *SECADM and *ALLOBJ special authorities.

SBMDOMCMD
The Submit Domino Command provides a way to submit Domino server commands to run on a Domino server on your system. Unless you redirect it, the output from a Domino server command is displayed on the Domino console.

When submitting a Domino server command, you will need to specify the name of the Domino server to which you want to submit the serve command.
To use this command, you must have either of the following:

- *USE authority to the SBMDOMCMD object (object type *CMD) in the QSYS library and *USE authority to the QNNINSDC object (object type *PGM) in the QNOTES library
- *ALLOBJ special authority

**SETDOMENV**

The Set Domino Environment command sets the i5/OS job environment to the context of particular Domino server. It sets the PATH environment variable, the active directory to the data directory, and can optionally switch to the user profile associated with the server. The server's product library is added to the library list of this job.

To use this command, you must have either of the following:

- *Use authority to the SETDOMENV object in the QSYS library and *USE authority to the QNNINRUN object in the Domino product library
- *ALLOBJ special authority

**STRDOMSVR**

The Start Domino Server command allows you to start a Domino server. You can choose to start all (*ALL) Domino servers on your system, or a specific Domino server. In addition, you can choose whether or not you want to activate the Java Server Controller when you start your Domino server.

To start a Domino server, you must have *JOBCTL special authority.

**UPDDOMSVR**

The Update Domino Server command allows you to update specific Domino servers to newer releases. You can update all servers, or select specific servers, allowing you to control which servers are configured for specific Domino releases.

There are two parameters for this command, SERVER and TORLS. The SERVER parameter allows you to update specific servers or all servers. The TORLS parameter allows you to specify the release to which you want these servers updated.

To use the UPDDOMSVR command, you must have *SEADM, *ALLOBJ, *JOBCTL and *IOSYSCFG special authorities.

**WRKDOMCSL**

The Work with Domino Console command provides a way to submit Domino server commands to a specific Domino server. When using the Domino console, you can immediately see the responses from the Domino server.

Only one job can be running the WRKDOMCSL command for a specific Domino server. Other jobs can use the Display Domino Console (DSPDOMCSL) command to view the console messages for the same server.
To use the WRKDOMCSL command, you must have either of the following:

- *USE authority to the WRKDOMCSL object (object type *CMD) in the QSYS library, *USE authority to the QNNINCSS object (object type *PGM) in the QNOTES library, and *X data authority to the Domino data directory (and its parent directories if the directory is not directly under the root directory)
- *ALLOBJ special authority

**WRKDOMSVR**

The Work with Domino Servers command provides a way to manipulate certain aspects of the Domino servers on your system. From this display, you can do any of the following to one or more Domino servers:

- Start a server
- End a server
- Change the server configuration
- Display the server console
- Work with the server console
- Work with i5/OS jobs being used by the server
- Change the working directory
- Work with i5/OS object links that are associated with the server
- Edit the NOTES.INI file

A new function (F10) was added to the WRKDOMSVR command that allows you to sort the list of Domino servers in this display either alphabetically, or by the date the server was created.

The special authorities required to execute the different options on the WRKDOMSVR display vary from function to function.

**WRKSBS**

The Work with Subsystems command allows you to end a subsystem, display the subsystem description, and work with subsystem jobs. Before upgrading from a previous version of Domino, all Domino subsystems must be stopped. When stopping a subsystem, first attempt to stop it using *CNTRLD. If after 20 minutes the subsystem has not stopped, use the *IMMED option.
## Typical administrative tasks and their equivalent Domino commands

The following table lists typical administrative tasks for a Domino server (called DOMSERV1) and shows the i5/OS command that you can use to perform the task.

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Use command:</th>
<th>Example:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start a server</td>
<td>STRDOMSVR</td>
<td>For the server named DOMSERV1, type: strdomsvr domserv1</td>
</tr>
<tr>
<td>End a server normally</td>
<td>ENDDOMSVR</td>
<td>For the server named DOMSERV1, type: enddomsvr domserv1</td>
</tr>
</tbody>
</table>
| End the server subsystem            | ENDDOMSVR         | First end the DOMSERV1 server, type: enddomsvr domserv1  
|                                    |                   | Wait for the server to end and then type: enddomsvr domserv1 *immed |
| Determine if a server is active     | WRKDOMSVR         | For the server named DOMSERV1, type: wrkdomsvr domserv1  
|                                    |                   | Look under the Domino Status column to determine if the server is active |
| Display server activities only      | DSPDOMCSL         | For the DOMSERV1 server, type: dspdomcsl domserv1 |
| Display server activities and enter server commands | WRKDOMCSL | For the DOMSERV1 server, type: wrkdomcsl domserv1 |
| Change a server                     | CHGDOMSVR         | For the DOMSERV1 server, type: chgdomsvr domserv1  
|                                    |                   | Press F4 to display the current properties. After changing the desired properties, press Enter |
| Request a working display for controlling Domino servers | WRKDOMSVR | For the DOMSERV1 server, type: wrkdomsvr domserv1 |
| Update a server                     | UPDDOMSVR         | For the DOMSERV1 server, type: upddomsvr server(domser1) torls(6.5.1)  
|                                    |                   | This updates DOMSERV1 to the 6.5.1 release |
| Remove a Domino server              | CFGDOMSVR         | To remove the DOMSERV1 server, type: cfgdomsvr server(domser1) option(*delete) |
| Set the Domino environment          | SETDOMENV         | To set the DOMSERV1 environment to run under the server's user profile with a PATH environment variable reset to the server's configured execution, data, and user directories, type: SETDOMENV SERVER(domser1) USER(*SERVER) PATH(*REPLACE) |
Index

B
Backup, 137, 139, 140, 141, 143, 144
BRMS, 152, 154, 158, 165

C
C API, 24
CCSID, 173
Collection Services, 167, 168, 169
Configuring
  additional server, 51, 56
  first server, 39, 45

D
DB2 UDB, 101, 103, 106
DECS, 101, 102
Directory
  centralized, 133
  LDAP, 134
Directory Synchronization, 13, 133
Domino
  Administrator, 3, 35, 62, 73
  Web Administrator, 3, 35

F
Fixes, 7

H
Host name, 31

I
Installing, 21, 24, 25, 28, 29, 36, 38, 73
iSeries Access, 36
iSeries Navigator, 21, 35, 36, 39, 56, 59, 61, 65

J
Java Server Console, 59, 62
Java Server Controller, 68

L
LAN, 185, 186, 187, 189
Languages, 173, 175, 181
LEI, 101
Locales, 173
LS:DO, 101, 103

M
Managing Domino, 59, 61, 62, 63, 65
MSF/Anymail, 13

N
NetServer, 36, 37

O
OS/400
  commands, 59, 191, 198
  user profile, 19, 60

P
Partitioning, 47, 48
Passport Advantage, 1
Plug-ins, 17, 38

Q
QNOTES, 93, 99, 100

R
Recovery, 63, 137, 147, 148, 149, 163, 164
Registering, 52
Requirements, 4, 152, 185
S
Security, 93, 96, 98, 99, 100, 103
Server
   HTTP, 115, 117, 128
   properties, 72, 73
   starting, 66
   status, 71
   stopping, 66
   Web, 115
Server characteristics, 40
Single Logon, 78
SMTP, 111
   multiple, 109

T
TCP/IP, 31, 48, 53

U
Upgrading, 16, 17
   considerations, 9, 12
Users, 77

V
Verity KeyView filter, 63

W
WebSphere, 116